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Uninstalling CA-Simply Money

If you ever run out of disk space, you may need to uninstall (remove) CA-Simply Money temporarily.    
Follow this procedure:

1. Back up your data to a safe place.    You can restore it later, after you reinstall CA-Simply Money.
2. Delete all CA-Simply Money files and the directories they are in.
3. Remove CASMALRT.EXE and its path from the LOAD= statement in your WIN.INI file.



Newcomer Hints

When you first enter CA-Simply Money, the Newcomer Hints dialog box appears.    This dialog box 
displays instructions, and pops up whenever you enter a new area of the program or activate a feature 
you have not used before.

You can put the Newcomer Hints dialog box in the background by clicking on another part of the screen.    
To bring the dialog box back to the top of your screen, press Alt+Tab one or more times.    You can turn off 
the Hints at any time by Changing System Settings.



Using the Main Window

The CA-Simply Money main window makes it easy for both beginning and advanced users to set up 
quickly and begin using the program.    CA-Simply Money uses the Microsoft Windows environment to 
provide you with an intuitive graphical interface.

The standard Windows menu bar is displayed along the top edge of the window.    Along the bottom is the 
tool rack.    The buttons in the tool rack provide basic CA-Simply Money functions.

The center portion of the window is the heart of your finances.    It is split into three areas: Income 
Sources, Accounts, and Payees.    Within each of the areas are drag & drop buttons that represent 
financial items.    Income Source buttons represent the funds that you earn.    The Accounts buttons 
include your checking account, credit cards, investments, and other things you move your money through.
The Payee buttons represent the people and companies to whom you pay money. 

Related Topics:
Using a Browser Box
Clicking on Buttons
Using Drag & Drop
Choosing a Menu Item
Canceling a Menu



Using a Browser Box

The Browser feature of CA-Simply Money helps you find the names of buttons, categories, and 
classifications you have already created.    For instance, when you write a check, a Payee Browser box 
appears when you begin typing a payee name.    The first name starting with the characters you typed is 
highlighted in the list.

If you continue to type characters, the browser box continues to search.    When the name you want is 
highlighted, stop typing and press Enter to choose it.    Or, use the arrow keys to scroll the list in the 
browser box.    Once you choose an item, it is automatically entered in the appropriate line of the 
transaction.

For example, suppose you write a monthly rent check to Properties, Inc.    You can type "p" in the Pay To 
line of the check displayed on the screen, and a list of payees starting with that letter appears.    Click on 
"Properties, Inc." and the name is placed on the check.    Also added is the amount paid previously to 
Properties, Inc., and any category or memo used before.    All you have to do is record the check.    



Clicking on Buttons

All buttons respond to single and double clicks of the mouse.

Button Single Click Double Click

Income
Accounts

Shows the name, type, number 
of transactions, and balance of 
every income source or account.

Lets you add, modify, or delete 
an income source or account.

Payees Lets you choose a payee, then 
see information about it.    (Same
as single clicking on individual 
payee button.)

Lets you add, modify, or delete a
payee.

Individual 
income 
buttons

Lets you record income. Lets you modify or delete the 
button.

Individual 
account 
buttons

Lets you add to or withdraw from
the account.

Shows the register for the 
account.

Individual 
payee buttons

Shows information about the 
payee.    (Same as single 
clicking on Payees button.)

Lets you modify or delete the 
button.

Tool buttons at
bottom of 
screen

Does the task assigned to the 
button (display a report, write 
checks, and so on).

Same as single click.



Using Drag & Drop

CA-Simply Money takes full advantage of the "drag & drop" capabilities of the Windows environment.    
You can drag & drop all the buttons in the CA-Simply Money main window, thus streamlining your 
financial activities.    When you drag & drop one button onto another, you automatically complete a 
transaction or other operation.

Note:    You can drag buttons only with a mouse.    There is no keyboard equivalent.

To drag & drop a button:
1. In the main window, move the mouse pointer to one of the buttons you want to use in the drag & 

drop.    It doesn't matter which button you start with.    Hold the left mouse button down.
2. Drag the button onto the second button.
3. Release the mouse button to drop the first button.    The appropriate dialog box, report, or graph 

appears.

Note:    CA-Simply Money does not allow you to drag & drop some combinations of buttons.    For 
instance, you cannot drop one income source onto another.    The CA-Simply Money cursor changes to a 
red circle with a slash through it when you attempt a drag & drop that is not allowed.

Related Topics:
Drag & Drop between Income Sources, Accounts, and Payees
Drag & Drop a Tool



Drag & Drop between Income Sources, Accounts, and Payees

You can make transfers between and among most income sources, accounts, and payees.    If you drag 
one of these buttons to another, CA-Simply Money automatically performs the transaction.

Example:    A common transaction is to pay your rent every month.    You can drag the button with your 
landlord's name on it and drop it on your checking account button (or vice versa).    A check appears that 
already includes the date, amount, landlord's name, and any other information concerning that payee.    
All you have to do is click on Record and the transaction is complete.    Drag & drop also works with 
groups of buttons (see Grouping Buttons).



Drag & Drop a Tool

You can use drag & drop with any of the buttons in the tool rack.    If you drag a button to a tool, the tool 
automatically performs its function for that button.

Example:    To see a graph of monthly balances in your checking account, drag the Graphs button to your
checking button (or vice versa).    A graph of all transactions in that account automatically appears.    



Choosing a Menu Item

CA-Simply Money uses a standard Windows menu bar.    Active menu items appear in black, and inactive 
choices are dimmed.    When you point to an active item on the menu bar, the option is highlighted.    

For more information on using the menu bar, see the Windows Users Guide.

You can choose a menu item with a mouse or the keyboard.

To select a menu item with the mouse:
1. Point to the name of the menu on the menu bar and click on it with the left button.    The menu opens.
2. Click on the menu item you want.

To select a menu item with the keyboard:
1. Press ALT, then the letter underlined in the menu name.    The menu opens.
2. Press the underlined letter of the menu item you wish to activate.    

Example:    To choose Setup from the Tools menu, press ALT, then T, then U (ALT,T,U).



Canceling a Menu

To cancel a menu, either:

· Click on the menu name or anywhere outside the menu
· Press the ESC key



Quitting CA-Simply Money

To exit from CA-Simply Money:

1. From the File menu, choose Exit.    The CA-Simply Money Backup Finance Group Before Exit dialog 
box appears.    It gives you the opportunity to back up the current finance group before exiting.

Note:    The automatic backup prompt feature is a CA-Simply Money default system option that you 
can turn off (see Changing System Settings.)

2. To perform the backup, select a drive and/or directory, then click OK.

To exit without backing up, click on Exit.    

The Windows Program Manager or an underlying application appears.



Setting Up Your Finances 

CA-Simply Money uses finance groups to separate your finances into logical groupings.    For example, if 
you run a small business, the payments you make and receive are not related to your personal or family 
payments, so you want to keep them separate.

Besides separating finance groups that serve different purposes, CA-Simply Money helps organize and 
categorize your finances according to the type of group you create:    business or personal.    The business
group provides categories that are specific to running a business, such as payroll and business income, 
and the personal group includes categories such as groceries, medical bills, and paychecks.

Some expenses are common to both business and personal finances, so categories for such things as 
utilities, rent, and investments are in both.    You can also create a finance group that includes the 
categories for both business and personal.    You can create up to ten finance groups.

For specific information on creating a finance group, and adding financial information to it, click on one of 
these topics:

Finance Groups
Finance Buttons



Finance Groups

A finance group is a collection of everything you enter into CA-Simply Money for your business or 
personal finances.    

A typical finance group includes buttons for the following items:

· Income Sources, which are the sources of your money.
· Accounts, which hold your money and let you record fund transfers.    Examples are cash, checks, 

credit cards, and savings accounts.
· Payees, which are the recipients (persons or companies) of your bill payments.

You do not have to add all items at once.    You can start with the basics, and add more as you need them.

Related Topics:
Creating a New Finance Group
Opening an Existing Finance Group
Modifying a Finance Group
Deleting a Finance Group
Finance Buttons



Creating a New Finance Group

To create a new finance group:

1. From the File menu, choose New.    The New Finance Group box appears.    
2. In the Finance Group Name text box, type a name that characterizes the group.
3. In the Comment text box, type any comments about the group.    Comments help you distinguish one 

finance group from another.
4. Choose OK.    The Select Finance Group Categories box appears.    
5. Choose the type of finance group you want to create:

· Personal sets up a finance group with categories for personal finances.    

· Business uses categories that apply to business operations.

· Both sets up a finance group that uses a combination of the personal and business categories.

For a list of default categories in each type of finance group, see Default Categories Assigned to 
Finance Groups. 

The new finance group becomes the current group.    You can begin adding buttons to the group (see 
Finance Buttons).

Related Topic:
Finance Groups



Opening an Existing Finance Group

When you start CA-Simply Money, the finance group that was last used appears.    You can switch 
between finance groups at any time.

To open an existing finance group:
1. From the File menu, choose Open.    The Select Finance Group box appears. 

The Group Name area lists all the existing groups.    The selection bar highlights the 
current group.

2. From the Group Name area, choose a finance group.    The comments for that group appear in the 
Comment box.

3. Double-click on the finance group name

-or-

Choose OK to open the finance group.

The income sources, accounts, and payees for that finance group appear.

Note:    You can also open an existing finance group when you start CA-Simply Money.    For more 
information, see Customizing Some Operations at Startup. 

Related Topics:
Finance Groups
Finance Buttons



Modifying a Finance Group

You can change the name of a finance group and edit the comments about it.

1. From the File menu, choose Change Name.    The Select Finance Group box appears.    
2. From the Group Name area, choose the group you want to rename.
3. Choose Edit Name.    The Modify Finance Group box appears.
4. Type a new name or edit the comment.
5. Choose OK to return to the Select Finance Group box.
6. Choose Exit to return to the main window.

Related Topics:
Finance Groups
Finance Buttons



Deleting a Finance Group

When you delete a finance group, all transactions for that group are also deleted.    Make sure you have 
backup copies of any important finance groups before you delete them (see Backup).

To delete a finance group:
1. From the File menu, choose Delete.    The Select Finance Group box appears.
2. From the Group Name area, choose the finance group you want to delete.
3. Choose Delete.

Note:    You cannot delete the finance group that is currently open.    If you want to delete the current 
group, you must first open a different finance group.

Related Topics:
Finance Groups
Finance Buttons



Finance Buttons

Your finances are represented in CA-Simply Money by buttons for your income sources, accounts, and 
payees.    

You can set up your finance buttons by using either the Setup Button on the Tool rack, or the Tools menu.

To use the Setup button, follow one of these procedures:
1. Click the Setup button.    The Setup box appears.
2. Click on either Income Sources, Accounts, Payees or Specials.    A setup box for your choice 

appears.

-or-

1. Click and drag the Setup button onto the Income, Accounts, or Payees button.    The Setup box 
appears.    

2. Click on either Add, Modify, or Delete.

To use the Tools menu, follow this procedure:
1. From the Tools menu, choose Setup.    The Setup box appears.    
2. Click on either Income Sources, Accounts, Payees, or Specials.    A Setup box for your choice 

appears.
3. Click on either Add, Modify or Delete.

Related Topics:
Adding Income Sources
Adding Accounts
Adding Payees
Adding Specials
Adding Additional Information
Changing a Button Icon
Hiding a Button
Modifying a Button
Deleting a Button
Finance Groups



Adding Income Sources

Income sources are salary, interest, dividends, and other inflows.
To add an income source:
1. Drag and drop the Income button onto the Setup button.    The Income Source Setup box appears.    
2. From the Income Source Setup box, choose Add Income Source.    The Income Source Setup-Add 

box appears.    
3. In the Name box, type the name you would like to appear on the Income Source button.    

Example:    If you have one job and receive paychecks from only one source, you can name your 
income source "Paycheck."    If you have several jobs, however, you would want to label each income
source by the company name.    

4. Click on the down arrow next to the Type box, then choose a type from the list that appears.

Note:    Some types create categories and subcategories.    For example, if you choose the type 
Paycheck, CA-Simply Money creates a Salary category with the name of the income source as the 
subcategory. It also creates a Paycheck Expenses category with the subcategories Federal 
Withholding, FICA, State Disability, State Withholding, and Misc.    

5. If you want to enter an address for the income source, click on the Address button.
The Additional Information box appears.    It has text boxes for address, telephone 
number, contact, and account number.

6. If you want to change the icon, click on the Icons button.
The Select an Icon box appears.    It contains a gallery of icons. Scroll through until you 
find an appropriate one, then click on it and click OK.

7. Choose OK to create the income source and return to the main window.

Related Topics:
Finance Groups
Finance Buttons



Adding Accounts

Accounts are assets such as savings and checking, and liabilities such as a mortgage or a loan.    
Accounts let you keep track of your money.
Note:    To make an account tax-free, make all the categories associated with it tax-free.    See Tax 
Considerations for Categories.

Related Topics:
Types of Accounts
Setting Up a Checking or Savings Account
Setting Up a Mortgage Account
Setting Up an Investment Account
Setting Up a Credit Line or Credit Card Account
Setting Up an Asset or Liability Account
Finance Groups
Finance Buttons



Types of Accounts 

The account types are checking, savings, credit card, cash, mortgage, investment, credit line, liability, 
asset, and payroll: 

Checking For check-writing accounts.

Savings For interest-bearing deposit accounts.

Credit Card For major credit card use.    Keeps track of account balance, 
available credit, and interest.    You can set up a credit card 
account for each credit card you use.    

With a credit card account you can reconcile your charge 
statement, and keep track of outstanding charges and 
remaining credit.    You can print a check for your credit card 
payment through the account, and have the check appear in 
the checking account register.    For more information about 
credit card accounts, see Setting Up a Credit Line or Credit 
Card Account, and Recording Detailed Usage.

In some cases you may want to set up your credit card 
company as a payee rather than an account:

· if you pay your card in full every month

· if you use BillPay USA to pay your credit card bill

· if you do not care to track account balance, available 
credit, and interest

Cash For tracking on-hand currency.

Mortgage For making mortgage payments, broken down into principal 
and tax-deductible interest.    Helps you keep track of home 
improvements and equity.

A mortgage account keeps track of principal and interest by 
using the amortization table you can calculate when you set 
up the account.    A mortgage account calculates your net 
worth by balancing the value of your home, including home 
improvements, against your mortgage debt.    You can print a 
check for your mortgage payment through the account, and 
have the check appear in the checking account register.    
Your mortgage payments are distributed properly to liability, 
asset, and interest accounts.    See Setting Up a Mortgage 
Account and Making a Mortgage Payment.

Investment 
Account

For buying and selling securities.    Use an investment 
account to record and track taxable and nontaxable interest, 
short- and long-term capital gain and losses, dividends, 
margin interest, and miscellaneous expenses.

Credit Line For bank lines of credit such as home equity loans, and loans 
for which interest is paid such as car and boat loans.    Keeps 
track of balances and amounts of credit still available (credit 
remaining).

Liability 
Account

For loans or amounts owed that are not covered in other 
accounts (such as personal loans).

Asset For keeping track of assets such as a 401(k) account, coin 



Account and art collections, or loans you have made to others.    Also 
for tracking accounts receivables.    

Payroll For paying wages.    Automatically itemizes taxes and 
deductions for liability and expense categories.

Related Topic:
Adding Accounts



Setting Up a Checking or Savings Account

The procedure for setting up checking and savings accounts is the same.

1. Drag and drop the Accounts button onto the Setup button.    The Account Setup box appears.    
2. Click on Add an Account.    The Account Setup-Add box appears.    
3. Type a name for your account.
4. From the Account Type list, choose Checking or Savings.
5. If you want to enter an address for the account, click on the Address button.

The Additional Information box appears.    It has text boxes for address, telephone 
number, contact, and account number.

6. If you want to change the icon, click on the Icons button.
The Select an Icon box appears.    It contains a gallery of icons. Scroll through until you 
find an appropriate one, then click on it and click OK.

7. Choose OK.    The Account Balances box appears.
8. Type the starting account balance.    If you want the balance to have a date other than today's date, 

press Alt+D and enter the date.

9. Choose OK.

Note:    If you are setting up a tax-free account such as an IRA, you must make the account tax-free by 
making the categories associated with it tax-free.    See Tax Considerations for Categories.

Related Topic:
Adding Accounts
Tax-Free Accounts



Setting Up a Mortgage Account

A mortgage account is for making mortgage payments, broken down into principal and tax-deductible 
interest.    It also helps you keep track of home improvements and equity.

A mortgage account keeps track of principal and interest by using the amortization table you can 
calculate when you set up the account.    A mortgage account calculates your net worth by balancing the 
value of your home, including home improvements, against your mortgage debt.    You can print a check 
for your mortgage payment through the account (see Making a Mortgage Payment), and have the check 
appear in the checking account register.    Your mortgage payments are distributed properly to liability, 
asset, and interest accounts.

To set up a mortgage account:
1. Drag and drop the Accounts button onto the Setup button.    The Account Setup box appears.    
2. Click on Add an Account.    The Account Setup-Add box appears.    
3. Type the name of the bank or company that holds your mortgage.    This name becomes the payee 

name printed on checks and shown in the mortgage account register.    
4. From the Account Type list, choose Mortgage.    
5. If you want to enter an address for the account, click on the Address button.

The Additional Information box appears.    It has text boxes for address, telephone 
number, contact, and account number.
Note:    If you are going to print checks and use windowed envelopes, add the name of 
the mortgage issuer to the address.    A quick way to do this is to press Ctrl+P. 

6. If you want to change the icon, click on the Icons button.
The Select an Icon box appears.    It contains a gallery of icons. Scroll through until you 
find an appropriate one, then click on it and click OK.

7. Click OK.    The Account Balances box appears. 
8. In the Current Loan Balance area, type the outstanding loan amount.    If you want the balance to 

have a date other than today's date, press Alt+D and enter the date.
9. In the Current Market Value area, type the current value of your home.
10. In the Down Payment + Improvements area, type the sum of your down payment plus the cost of any

home improvements (but not repairs or maintenance) you have made.
11. Choose OK to return to the main window.

Note:    CA-Simply Money allows you to set up an amortization table, which it uses to automatically 
distribute the principal and interest portions of your loan payment to the correct categories.    See 
Amortizing Loans.    While setting up a mortgage, you might also want to use the Loan calculator, which 
will calculate your payments for a given loan and interest rate; see Using the Loan Calculator.

Related Topic:
Adding Accounts



Setting Up a Credit Line or Credit Card Account

A credit line account is for paying lines of credit such as home equity loans.    Use the account to track the 
balance and the amount of credit remaining.

A credit card account is for paying and tracking credit card balances.    With a credit card account you can 
reconcile your charge statement, and keep track of outstanding charges and remaining credit.    You print 
a check for your credit card payment through the account, and the check appears in the checking account
register.

If you pay off your credit card balance each month, or do not care to track your balance, you may want to 
set up your credit card as a payee instead of an account (see Adding Payees).    If you use BillPay USA to
pay your credit card bill, you must set up your credit card as a payee, not an account.

To set up a credit line or credit card account:
1. Drag and drop the Accounts button onto the Setup button.    The Account Setup box appears.    
2. Click on Add an Account.    The Account Setup-Add box appears.    
3. Type the name to appear on payment checks, usually the bank name.
4. From the Account Type box, choose Credit Line or Credit Card, 
5. If you want to enter an address, click on the Address button.

The Additional Information box appears.    It has text boxes for address, telephone 
number, contact, and account number.
Note:    If you are going to print checks and use windowed envelopes, add the bank 
name to the address.    A quick way to do this is to press Ctrl+P. 

6. If you want to change the icon, click on the Icons button.
The Select an Icon box appears.    It contains a gallery of icons. Scroll through until you 
find an appropriate one, then click on it and click OK.

7. Click OK.    The Account Balances box appears.
8. For a credit line, type the Starting Account Balance amount and the Total Credit Line amount in the 

Account Balances box.    For a Credit Card, enter the Credit Limit.

If you want the starting balance or credit limit to have a date other than today's date, press Alt+D and
enter the date.

Note:    If you are setting up a credit line, you may want to click on Amortize to calculate an 
amortization table, which automatically distributes the correct amounts of principal and interest when 
you pay off the loan.    See Amortizing Loans. 

9. Choose OK to set up the account and return to the main window.

Related Topic:
Adding Accounts



Setting Up an Asset or Liability Account

An asset account is for tracking assets such as a 401(k) account, coin or art collections, or loans you 
have made to others.    It can also track accounts receivables in a business finance group.

A liability account is for paying loans such as personal loans, or for tracking accounts payable in a 
business finance group. 

To set up an asset or liability account:
1. Drag and drop the Accounts button onto the Setup button.    The Account Setup box appears.    
2. Click on Add an Account.    The Account Setup-Add box appears.    
3. Type a name for your account.
4. From the Account Type list, choose Asset Acct. or Liability Acct.
5. If you want to enter an address for the account, click on the Address button.

The Additional Information box appears.    It has text boxes for address, telephone 
number, contact, and account number.

6. If you want to change the icon, click on the Icons button.
The Select an Icon box appears.    It contains a gallery of icons. Scroll through until you 
find an appropriate one, then click on it and click OK.

7. Click on OK.    The Account Balances box appears.
8. In the Account Balances box, type the current asset value, or the current loan balance.    If you want 

the asset value or loan balance to have a date other than today's date, press Alt+D and enter the 
date.

Note:    If you are setting up a personal loan, you may want to click on Amortize to calculate an 
amortization table, which automatically distributes the correct amounts of principal and interest when 
you pay off the loan.    See Amortizing Loans. 

9. Choose OK to return to the main window.

Related Topic:
Adding Accounts



Adding Payees

Payees are companies and individuals to whom you write checks.    Payee buttons let you pay bills.
To add a new payee:
1. Drag and drop the Payee button onto the Setup button.    The Payee Setup box appears.
2. From the Payee Setup box, choose Add Payee.    The Payee Setup-Add box appears.    
3. In the Name area, type the name that should appear on a check.    The name you type appears on 

the payee button.
4. If you want to enter an address, click on the Address button.

The Additional Information box appears.    It has text boxes for address, telephone 
number, contact, and account number.
Note:    If you are going to print checks and use windowed envelopes, add the payee 
name to the address.    A quick way to do this is to press Ctrl+P. 

5. If you want to change the icon, click on the Icons button.
The Select an Icon box appears.    It contains a gallery of icons. Scroll through until you 
find an appropriate one, then click on it and click OK.

6. Choose OK to create the new payee and return to the main window.

Related Topics:
Finance Groups
Finance Buttons



Adding Specials

Some transactions are not transfers of funds from one button to another.    Examples are balance 
adjustments, voided checks, and account withdrawals.    For these types of special transactions you can 
set up "specials."    For more details about the default specials that come with CA-Simply Money, see 
Types of Specials.

Specials have a browser box just as income sources, accounts, and payees do.    (See Using a Browser 
Box.)    The browser enables you to choose specials when you record transactions in a Register.

You can also use specials for transactions that require a transfer of funds but do not warrant setting up a 
payee button.    

Example:    To record an ATM withdrawal in your check register, use the special "Withdrawal." 

To add a Special:
1. Click on the Setup button.    
2. From the Setup box, choose Specials.    The Special Button Setup box appears.    
3. Choose Add Special.    The Special Button Setup-Add box appears. 
4. Type a name for the Special.    The name will appear in the Special Browser box when you record 

transactions in the account Register.

Related Topics:
Finance Groups
Finance Buttons



Types of Specials

Specials are for transactions that are not fund transfers from one button to another.    The CA-
Simply Money Specials are:

Balance 
Adjustment

CA-Simply Money adds this automatically during account 
reconciliation if you choose to make an adjustment to an 
unbalanced account (see Handling Out of Balance Accounts).

A Balance Adjustment is distributed to the Misc. Equity 
category.    This is a special category for balance adjustments 
and starting balances.    It is not an income, expense, asset, 
or liability category, and is used to add money to an account 
without recording it as income.

Deposit Use Deposit when the payee is the account itself.

Interest 
Earned

Interest earned and added to an account automatically by the 
account institution.

Interest Paid Interest expenses deducted from an account automatically by
the account institution.

Refund Funds that are restored by a bank or other institution.

Service 
Charge

Charges for overdrafts, use of an ATM card, and other 
services.

Starting 
Balance

The first entry in the register for an account is the starting 
balance.    You enter the starting balance when you add an 
account.

A Starting Balance is distributed to the Misc. Equity category.  
This is a special category for balance adjustments and 
starting balances.    It is not an income, expense, asset, or 
liability category, and is used to add money to an account 
without recording it as income.

Transfer Use Transfer when the payee is an account rather than a 
payee.

Void Use Void for checks that have been destroyed.

Withdrawal Use Withdrawal when you take money out of an account for 
your own use, as opposed to a payment to yourself as payee.

Related Topic:
Adding Specials



Adding Additional Information

While setting up or modifying an income source, account, or payee, you can add an address, contact 
name, telephone number, and account number.

To record additional information:
1. Click on the Setup button.
2. Click on one of these buttons:    Income sources, Accounts, or Payees.    
3. Click on the button that says either Add or Modify.
4. From the Setup-Add or the Setup-Modify box, choose Address.    The Additional Information box 

appears.    
5. Type an address, telephone number, contact person, and/or account number.    

If you are recording information for a payee, the address and account number 
automatically appear on a check made out to the payee.    This saves time when you pay
your bills.
Note:    If you are going to print checks and use windowed envelopes, add the payee 
name to the address.    A quick way to do this is to press Ctrl+P. 

6. Choose OK to return to the Setup-Add box.

Related Topic:
Finance Buttons



Changing a Button Icon

While setting up or modifying an income source, account, or payee, you can select a different icon.

To change a button icon:
1. Click on the Setup button.
2. Click on one of these buttons:    Income sources, Accounts, or Payees.    
3. Click on the button that says either Add or Modify.
4. From the Setup-Add or Setup-Modify box, choose Icons.    A gallery of over 200 icons appears.    Use 

the scroll bar to display the many different icons.
5. Double-click on any icon you would like to use on the button.

-or-

Single-click on the desired icon and choose OK.

Related Topic:
Finance Buttons



Hiding a Button

You can "hide" buttons you do not use often to remove them from view.    For example, you may want to 
hide charitable donations or school tuition that you pay only once or twice a year.    

All the transactions for a hidden button remain intact.    You can unhide a button at any time.    Even when 
hidden, a button name still appears in the browser box so you can use it.

To hide a button:
1. Click on the Setup button.
2. Click on one of these buttons:    Income Sources, Accounts, or Payees.    
3. Click on the button that says either Add or Modify.
4. In the Setup box, click on the Hidden Button check box.

Related Topic:
Finance Buttons



Modifying a Button

You can change most information for any button at any time.    The only attributes you cannot change are 
the Account Type and Starting Balance for an account.    (If you want to change the starting balance of an 
account you are already using, enter the change as a balance adjustment; see Handling Out of Balance 
Accounts for an explanation of this procedure.

To merge several payee buttons into one button with their combined transaction history, see Merging a 
Payee Group into One Button.

To make an account tax-free, make the categories associated with it tax-free.    See Tax Considerations 
for Categories.

To modify a button:
1. Drag and drop the button you want to modify onto the Setup button.    The Single Button Setup box 

appears.    
2. Choose Modify.    The Setup-Modify box for the chosen button appears.    It contains the information 

that you supplied when you set up the button.
3. If you wish, change the Name, or hide the button.
4. If you wish, click on the Address button, then edit any information you want to change in the text 

boxes (Name, Address, Telephone Number, Contact, or Account Number).    
Note:    If you are going to print checks and use windowed envelopes, add the payee 
name to the address.    A quick way to do this is to press Ctrl+P. 

5. If you wish, change the icon.

6. When you have finished modifying the button, choose OK.

7. For some types of accounts, the Account Balances dialog box appears.    You cannot change the 
starting account balance, but you can modify other amounts such as Credit Limit for a credit card 
account or Current Market Value and Down Payment and Improvements for a mortgage account.    
Change an amount if you wish.    This generates an adjustment transaction.

If you want the changed amount to have a date other than today's date, press Alt+D and enter the 
date.    Click on OK to get back to the main window.

Related Topic:
Finance Buttons



Deleting a Button 

If an account is inactive but contains information you want to keep, you can delete the button.    When you
want to delete a button, you should make a backup first (see Backup).

You can also "hide" a button to remove it from view (see Hiding a Button).    

To delete a button:
1. Click on the Setup button.
2. From the Setup box, choose one of these: Income Sources, Accounts, Payees.    
3. Click on Delete.    The Setup-Delete box appears.    
4. Click the Next or Previous button until the item you want to delete appears in the Name box, and 

choose OK.
The button's Delete box appears.    The Delete boxes for income sources, accounts and 
payees contain a message warning that deleting the button makes it impossible to 
reference transactions that were associated with the button.
· If you are deleting an income source, you can choose to keep the categories and transactions 

associated with it.    In transactions involving the deleted income source, the source name will be 
replaced with either "Withdrawal" or "Deposit."    If you choose to delete the associated 
categories, past references to those categories are moved to the "Miscellaneous" category.

· If you are deleting a payee, you can choose to keep the transactions associated with the payee.    
In transactions referencing the deleted payee, either "Withdrawal" or "Deposit" replaces the 
payee name.

· If you are deleting an account, the categories associated with the account are also deleted.

· You can delete specials you created but not the default ones that come with CA-Simply Money.    
The deleting options are the same as for a payee.

5. Click on OK, then click on OK again to confirm the deletion.

Related Topic:
Finance Buttons



Tracking Your Money

After you have set up at least one account, you can start keeping track of your finances.    As you record 
income and pay bills, transaction information is recorded in the appropriate accounts.    CA-Simply Money 
can translate this information into reports and graphs so you can know where your money comes from 
and where it goes.

The following topics explain how to record income, pay bills, and maintain your accounts.

Categorizing Your Finances
Recording Income
Paying Bills
Using an Account Register
Writing Checks
Tracking Credit Cards
Cash and Savings Accounts
Credit Line and Loan Accounts
Mortgages
Recording Assets and Liabilities
Transferring Funds Between Accounts
Reconciling Accounts
Grouping Buttons
Budgeting



Recording Income

Once you have set up your income sources (see Adding Income Sources), you can record income.

Recording income in CA-Simply Money can be as simple as clicking with the mouse.    The first time you 
enter, say, paycheck information, you need to type all the amounts.    The next time, CA-Simply Money 
displays all the information from the last deposit.    If your income is steady from month to month, just click
the mouse to record the current paycheck.

Related Topics:
Recording Paycheck Income
Recording Income Other than Salary



Recording Paycheck Income

When you set up your paycheck button (see Adding Income Sources), CA-Simply Money automatically 
sets up expense categories for Federal and State withholding, disability insurance, and FICA.    When you
deposit income, CA-Simply Money automatically records these expenses in the correct categories.    This 
saves you time and effort when you prepare your taxes.

1. Display the Record Income box by either:
· Clicking once on your paycheck button.
· Choosing Record Income from the Operations menu, then choosing the name of your paycheck 

button from the list that appears.
If you recorded income from this source before, the information from the last transaction
appears in the Record Income box.

2. If this is the first paycheck you have recorded, or if amounts, deposit account, or deposit method 
have changed, type in the current information.
To assign money to categories other than those in the Deductions area (Federal and State 
withholding, Disability Insurance, and FICA), click on the Distribution button to open the Distribution 
Register.    For more information, see Distributing an Amount to More Than One Category.

3. Click Record to record this paycheck.    The result in the Net text box, which CA-Simply Money 
calculates automatically from your gross income less all deductions and adjustments, is added to the
destination account automatically.

Related Topic:
Recording Income Other than Salary



Recording Income Other than Salary

Examples of income other than salary are consulting income, inheritance, royalties, and social security.    
Follow this procedure to record other income:

1. Display the Record Income box by either:
· Clicking once on the button for your income source.
· Choosing Record Income from the Operations menu, then choosing the name of your income 

source from the list that appears.
If you recorded income from this source before, the information from the last transaction
appears in the Record Income box.

2. Type the amount and deposit method, and choose the destination account.
3. To categorize the income, begin typing the category name into the Category box and choose your 

category from the Category Browser.    For more information on categories, see Categorizing Your 
Finances.

4. Click on the Record button.

Related Topics:
Recording Paycheck Income
Recording Investment Income and Expense



Paying Bills

CA-Simply Money saves you time by streamlining payment procedures and by performing split-second 
calculations.    Checks that you write for the same amount each month are automatically prepared.    CA-
Simply Money even anticipates your payee's name for you.

CA-Simply Money provides two ways to pay bills:    by "writing" checks in the Checkbook, and by 
recording a payment in the account Register.    If you are going to print custom checks when you pay your 
bills, use the Checkbook for recording your payments.    If you do not print checks, record your payments 
in the Register.

As you pay bills, you can allocate the amount paid to one or more categories.    Examples of categories 
are utilities, food, and dental.    Categories help you monitor where your money goes.    Most payments go 
to only one category, but some payments may be for more than one type of expense.    For example, a 
department store bill may be for both dining and clothing because you treated friends to lunch in the store 
restaurant while shopping.    For detailed information about categories, see Categorizing Your Finances.

CA-Simply Money offers custom checks for automated check printing.    Computer-printed checks save 
time and reduce errors.    For information about ordering checks, see Ordering Supplies. 

Regardless of whether you use the Checkbook or Register method, the major steps for making a payment
in CA-Simply Money are the same:

1. Select the account from which the payment is being made.
2. Select the payee or account to receive the payment.
3. Record the payment information.

Note:    If you pay your bills through BillPay USA, which is an online payment service available through 
Prodigy, you can import a file of those payments into CA-Simply Money.    The imported transactions are 
added to your records and your balances are adjusted accordingly.    See Importing BillPay USA Records 
for the procedure.    Note that if you use BillPay USA, you should set up your mortgage and credit cards 
as payees rather than accounts.

You need a Prodigy membership to use BillPay USA.    See the Prodigy brochure included in your CA-
Simply Money package for information.    

Related Topics:
Writing Checks
Using an Account Register



Writing Checks

The Checkbook is a CA-Simply Money window that looks like a check.    It enables you to write and print 
checks with CA-Simply Money rather than write your own checks and record them in the checking 
account register (as explained in Using an Account Register).    You can write checks as you receive bills, 
or you can write checks for all your bills at the same time.    Either way, you can print the checks at any 
time.    Writing checks and printing them are separate activities.

Whenever you write a check, CA-Simply Money remembers the amount.    The next time you write a 
check to that payee, the information from your last payment automatically appears on the check.    This 
saves you time and prevents errors when you make recurring payments.

Tip:  CA-Simply Money can remind you to pay recurring bills. See The Scheduler.

When you open the Checkbook, you can do one of the following:

· Write a check to a new payee and add that payee button.
· Write a check to an existing payee and add new date and amount values.
· Write a check to an existing payee and use the values automatically entered from the last payment.

When in the checkbook, use the Tab key or the Enter key to move the cursor to the various fields on the 
check.    (If you want to change the function of the Enter key to make it record the check rather than move 
from field to field, see Customizing Some Operations at Startup.)

Tip:  If you pay several bills at the same time every month, you may want to automate the check writing 
procedure by grouping those payees. See Grouping Buttons.

Related Topics:
Opening the Checkbook
Paying a New Payee
Paying an Existing Payee
Writing a Check to a One-Time Payee
Distributing a Payment to One Category
Editing an Unprinted Check
Making Sure Your Checks Are Covered
Printing Checks



Opening the Checkbook

You can open the Checkbook by either clicking with the mouse, dragging and dropping, or selecting from 
the Operations menu:

Mouse Clicks 1. Either:
· Click once on the button of the checking account 

you want to use
· Click on the Write button

2. If you have more than one checking account, the Write 
Checks box appears, containing a list of all your checking

accounts.    Choose a checking account by double-
clicking 

on it.
Drag & Drop 1. Either:

· Drag the checking-account button to the payee 
button, or the payee button to the checking-account 
button

· Drag the Write button to the checking-account 
button.

Operations 
Menu 

1. Choose Transfer Funds or Pay Expenses.    

2. From the Use Account box, select the name of the 
checking account you want.

Related Topic:
Writing Checks



Paying a New Payee

You can write a check to a payee without first setting up a button for it.    As you write the check, CA-
Simply Money prompts for the information needed to add a button for the payee.

To write a check to a new payee:
1. Drag the checking account button to the Write button and drop it.    The checkbook opens.
2. If necessary, change the date.
3. Press the tab key to get to the Pay to the Order of line.
4. Type the name of the payee.    The Payee Browser box appears.    Choose New.    The Payee Setup-

Add box appears.
5. Fill in the payee information (see Adding Payees).

When you are finished, click OK to return to the Checkbook window.
6. In the $ box, type the amount of the check.    CA-Simply Money writes the amount in words on the 

next line.
7. If you wish, type an optional memo on the Memo line.    The memo will appear on the printed check 

(it may be truncated) and in the Register.
8. Specify one or more categories (see Categorizing Your Finances). 
9. If you want to print the check, make sure the Print box in the upper left corner contains an X.    See 

Printing Checks for instructions on printing checks.

Note:    The Checkbook is for checks you mean to print; checks you have handwritten are more easily 
recorded in the register.    If you enter a handwritten check in the Checkbook, however, update the 
corresponding entry in the Register by typing the number of the handwritten check in the Via column, 
where it says "Print."

10. Click on Record to complete the transaction.
11. A new check appears. You can continue writing checks, or click Home to return to the main window.

Note:    You can use the Note button to record a note with the transaction.    See Editing a Transaction 
Note.

Related Topic:
Writing Checks



Paying an Existing Payee

To write a check to an existing payee:

1. Drag the payee button to the checking account button and drop it.    The checkbook opens, showing 
information from the last check (if any).

2. If necessary, change the amount, memo, and/or the date.
3. If necessary, change the category distribution information (see Categorizing Your Finances).
4. If necessary, change the address.    Changing the address here also updates the payee button.

Click on the first line of the address area above the memo, then press CTRL+P to add 
the payee name to the first line.    (Press Return to move to the second line).    The name 
will appear on the printed check and is added to the address information for the payee.

5. If you want to print the check, make sure the Print box contains an X.    See Printing Checks for 
instructions on printing checks.

Note:    The Checkbook is for checks you mean to print; checks you have handwritten are more easily 
recorded in the register.    If you enter a handwritten check in the Checkbook, however, update the 
corresponding entry in the Register by typing the number of the handwritten check in the Via column, 
where it says "Print."

6. Click on Record to complete the transaction.
7. A new check appears. You can continue writing checks, or click Home to return to the main window.

Related Topic:
Writing Checks



Writing a Check to a One-Time Payee

The "One-time payee" designation allows you to write checks to payees who need not appear on your 
payee list.    For example, you may want to pay a friend for a dinner bill, although the friend is not 
someone you will be writing checks to routinely.    You can record the transaction on a one-time basis, 
without adding the friend to your payee list.

To write a check to a one-time payee:
1. Drag the checking account button to the Write button and drop it.    The checkbook opens.
2. If necessary, change the date.
3. Press the tab key to get to the Pay to the Order of line.
4. Type the name of the payee.    The Payee Browser box appears.    Choose New.    The Payee Setup-

Add box appears.
5. In the Payee Setup-Add box, select "Is this a one-time only Payee?" and click OK.
6. Type an amount on the check, one or more categories (see Categorizing Your Finances) and any 

memo, then click Record.

Note:    You can use a one-time payee again by typing its name into the browser box; it will not appear in
the list but CA-Simply Money will accept it as an existing payee.

Related Topics:
Turning a One-time Payee Into a Button
Writing Checks



Turning a One-time Payee Into a Button

If you use a one-time payee more often than you had expected, you can make it a payee button (see 
Adding Payees).    Use the same name you wrote on a check to the one-time payee.    CA-Simply Money 
will associate with that button all transactions made to that name as a one-time payee.

Related Topic:
Writing a Check to a One-time Payee



Distributing a Payment to One Category

As you pay bills or record payment information in the register, you can allocate the amount paid to one or 
more categories.    Examples of categories are utilities, food, and dental.    Categories help you monitor 
where your money goes.    Most payments go to only one category, but some payments may be for more 
than one type of expense.    For example, a department store bill may be for both dining and clothing 
because you treated friends to lunch in the store restaurant while shopping.    

For detailed information about categories, see Categorizing Your Finances.

Note:    If you do not assign an amount to a category, CA-Simply Money puts it into the Miscellaneous 
category.    The Misc. Expns. category does not appear in the register, but shows as a Miscellaneous 
Expense on reports.

To distribute to one category:
1. If you are in the Checkbook window, click in the Category box.    

If you are in a register, click on the category line (the third line when the register is in standard 
format; for information about formats, see Setting Register Sort and Display Options).

2. Begin typing the category.    The Category Browser box appears (see Using a Browser Box). 
As you type, CA-Simply Money searches the browser list to match what you type.    The 
matching category name is highlighted automatically.

3. Continue typing the category name until it is highlighted in the Browser box.    Choose OK.
4. To distribute to more than one category, click on the arrowhead.    For more information, see 

Distributing an Amount to More Than One Category.
5. Click on Record to complete the transaction and record it in the account register.
6. Either continue writing checks or recording payment information in the register, or choose Home to 

return to the main window.

Related Topics:
Distributing an Amount to More Than One Category
Using an Account Register
Writing Checks



Editing an Unprinted Check

After you record a check, you can display it by using the scroll bar in the Checkbook window.    Checks 
remain in the Checkbook until they are printed.

To edit an unprinted check:
1. Drag the button for the checking account to the Write button, then drop it.    The Checkbook opens.    
2. Use the scroll bar to locate the check you want to edit.
3. Click on any part of the check you want to change and edit the transaction information.
4. Choose Record.    The new transaction information replaces the old in the account Register, and the 

next check in the Checkbook appears.
5. When you have finished editing checks, choose Home.

Related Topic:
Writing Checks



Making Sure Your Checks Are Covered

If you don't have enough money in your checking account to pay all the bills right now, you can let CA-
Simply Money help you manage your cash flow.

1. Sort your bills in order of their priority.
2. Write checks for all your bills (see Writing Checks).

As you write checks, the amounts in the bottom right of the window change.    Check 
amounts are added to Checks to Print and subtracted from Current Balance to produce 
an Ending Balance.
When the account balance is exceeded, Ending Balance displays a negative amount (on color 
monitors, in red).

Note:    You can use the Windows Calculator while you are in the Checkbook by choosing Calculator 
from the System menu.    See Using the Windows Calculator.

3. After you have recorded all the checks, use the scroll bar to find the checks you do not want to print 
now.

4. Click on the Print box to remove the X for each check you do not want to print, then click on Record.
The Ending Balance changes as you choose checks not to print.    When the Ending 
Balance is a positive amount, you can print the remaining checks.

5. Click on the Print button to print the checks that are still marked with an X in the Print box.    The 
other checks can be printed after you have deposited more money. 

The Register shows a negative balance reflecting the amount you still owe.

Related Topic:
Writing Checks



Printing Checks

You can print checks on a dot-matrix, ink jet, or laser printer.

To order check stock, use the supplies catalog, on-line order form, or toll-free number (see Ordering 
Supplies).

1. If you want to specify the date format for checks or other check options, see Setting Check Printing 
Options.

2. Make sure the printer is ready and the correct check stock is loaded.
3. If you are not already in the Checkbook window, click on the checking account button for the account

you want to print checks from.
4. Click on the Print button.    The Print Checks box appears.
5. If you want to print only those checks written before a specific date, enter a date in the Print through 

box.    The default is today's date.
If you have recorded more checks than your account balance can support, be sure you have 
selected only those that are within your balance.    See Making Sure Your Checks are 
CoveredHELPID_MakingSureYourChecksareCovered142.

Important:    Before continuing, you may need to change the check layout and/or the printing 
alignment.    See Setting Check LayoutHELPID_Check_format or Setting Check 
AlignmentHELPID_Continuous_align.

6. Choose OK.    The Check Number box appears.
7. Look at your check stock.    In the Next check # box in the Check Number box, type the number of 

the next check to be printed.
8. Choose OK.    The Confirm Printing box appears.

Note:    If you are using standard, page-feed checks, the Standard Checks-Page Feed box 
appears.    It enables you to print on a partial page of checks.    Standard laser checks come three on 
a page.    After printing checks the last time, you may have a partial page of only one or two checks.   
See Printing Partial Pages of Checks.    If the first page you are going to feed into the printer has 
three checks on it, you do not need to use this dialog, so click OK to close it.

9. If all your checks printed correctly, choose OK.    
If they misfed, see Reprinting Checks.

10. Choose Home to return to the main window.

CA-Simply Money updates the Register with the check numbers.

Related Topics:
Setting Check Printing Options
Setting Check Layout
Setting Check Alignment
Reprinting Checks
Printing Partial Pages of Checks
Writing Checks



Printing Partial Pages of Checks

Standard laser checks come three on a page.    After printing checks, you may be left with a partial page 
of only one or two checks.    You can use them again.

CA-Simply Money displays the Standard Checks - Page Feed dialog box before printing checks.    This 
dialog lets you specify the number of checks on the first page you will feed into the printer, and choose 
the alignment and orientation for that page.    If your first page has three checks, you do not need to use 
this dialog, so click on OK to close it.

Number of Checks.    Select 2 Checks or 1 Check.

Orientaion.    Select Normal Feed or Sideways Feed.    If you are not sure which one to choose, check 
your printer manual or experiment.    The most common choice is Sideways Feed, which is appropriate for
the HP Laserjet II, III, IIp, and the Apple Personal LaserWriter.    Normal Feed is usually appropriate for 
bubble jet printers such as the HP DeskJet.

If your printer uses Sideways Feed, you may need to experiment with inserting the checks face up or 
down and with the left or right edge leading.    A good first try is face up, right edge leading.

Alignment.    Select Centered or Along Left Edge.    Centered applies to popular printers such as the HP 
Laserjet II and III.    Use Along Left Edge for the HP Laserjet IIp and the Apple Personal LaserWriter.



Setting Check Printing Options

You can select three printing options and four date formats.    

1. From the System/Settings menu, choose Check Printing.    The Check Printing Settings box appears.
2. From the Options box, choose one or more of these check printing options:

Print Categories on Check Voucher, for use with the voucher-style checks.    
Print Current Date on Checks, to date all checks with today's date.
Warn if Check Number is Reused, to guard against entering an incorrect starting 
number.

3. From the Date Format box, choose a format.
4. Choose OK to return to the main window.

Related Topic:
Printing Checks



Setting Check Layout

Because you can order several different check styles, you may need to specify what kind of checks you 
have.    If you have pin-feed, standard checks, the default, you can skip this procedure.

To set check layout:
1. If you are not already in the Checkbook window, click on the checking account button for the account

you want to print checks from.
2. Click on the Print button.    The Print Checks box appears.
3. From the Print Checks box, click on Check Layout.    The Check Layout box appears.
4. In the Type area, select either Pin Feed or Page Feed.    Laser printers use page feed stock.
5. In the Style area, select either Standard, Wallet, or Voucher style stock.    Wallet-style checks are not 

available for laser printers.
6. If you are using a laser printer, you can request multiple copies of the check for a multi-part check 

form.
7. Click on OK to return to the Print Checks box.

Related Topics:
Printing Checks
Setting Check Alignment



Setting Check Alignment

This help topic describes how to print a sample check, then fix its alignment.    

Before printing a sample check, you may need to specify the type of check you are using (see Setting 
Check Layout).    The default check type is pin-feed, standard.

You may also want to review Printer Setup, to verify that you are connected to the right printer and that 
the settings are correct.    For laser printers, be sure paper size is 8.5 by 11 inches and a paper cassette is
chosen.

After you set the check alignment, CA-Simply Money remembers it from session to session so you only 
need to do it once unless you change check style or get a new printer.

To print a sample check:
1. If you are not already in the Checkbook window, click on the checking account button for the account

you want to print checks from.
2. Click on the Print button.    The Print Checks box appears.
3. Click on Print Sample.    
4. Feed enough check stock into the printer to gain traction.    If you are using a pin-feed printer, note 

where the check lines up with the printer guides.    The first check in each print run should start in the 
same position.

5. Click on Print Sample Check.    
6. Examine the printed check, then align your checks using the following procedure for either pin-feed 

or page-feed printers.

To align checks on a pin-feed printer:
The Continuous Feed Checks-Alignment box appears for most pin-feed printers.    

1. The sample check for pin-feed printers has two columns of numbers and one row of letters.    Position
an actual check under the sample check and see where the numbers and letters line up.    One of the
numbers should line up on the Payee line and one of the letters should line up with the left edge of 
the Date line.

2. In the Continuous Feed Checks-Alignment box, type the number appearing on the Payee line and 
the Letter appearing at the start of the Date field.

To align checks on a page-feed printer:
The Page Feed Checks-Alignment box appears.

1. If the information on the sample check was too far left, right, up, or down, you can enter adjustments 
in 1/100ths of an inch.    For example, if the information is 1/2 inch too far to the right, enter -50 in the 
Side Adjustment field.

2. Print another sample check to verify the new alignment.    (You may want to use regular paper to 
save valuable check stock.    Simply place the paper on top of a check to see how the information 
lines up.)

Related Topics:
Printing Checks
Setting Check Layout



Reprinting Checks

If your printer jams, you may need to reprint checks.    Use either of the following procedures.

Important:    Record spoiled checks in the register by typing "Void" over the payee name.    A Voided 
check is one of the built-in special transactions in CA-Simply Money.    For more information on Specials, 
see Adding Specials or Types of Specials.

If the Print Checks box is still open:
1. In the Confirm Printing box, type the number of the first check that misfed.    CA-Simply Money will 

reprint all checks starting with that number.
2. Choose OK to return to the Print Checks box.
3. Choose OK.    The Check Number box appears.
4. Look at your check stock, then type the next check number in the Next check # box.
5. Choose OK.    The Confirm Printing box appears.

Note:    If you are using standard, page-feed checks, the Standard Checks-Page Feed box 
appears.    You need to specify the number of checks per page.    With less than 3 checks per page, 
you must also specify the orientation and alignment you want to use.    See Setting Check Alignment.

6. If all your checks printed correctly, choose Home to return to the main window.

CA- Simply Money updates the Register with the check numbers.

If the Print Checks box is not open:
1. Drag the account button to the Register button, then drop it.
2. In the Register, locate the check(s) that need reprinting.
3. Type P over the check number in the Via column.

The check(s) will be printed in the next check printing run.

Related Topic:
Printing Checks



Using an Account Register

One of the most common ways to view and update your financial data is through an account register.    
Each account has its own register, which shows all transaction information for that account.    You can also
enter transactions directly into a register.

Registers vary slightly for different types of accounts, but they work in the same manner.    

When you first open the Register window, CA-Simply Money provides you with an empty transaction line 
to begin a new transaction.    After you record a transaction by pressing the Record button, a new blank 
line appears just below it.    If you predate or postdate a transaction, the transaction automatically moves 
to its proper chronological location in the register.

Use the Tab key or the Enter key to move the cursor to the various fields on the register.    (If you want to 
change the function of the Enter key to make it record a transaction rather than move from field to field, 
see Customizing Some Operations at Startup.)

By default, as the cursor moves through the Register, the message line indicates the information required 
in each field.    (This is controlled by "Drag & Drop Info. On" in the General Settings window; see 
Changing System Settings.)

By using a register you can:
· View transactions
· Delete transactions
· Change transactions
· Distribute transactions to categories and subcategories
· Record deposits and withdrawals
· Record transactions that have a check number (for example, a check drawn against a checking 

account or line of credit)
· Record, change, or delete transactions while reconciling an account

Related Topics:
Opening an Account Register
Columns in a Register
Recording Payments in a Register
Distributing an Amount to More Than One Category
Paying by Means Other Than a Check
Recording a Deposit Through a Register
Editing a Transaction
Deleting a Transaction
Setting Register Sort and Display Options



Opening an Account Register

You can open an account register in several ways:

Double Click 1. Double-click on the account whose register you want to 
open.

Drag & Drop 1. Click and drag an account button and drop it on the 
Register button. 

Tools Menu 1. Choose View Register.    The View Register box appears.
2. Choose an account by either:

· double-clicking on the account name
· single-clicking on the account name, then on OK

Register 
Button

1. Click on the Register button.    The View Register box 
appears.    

2. Choose an account by either:
· double-clicking on the account name
· single-clicking on the account name, then on OK

Related Topic:
Using an Account Register



Recording Payments in a Register

If you do not use CA-Simply Money to print checks, record your handwritten checks in the Register.    

The procedure for recording payments in an account register is the same for all account types except 
mortgage and payroll accounts.    For information about mortgage and payroll accounts, see Making a 
Mortgage Payment and Writing Payroll Checks.

Note:    If you use the check printing feature, recording checks through the Checkbook is easier than 
through the Register because checks are automatically marked for printing in the Checkbook.

To make a payment:
1. Drag the account button to the Register button, then drop it.    The register opens, and the cursor is in

the Pay To column of an empty transaction space.
When a register is in standard register format (see Setting Register Sort and Display 
Options), each transaction space in the Pay To/Deposit From column has three lines.    
The first is for the payee name, the second is for an optional memo, and the third is for 
a category.    

2. Type the name of a payee on the first line.    The Payee Browser box appears.
If the payee is new (not in the Payee Browser list), choose New, then add the payee 
button.    (See Adding Payees.)

3. Type the amount of the check in the Payment column.
4. If desired, type an optional memo.

Note:    You can use the Note button to attach a note to the transaction.    See Editing a Transaction 
Note.

5. If desired, distribute the payment to one or more categories. (see Categorizing Your Finances).
Note:    If you do not assign an amount to a category, CA-Simply Money puts it into the 
Miscellaneous category.    The Misc. Expns. category does not appear in the register, but shows as a 
Miscellaneous Expense on reports.

6. If the date of the check is different from the current date, change the date in the Date column.
7. In the Via column, type the check number for your handwritten check, or type P if you want to print 

the check.
8. Choose Record.    CA-Simply Money updates your balance, and a new transaction line appears.
9. Continue entering transactions, or choose Home to return to the main window.

Note:    If you should ever move an amount assigned to the Misc. Expns. category from the Payment 
column to the Deposit column, the category changes to Miscellaneous Income.    The category does 
not appear in the register, but shows as Miscellaneous Income on reports.

Related Topics:
Columns in a Register
Using an Account Register



Columns in a Register 

An account register has columns for the following information:

Date Contains the transaction date.    Type a date or use The 
Calendar.

Via Contains either the check number or a P, which indicates a 
check is ready to print.
Also contains an icon indicating the transaction method 
(check, ATM, wire, and so on).    To change the method, 
double-click on the icon, then select a method from the list that
appears.    The icon changes to reflect your selection.

C Indicates whether the transaction has cleared.    When your 
account statement lists the transaction, click in the box to 
make a check mark appear.

Pay 
To/Deposit 
From

When a register is in standard register format (see Setting 
Register Sort and Display Options), the Pay To/Deposit From 
column has three lines.    The first is for the payee name, the 
second is for an optional memo, and the third is for a category.

Payment Contains the purchase amount.    In Credit Card accounts, this 
column is labeled Charge.

Deposit Contains the amount of a deposit.    In Credit Card accounts, 
this column is labeled Payment.

Balance Contains the balance that CA-Simply Money calculates.    You 
cannot edit this number.

Related Topic:
Using an Account Register



Distributing an Amount to More than One Category

Distributing an amount means you split it among several categories.    For example, if you are paying a 
pharmacy bill that includes a prescription and food, you might distribute the amount to the Medical and 
Groceries categories.

You use the Distribution Register to distribute an amount.    The Distribution Register appears when you 
click on:

· the Distributions button (if it is present) in a dialog box

· the small arrowhead on a category line or in a category box

After you distribute an amount, the arrowhead becomes black.

Note:    The distribution of paychecks is automatic after the first time; see Recording Paycheck Income.    
You can change the distribution of your paycheck in the Record Income box or the Distribution Register.    
In the register, for paycheck distribution, recalculation is automatic.

To distribute to more than one category:
1. Do one of these these things:

· open the Checkbook by clicking on the button for your checking account
· open an account Register by dragging the account button to the Register button
· open a transaction dialog box by clicking once on an income source or account button

2. Type an amount.

Note:    You can skip this step if you want the payment amount to be the total of the amounts you 
assign to each category.

3. Open the Distribution Register by clicking on the arrowhead (or the Distribution button).    In the 
Checkbook and in transaction dialogs the arrowhead is in the Category box; in a Register it is on the 
category line (the third line in standard display format, see Setting Register Sort and Display 
Options).      
Note:    You can also open the Distribution Register by placing the cursor on the category line and 
pressing Ctrl + DnArrow.

4. In the Category column of the Distribution Register, type the first category.
Note:    An X in the Prt column indicates that the category prints on voucher-style checks.

5. In the Amount column, type the amount to distribute to that category.    The remainder of the payment
amount appears on the next category line.

Note:    You can use the Windows Calculator while you are in the Distribution Register by choosing 
Calculator from the System menu.    See Using the Windows Calculator.

6. In the next Category line, type another category.    If you plan to add more categories, change the 
Amount to the amount to distribute to that category.    The remainder of the payment amount appears
on the next line.

7. Repeat step 6 for all categories you want to add.    
Note:    If you leave an undistributed amount in the Distribution Register, the undistributed amount 
goes into the Miscellaneous category.    The Misc. Expns. category does not appear in the register, 
but shows as a Miscellaneous Expense on reports.

8. Click Close to return to the Checkbook or Register.    The total transaction amount appears.

Note:    If want to clear the Distribution Register and reenter categories, place the cursor on the category 
line and press Ctrl + D.



Related Topics:
Distributing a Payment to One Category
Categorizing Your Finances
Deleting a Distribution



Deleting a Distribution

This procedure applies when an amount is assigned to more than one category.    

1. Drag an account button to either the Write button (to open the Checkbook) or to the Register button 
(to open a register).

2. Click on the black arrowhead to open the Distribution Register.
3. Click anywhere on the distribution line you want to delete.

The indicator bar on the right of the distribution register shows which row is currently 
selected.

4. Click on Delete and the row disappears.
5. Click on Recalc Total to correct the transaction amount.
6. Choose OK to return to the Checkbook or Register.

Related Topics:
Distributing a Payment to One Category
Distributing a Payment to More Than One Category
Categorizing Your Finances



Paying by Means Other Than a Check

When you use other means besides a check to make payments and deposits, indicate the method in the 
Via column of the register.    The other methods are credit card, cash, ATM, wire transfer, and direct 
deposit.

1. Drag the account button to the Register button, then drop it.    The register opens.
2. In the Via column, click on the check icon.    A list box appears with the following payment options:    

Check, Credit Card, Cash, ATM, Wire Transfer, or Direct.
3. Choose an option.    The icon in the Via column changes to reflect the method of payment or deposit.

Related Topic:
Using an Account Register



Recording a Deposit Through a Register

This procedure explains how to record a deposit through an account register.    

Note:    You can also make a deposit through an account button.    See Recording a Deposit Through an 
Account Button.

1. Drag the account button to the Register button, then drop it.    The register opens.
2. In the Pay To/Deposit From column, type the name of the income source from which the deposit 

came.
3. Type the amount in the Deposit column.
4. Choose Record.

Related Topic:
Using an Account Register



Editing a Transaction

You can edit a transaction while recording it or after completing it.    You can also edit a transaction while 
reconciling an account (see Reconciling Accounts).    Any changes you make to an amount automatically 
change the account balance.

To edit a transaction:
1. Drag the account button to the Register button, then drop it.    The register opens.
2. Use the scroll bar to locate the transaction you want to edit.    
3. Click on the part of the transaction you want to change, then change it.

Note:    If you should ever move an amount assigned to the Misc. Expns. category from the Payment 
column to the Deposit column, the category changes to Miscellaneous Income.    The category does 
not appear in the register, but shows as Miscellaneous Income on reports.

4. Click on the Record button.

Note:    CA-Simply Money treats every change to a transaction as if the transaction were just being made 
and prompts you to confirm the change.    You can turn this confirmation message off with the Confirm 
Cancel setting.    See Changing System Settings.

Related Topic:
Using an Account Register



Deleting a Transaction

You can delete a transaction while recording it or after completing it.

1. Drag the account button to the Register button, then drop it.    The register opens.
2. Use the scroll bar to locate the transaction you want to delete.    
3. Click on the transaction line, then on the Delete button.    A confirming message appears.
4. Choose Yes.    The transaction line disappears, and CA-Simply Money updates the account balance.

Related Topic:
Using an Account Register



Setting Register Sort and Display Options

You can:

· specify how transactions in a register are sorted

· collapse or expand the space for each transaction

Note:    To change the color or pattern of the register background, see Selecting a Background Pattern.

To set register options:
1. Drag the account button to the Register button, then drop it.    The register opens.
2. In the Register, click on the View button.    The Register View Options box appears.

3. If you wish, choose one of the Sort By options:
Date.    To list transactions chronologically
Check Number.    To list transactions by check number
Payee.    To list transactions alphabetically by payee

4. If you wish, choose one of the Display Format options:
Standard Format.    To display three lines per transaction, for the payee name, the 
memo, and the distribution (category)
Mid Format.    To display two lines per transaction, dividing the second line between the
memo and the distribution
List Format.    To display one line per transaction, showing just the payee name and 
excluding the memo and distribution 

5. Choose OK to return to the Register.

Related Topic:
Using an Account Register



Tracking Credit Cards

You can handle your credit cards in one of two ways: fast payments and detailed payments.



Fast Payments

If you pay your credit card bill in full every month, you may want to make the credit card a payee rather 
than an account.    You can then pay the credit card from your checking (or other) account.    CA-Simply 
Money will not have a record of the merchants you made purchases from, but you can choose to record 
purchase categories when you make your payments.    You will not be able to reconcile your statement.

Related Topic:
Detailed Payments



Detailed Payments

If you want to track and categorize individual credit card charges, and reconcile your charge statements, 
make your credit card an account.    This allows you to record your purchases and track your payments in 
detail.

The alternative is to set up your credit card as a payee and use the fast payment method.    You may want
to do this if you pay off your balance in full every month, or do not care to track your purchases and 
payments.    With the fast method you cannot reconcile your credit card statements.

To maintain a credit card account, you first record detailed usage, then record detailed payments.



Recording Detailed Usage

To maintain a credit card account, you first record detailed usage, then record detailed payments.

To record detailed credit card usage:
1. Click on your credit card account button.    The Account Activity box appears.
2. From the Account Activity box, choose Use Card.    The Credit Card Account Withdrawals box 

appears.
3. If the transaction date is different from the current date, type the date in the Date box.
4. If the transaction is a purchase, in the Merchant box, type the name of the place of purchase.    The 

Payee Browser box appears.
5. In the Amount box, type the amount of the purchase.
6. If the transaction is a withdrawal from an ATM, or a check written against the credit card account, 

click on the down arrow in the Via box to list transaction methods.    Select the appropriate method.
7. You can optionally add a Memo or an ID number.

Note:    The memo could include the ATM slip number or credit card transaction number.    The ID 
could be a check number if you write checks against your credit card.

8. In the Category box, select a category.    See Categorizing Your Finances.
9. Choose Record to accept the transaction.    The amount of the transaction is added to the account 

balance and subtracted from the Credit Remaining.
10. Choose Home to return to the main window.

Related Topic:
Recording Detailed Payments



Recording Detailed Payments

To use the detailed payment method for your credit card, you make your payment while reconciling the 
account.

The reconciliation procedure for credit card accounts performs two functions.    First, it lets you confirm 
your charges as shown on your statement.    Second, it provides a method for paying off your credit card 
bill (partially or in full) by a link to a checking, savings, or other bank account.    You can reconcile the 
account when you make a payment, or reconcile the account at another time.    See Balancing Credit 
Card 
Accounts.

Related Topic:
Recording Detailed Usage



Reconciling Accounts

You can reconcile (balance) all account types except mortgage and payroll.    The accounts most 
commonly reconciled are checking, credit card, savings, and credit line.    When you balance an account, 
CA-Simply Money displays a type of account register so you can see the transaction information. 

Related Topics:
Interpreting the Balance Window
Balancing a Bank Account
Handling Out of Balance Accounts
Balancing a Credit Card Account



Interpreting the Balance Window

When you click on the Balance button or select Balance Accounts from the Tools menu, CA-
Simply Money displays:

· The Balance window, which contains a register list of account transactions and some amounts (see 
below)

· The Balance Account dialog box, which asks for the ending balance on your account statement, plus 
any service charge or interest earned.    CA-Simply Money deducts any service charge from the 
Ending Balance, adds any interest earned, and enters these amounts into your account Register as 
individual transactions. 

The Balance window contains five numbers.

Credits The number and total amount of deposits and interest earned 
that you have checked as cleared in the register list in the 
Balance window.

Debits The number and total amount of payments you have checked 
as cleared in the register list in the Balance window.

Statement 
Balance

The balance of your account at the time the bank prepared 
your statement.

Cleared 
Balance

The balance of your account excluding the credits and debits 
that have not yet cleared (have been transacted between the 
time your statement was prepared and now).

Difference The Statement Balance less the Cleared Balance.

Related Topic:
Reconciling Accounts



Balancing a Bank Account

To balance a bank account:

1. Drag the button of the account you want to balance to the Balance button.    The Balance window 
appears (see Interpreting the Balance Window) as does the Balance Account box.

2. From your current account statement type the ending balance and any service charge (for example, 
the bank's monthly service charge, a stop-payment charge for a checking account, or a late-payment
charge for a credit card account).    For a Liability Account, type the current liability.

3. In the Enter Any Interest Earned box, type any interest shown on your account statement.    For a 
Liability Account, it is any interest paid.

4. Choose OK.    The Balance Account box closes and the register list in the Balance window comes to 
the front of the screen.
The register list shows transactions that have not yet cleared.    A minus sign (-) in front 
of an amount indicates a debit.    Credits have no sign.

5. In the column labeled C (Cleared), click on the boxes of transactions that have cleared on your 
current statement.    If a whole range of checks have cleared, you can enter them all at once; see 
Reconciling by Check-Number Range.    As you clear each item, the amount of the transaction is 
deducted from the Cleared Balance.    The Difference between the Statement Balance and the 
Cleared Balance is updated.    The number of Debits and Credits, and their total amounts, also 
change.

6. If any items on your statement are not recorded or need to be modified, choose the Register button 
so you can add or change them (see Using an Account Register).
From the Register, choose the List button if you want to return to the Balance window to 
clear any newly recorded transactions.

7. From the Register or from the Balance window, choose Home.    If the account balances, the 
Reconcile box appears.    Click on OK to complete the account reconciliation.

8. If the account does not balance (the Difference amount is not $0.00), the Reconcile Closing box 
appears.    For instructions about how to proceed, see Handling Out of Balance Accounts.

Related Topics:
Reconciling by Check-Number Range
Handling Out of Balance Accounts
Reconciling Accounts
Balancing a Credit Card Account



Reconciling by Check-Number Range

During reconciliation you can enter a range of checks that you want to mark as cleared.    For example, 
suppose all checks between #245 and 263 cleared last month. 

1. In the Balance window, click on the Clear Range button.    The Clear Range box appears.
2. In the Clear from and to boxes, type the lowest and highest check numbers in the range.    
3. Choose OK.    

The checks in the range are all marked in the C (cleared) column.

Related Topic:
Balancing a Bank Account



Handling Out of Balance Accounts

When you balance an account, if the cleared balance and your statement balance do not agree, CA-
Simply Money gives you three choices:

Add Adds the positive or negative difference to your register as a 
transaction called "Balance Adjustment."    The Balance 
Adjustment amount is distributed to the Misc. Equity category.  
This is a special category for balance adjustments and starting
balances.    It is not an income, expense, asset, or liability 
category, and is used to add money to an account without 
recording it as income.

Don't Add Leaves the register unbalanced.
Cancel Returns to the Balance window, allowing you to check off 

items and access the account register.

If the difference is small, a few cents to a few dollars, you may want to ignore it and let CA-Simply Money 
add it to the account.    In this case, click on Add.

If the difference is large, however, you may want to figure out why.    Perhaps you forgot to enter a 
transaction, or entered the wrong amount.    In this case, click on Cancel or Don't Add.

Related Topics:
Balancing a Bank Account
Balancing a Credit Card Account



Balancing a Credit Card Account

When you reconcile a credit card account, you can balance the account and pay the bill at the same time.

To balance a credit card account:
1. Either:

· Drag the credit card account button to the Balance button
· Click on the credit card account button, then choose Pay Bill and OK.
The Balance window appears (see Interpreting the Balance Window) as does the Balance Account 
box.

2. From your current account statement, type the ending balance and any service charge (for example, 
a late-payment charge).    

3. In the Enter Any Interest Paid box, type any interest shown on your account statement. 
4. Choose OK.    The Balance Account box closes and the register list in the Balance window comes to 

the front of the screen.
The register list shows transactions that have not yet cleared.    A minus sign (-) in front 
of an amount indicates a debit.    Credits have no sign.

5. In the column labeled C (Cleared), click on the boxes of transactions that have cleared on your 
current statement.    As you clear each item, the amount of the transaction is deducted from the 
Cleared Balance.    The Difference between the Statement Balance and the Cleared Balance is 
updated.    The number of Debits and Credits, and their total amounts, also change.

6. If any items on your statement are not recorded or need to be modified, choose the Register button 
so you can add or change them (see Using an Account Register).
From the Register, choose the List button if you want to return to the Balance window to 
clear any newly recorded transactions.

7. From the Register or from the Balance window, choose Home.    If the account balances, the 
Reconcile box appears.    Click on OK to complete the account reconciliation.

8. If the account does not balance, make corrections in the Register.    When the Difference equals 
zero, choose OK.    The Pay Off Credit Card Balance box appears.    The current account balance 
appears in the Amount box.

9. If you do not want to make a payment, select Cancel to return to the main window.

To pay a credit card bill:
10. If needed, change the displayed date (today's date).
11. In the From Account or Income Source box, type the name of the income source or account where 

the payment comes from.
12. Type the payment Amount.    CA-Simply Money automatically fills in the total amount owed.    You 

have the option of entering a different amount.
13. In the Via box, select a method of payment (such as Check).
14. Type an optional Memo.
15. Choose Record, then choose whether to print a check or just record the transaction.

Related Topics:
Balancing a Bank Account
Reconciling Accounts



Transferring Funds Between Accounts

You can transfer funds between any account types except Mortgage, Credit Line, and Payroll accounts.    
For example, you may need to transfer from savings to checking in order to have enough money to pay 
your bills.

1. Either:
· Drag the button for the account the money will come from to the account the money will go to.    
· Choose Transfer Funds from the Operations menu.    Then, from the dialog box that appears, 

click on the account the money will come from and the account it will go to.
The Account-to-Account Transfer box appears.

Note:    When you drag any account button to a mortgage, credit line, or payroll account (or vice 
versa), CA-Simply Money assumes you want to use the account to make a payment to the mortgage 
or credit line account, or to write a payroll check, and does not offer the option of transferring funds.

2. If needed, change the date.
3. Type the Amount to be transferred.
4. In the Transfer Via box, choose a method of transfer, such as Direct or ATM.
5. Click on Transfer to transfer the funds and return to the main window.

Related Topics:
Editing Transfers Between Accounts
Transferring by Check



Editing Transfers Between Accounts

Use the register of the source account to edit or delete a transfer between accounts, if the amount is 
distributed to more than one category.    Only the part of the transaction distributed to a destination 
account appears in that account's register, so the transfer needs to be edited in the source register, where
the whole transfer is recorded.    

Related Topic:
Transferring Funds



Transferring by Check

If you use CA-Simply Money's check printing feature and you want to transfer funds from checking to 
another account by writing a check, type the name of the account to receive the funds in the Category box
of the check. 

Related Topic:
Transferring Funds



Mortgages

The best way to keep track of mortgage payments is to create a mortgage account and record payments 
in the account.    CA-Simply Money can link the mortgage account to any of your bank accounts, so you 
can print checks.    A mortgage payment is actually a transfer of money from your bank account to a 
liability (usually) account.    You do not need a payee button for your mortgage lender.

If you print checks with CA-Simply Money, use the name of your loan institution on the mortgage account 
button.    For example, if you pay your mortgage to First National Bank, the name on the mortgage 
account button should be "First National Bank."

When you create a mortgage account (see Setting up a Mortgage Account, CA-Simply Money creates the
following categories:

· Mortgage Principal (a liability, top level category)
· Mortgage Interest (an expense, Interest Expenses subcategory, flagged for tax reporting)

CA-Simply Money properly balances the liability of the mortgage against the asset of your equity (realized
and unrealized) to reflect a positive net worth when the mortgage is considered.

Note:    CA-Simply Money has specialized calculators you may find useful with mortgage accounts.    The
Loan Calculator calculates monthly payments from your initial loan information, or calculates how large a 
loan you can afford from your budgeted monthly and down payments.    The Refinance Calculator 
calculates the benefit of refinancing your loan.

Related Topics:
Making a Mortgage Payment
Recording Other Mortgage Costs
Recording Home Improvements
Categorizing Your Finances



Making a Mortgage Payment

You pay a mortgage through the mortgage account button.

1. Click once on your mortgage account button.    The Account Activity box appears.
2. In the Account Activity box, choose Pay Mortgage.    The Mortgage Payment box appears.

If you made a previous mortgage payment against this account, the information from 
the last payment is displayed.
If you amortized your mortgage (see Amortizing Loans), the Amortized Payment box also
appears.    Click OK to enter automatically the correct amounts of principal and interest 
into the Mortgage Payment box.

3. Type the principal and interest amounts (if necessary), and choose the Account or Income Source 
the funds are coming from.    You can optionally type a memo or change the date.
The amount of the transaction is subtracted from Current Loan Balance and displayed in
Total.    The Total Interest Paid to date is displayed.

4. If you need to record other costs such as insurance, click on the Distribution button.    See Recording 
Other Mortgage Costs.

5. Choose Record to accept the transaction.    The Print/Record Check box appears.
6. Choose either Prepare Check for Printing (if you print checks with CA-Simply Money) or Just Record 

Transaction (if you write your own checks).    
A check number box appears with the next sequential check number.    Change the 
check number if necessary.

7. Choose OK to complete the payment and return to the main window.

Related Topic:
Editing Mortgage Payments



Editing Mortgage Payments

When you make a mortgage payment, you do not pay a payee, but you transfer money between 
accounts, usually from checking to the liability and expense categories of your mortgage account.    
Mortgage payments split between liability and expense appear in yellow in the mortgage register, 
indicating you cannot delete or edit them there.    You must edit the transaction in the source account, 
usually your checking account.

Related Topic:
Mortgages



Recording Other Mortgage Costs

Some mortgages have insurance or other costs that you can record when you make your payment.    

1. In the Mortgage Payment box, click on Distributions.    The Distribution register appears.
2. In the Category column of the Distribution Register, type the other cost.
3. In the Amount column, type the amount of the other cost.

Note:    You can use the Windows Calculator while you are in the Distribution Register by choosing 
Calculator from the System menu.    See Using the Windows Calculator.

4. Repeat steps 2 and 3 for any other costs you want to add.    
5. Click on Close to return to the Mortgage Payment box.    The total of the other costs is displayed in 

Other.

Related Topics:
Making a Mortgage Payment
Categorizing Your Finances



Recording Home Improvements

To receive the appropriate tax deductions on your home, you must keep accurate records of additions to 
your home basis equity.    When you use CA-Simply Money to record improvements to your home, the 
value of the improvements is automatically added to your equity.

1. Select your mortgage account button.    The Account Activity box appears.
2. In the Account Activity box, choose Record Improvement.    The Record Home Improvements box 

appears.
3. In the Amount area, type the amount of the improvement purchase.
4. Select the account or income source you used to pay for the improvement.
5. In the Payee box, enter the vendor from whom you purchased the improvement.
6. If you wish, type a memo or change the date.
7. To assign the amount to one or more categories, click on the Distributions button.    The Distributions 

register appears.    Enter one or more categories and amounts, then click on Close.    For information 
about categories, see Categorizing Your Finances.

8. Choose Record to accept the transaction.    The Print/Record Check box appears.
9. Make a selection, then click on OK.
10. Choose Home to return the main window.

The amount of the transaction is added to the current Home Basis.

Related Topic:
Mortgages



Cash and Savings Accounts

If you want to keep track of how you spend your cash, you can create a Cash account to accept transfers 
from other accounts.    You can record individual cash transactions, or record a monthly or weekly lump 
sum that you use for spending money.

For example, you stopped at an automatic teller machine on your way to go shopping and withdrew $50.   
While shopping, you used $15 for lunch.    To record this transaction, drag your Checking account button 
to the Cash button and make a $50 transfer via ATM.    Then use your Cash account to distribute the $15 
payment to a category such as Food or Dining.    As you spend the rest of the $50, you can distribute the 
payments singly, or distribute them all at the same time.

If you withdraw spending money from your Savings account, you don't need to transfer from your Savings
to your Cash account.    Just use the Savings account button to record the withdrawal and distribute the 
expenditures.

Clicking once on a Cash or Savings account button brings up a dialog box with buttons labeled Deposits 
and Withdrawals.    You can also record deposits and withdrawals in the account register as a Special 
transaction (see Adding Specials).    Clicking on the buttons is faster, however, because you can bypass 
the register.

Related Topics:
Recording a Withdrawal
Recording a Deposit Through an Account Button
Recording a Deposit Through a Register
Setting Up a Checking or Savings Account



Recording a Withdrawal

To record withdrawals from a cash or savings account:

1. Select your cash or savings account button.    The Account Activity box appears.
2. From the Account Activity box, choose Withdrawals.    The Cash Out or Savings Withdrawal box 

appears. 
3. In the Payee area, add a new payee or select an existing one.

Note:    You may want to use a Special for withdrawals from a Cash or Savings account (see Adding
Specials).

4. In the Amount box, type the amount of the withdrawal.    You can optionally type a memo or an ID, or 
change the date.

5. Use the Category box to record how you spent the money (see Categorizing Your Finances).
6. Choose Record to accept the transaction.    The amount of the transaction is subtracted from Current 

Balance, and a new Cash-Out or Savings Withdrawal window appears.
7. When you are finished recording cash expenditures, choose Home to return to the main window.

Related Topics:
Recording a Deposit Through an Account Button
Recording a Deposit Through a Register



Recording a Deposit Through an Account Button

To record deposits to a cash or savings account:

1. Select your cash or savings account button.    The Account Activity box appears.
2. From the Account Activity box, choose Deposits.    The Cash In or Savings Deposits box appears.
3. In the From area, type the source of the deposit funds.    The Income Source browser box appears.    

If the funds came from an account, choose Accounts to see the Account browser box.    If you want to
use a Special, choose Specials to see the Special browser box (see Adding Specials).

4. Choose an income source, account, or special.    Click on OK to return to the Cash In or Savings 
Deposit window.

5. In the Amount box, type the amount of the deposit.    You can optionally type a memo or an ID, or 
change the date.

6. If desired, enter one or more in the Category box (see Categorizing Your Finances).
7. Choose Record to accept the transaction.    The deposit is added to Current Balance, and a new 

Cash In or Savings Deposits box appears.
8. When you are finished entering deposits, choose Home to return to the main window.

Related Topics:
Recording a Withdrawal
Recording a Deposit Through a Register



Credit Line and Loan Accounts

Use a credit line account to keep track of bank lines of credit such as home equity loans, or other interest-
bearing loans such as for your car or boat.

For example, your son is in college and needs help with his monthly expenses.    Your bank extends a 
credit line of $5000 to you.    You open a joint bank account with your son and draw on the credit line.

Related Topics:
Using Your Credit Line
Paying Off Your Credit Line



Using Your Credit Line

To use your credit line:

1. Select your credit line account button.    The Account Activity box appears.
2. From the Account Activity box, choose Use Credit.    The Use Credit box appears.
3. In the Payee area, begin typing a payee.    The Payee Browser box appears.    If the payee is an 

account, click on Accounts to change the Browser list.    Choose an account or payee and choose OK
to return to the Use Credit box.

4. Type the Amount, and optionally type a memo, an ID, or change the date.

Note:    The ID could be used for the trace number on an account transfer.

5. If you are tracking your distributions, select one or more categories in the Category area.    See 
Categorizing Your Finances.

6. Choose Record to accept the transaction.    The amount of the transaction is added to the Current 
Balance, and a new Use Credit window appears.

7. When you are finished using credit, choose Home to return to the main window.

Related Topic:
Paying Off Your Credit Line



Paying Off Your Credit Line

You can record payments to credit lines by using the Register, the Checkbook, or the Pay Off Credit box 
(which appears when you click on the credit line account button).    Using the Pay Off Credit box is easiest
because CA-Simply Money automatically enters principal and interest distributions; you do not have to 
enter them yourself.

The Pay Off Credit box displays the Current Loan Balance and Total Interest Paid (which includes interest
paid since recording payments in CA-Simply Money).

To pay off your credit line:
1. Select your credit line account button.    The Account Activity box appears.
2. From the Account Activity box, choose Pay Off Credit.    The Pay Off Credit box appears, with the 

information from your last payment.
The Amortized Payment box also appears if you amortized this credit line.    Click OK to enter 
automatically the correct amounts of principal and interest into the Pay Off Credit box.    If you did not
amortize, you can do so now. See Amortizing Loans.

3. If necessary, type the principal and interest, and choose the Account or Income Source the funds are
coming from by using the Browser boxes.    You can optionally type a memo, or change the date.

4. If you are tracking your distributions, click on Distributions.    See Categorizing Your Finances. 
The amount of the transaction is subtracted from Current Loan Balance and displayed in
Total.    Total interest is shown, and appears the next time you review Pay Off Credit.

5. Choose Record to accept the transaction.    The Print Record box appears.
6. In the Print Record box, choose Prepare Check for Printing or Just Record Transaction.    Choose OK

to complete the payment and return to the main window.

Related Topic:
Using Your Credit Line



Amortizing Loans

Loans have two components, interest and principal.    An amortization table lists how much of a fixed loan 
payment is principal and how much is interest.    You can calculate an amortization table for mortgage and
credit line accounts.

Making payments on an amortized loan is easier and quicker than making payments on an unamortized 
loan.    Principal and interest amounts are automatically filled in; you do not have to enter them yourself.

To set up an amortization table for a loan account:
1. Display the Amortization Setup box.    It appears when you:

· click on the Amortize button at the end of adding a loan account (see Setting Up a Credit Line or
Credit Card Account or Setting Up a Mortgage Account)

· click on the Amortize button at the end of modifying a loan account (drag the account button to 
the Setup button, click on Modify This Button, then click on OK) 

· click on the Amortize button when you pay a mortgage (see Making a Mortgage Payment)
· display the Loan Calculator (see Using the Loan Calculator)

2. Choose Principal, Payment, or Interest Rate, depending on which amount you want CA-
Simply Money to calculate for you.

3. Type the appropriate amounts in the other two boxes.
4. In the Number of Years area, type the length of the loan.
5. In the Payments Made area, choose the payment frequency.
6. If this is a new loan, leave "1" as Payment Number.    Otherwise, type the current payment number.    

If you are not sure of the payment number, click on the Schedule button to see the amortization 
schedule.    By comparing the schedule to your receipts, you may be able to determine which 
payment is the next one.    (See Using the Loan Payment Schedule.)

7. If you pay at the end of the period, click the Payments Made at End of Period box.
8. Click Solve.    CA-Simply Money fills in the missing value.
9. If you want to see or print the amortization table, choose Schedule.    (See Using the Loan Payment 

Schedule.)    
10. Choose OK to complete the amortization set up.

Note:    You can also use the Amortization Setup box to remove amortization information by choosing 
UnAmortize.

Related Topics:
Setting Up a Mortgage Account
Setting Up a Credit Line or Credit Card Account
Setting Up an Asset or Liability Account



Using the Loan Payment Schedule

The Payment Schedule dialog box appears if you click the Schedule button on the Amoritization Setup 
dialog.    The Payment Schedule dialog box contains each amortized payment in a small window that you 
can scroll.    For each payment, it shows payment number, principle, interest, and loan balance.

Use the Payment Schedule dialog box to:

· see the amortization schedule of your loan

· print the schedule (click on the Print button)

· choose which payment is the next one on a loan you have partially paid off.    (Highlight the payment 
by clicking on it, then click on the Select button.)

Related Topic:
Amortizing Loans



Recording Assets and Liabilities

An asset account is for tracking assets such as coin or art collections.    In a business finance group, an 
asset account is for tracking accounts receivable.

A liability account is for personal loans that are not mortgages or credit lines.    In a business finance 
group, a liability account is for tracking accounts payable.

To record asset or liability account transactions:
1. Click once on your asset or liability account button.    The Account Activity box appears.
2. From the Account Activity box, choose Record Decreases or Record Increases.    The appropriate 

box appears.
The Liability box looks the same as the Asset box except it has a From text box instead 
of a Payee text box.    The Asset Increases and Liability Decreases windows have the 
Print Check box.

3. Begin typing an account name in the Payee or From box.    The Account Browser box appears.    
Choose an account, and click on OK to close the Browser box and enter the account name.

4. Type the Amount.    You can optionally type a memo or an ID, or change the date.
5. If you are tracking your distributions, enter one or more categories in the Category area.    See 

Categorizing Your Finances. 
6. Choose Record to accept the transaction.    The Current Balance is adjusted to reflect the 

transaction.
7. Select Home to return to the main window.

Related Topic:
Setting Up an Asset or Liability Account



Investment Accounts

CA-Simply Money can help you track your investments.    Mutual funds, stocks, bonds and other 
investments can be integrated with your other finances.    With CA-Simply Money you can record the 
buying and selling of securities as well as increases in mutual funds, dividends, stock splits, interest and 
expense.

You can update the value of your investments by entering the latest prices of your securities, either 
manually or electronically.    The easy-to-use Modem Stock Update tool gives you access to the latest 
prices through CompuServe or the CA-Simply Money Stock Quote Service.    You can also classify your 
various types of investments and assign them goals.    This lets you evaluate the performance of your 
portfolios.    CA-Simply Money offers a number of specially designed reports and graphs to help you 
analyze your investment performance, and an investment calculator to project your investment needs and
performance.

Related Topics:
Considerations for Investment Accounts
Setting Up an Investment Account
Making Investment Transactions
Transferring Investment Funds
Recording Securities Transactions
Recording Investment Income and Expense
Recording Mutual Fund Transactions
Tax-Free Investment Accounts
Recording Security Price History
Viewing Security Price History
Updating Stock Prices by Modem
Assigning Types and Goals
First-in, First-out Costing Method
Lot Grouping



Considerations for Investment Accounts

An investment account, also called a portfolio, consists of investment instruments that you want to track 
as a group.    The advantage of grouping investments is the financial reports and graphs that CA-Simply 
Money can generate to help you measure the performance of the group.    Set up your portfolio according 
to the way to you want to see your investment information.    Create as many portfolios as you like.

Some portfolios may contain securities, which are investment instruments with a value expressed in 
shares.    Stocks, mutual funds, and bonds are examples of securities.

Other portfolios may contain investment instruments that maintain a constant price, such as money 
market funds and certificates of deposit.

Other portfolios might represent your brokerage account, a family of mutual funds, or investments that 
have the same goal.    

Here are some typical portfolios you may want to create:

Individual security.    If you directly own a security, such as shares of a stock or mutual fund, you can
set up a portfolio for that specific security.

Brokerage account.    You can create an account that represents the account your broker uses for 
you.    As you receive your statements, you can copy the transactions into CA-Simply Money.    Set up a 
separate portfolio for each of your managed accounts.

IRA.    Set up portfolios for you and your spouse.    Since you can add more than one security to a 
portfolio, this is an ideal place to track your IRA investments.    For example, you could enter all of your 
mutual fund purchases into one investment account, even if they are from different fund managers.    
Include your CDs and other non-fluctuating investments.    CA-Simply Money can provide performance 
reports on your IRA as a whole.    CA-Simply Money can also set up your portfolios as tax-free accounts.   
See Tax-Free Investment Accounts.

Some investments may require a different kind of account:

Money market account.    If you are writing checks from a money market account, you may want to 
set it up as a checking account or asset account.

Cash management account.    CMAs are best handled with two separate accounts.    Create a 
checking account for the checking transactions and set up an investment account for all other 
transactions.    When you need to transfer funds to the checking account, you can drag the investment 
account button to the checking account button and record the transaction.

Mutual fund.    You can set up a mutual fund in two ways:    with detailed past transactions, or with just 
the current shares and price.    The detailed method gives you accurate capital gains, but is more time-
consuming.

To show detail, set up an investment account with your opening deposit as the account balance.    Then 
enter your purchases and reinvested earnings.    If you reinvest all earnings, the Increase Securities 
operation (explained later in this chapter) is the easiest way to record it, though you could also record it as
a receipt of earnings and a purchase of shares.

To track just from your last statement, set up an investment account with no account balance.    Then use 
the Increase Securities operation to enter the number of shares owned and the price per share.    After 
initial setup, track all account activity just as for the detailed type of mutual fund investment account.    

Broker margin account.    A broker margin loan is similar to any other type of loan, except the 
securities in your account are the collateral.    One way to set up a broker margin loan is as a credit line 
account, and make its category for interest tax-free.    Interest on margin loans is generally deductible if 
used for investing, with some tricky exceptions.

Another way is to use a liability account for the principal amount of the loan.    For example, suppose you 



borrow $10,000 on your security account.    To record the loan in CASimply Money, set up a liability 
account with 0 as the account balance.    Drag and drop from the liability account to your checking 
account, and deposit the $10,000.    As you pay off the loan, enter the principal in the liability account as a 
decrease.    Enter the margin interest in your investment account.

Related Topic:
Setting Up an Investment Account



Setting Up an Investment Account

An investment account is for buying and selling securities.    Use it to record and track taxable and non-
taxable interest, short- and long-term capital gains and losses, dividends, margin interest, and 
miscellaneous expenses.    For information about handling different types of investment accounts (such as
IRA, money market account, brokerage account), see Consideration for Investment Accounts. 

Setting up an investment account is similar to setting up any other account in CA-Simply Money.

1. Drag the Setup button to the Accounts button.    The Account Setup box appears.    
2. Choose Add an Account.    The Account Setup - Add box appears.
3. In the Name area, type a name for your account.

If the account represents a brokerage account, you could use your broker's name.    A collection of 
Mutual Funds could be called "Mutual Funds."    Use any name that makes sense to you.

4. From the Account Type list, choose Investment Acct.    
5. If you want to enter an address, click on the Address button.

The Additional Information box appears.    It has text boxes for address, telephone number, contact, 
and account number.    After entering any information, click on OK to get back to the Account Setup - 
Add box.

6. If you want to change the icon, click on the Icons button.
The Select an Icon box appears.    It contains a gallery of icons. Scroll through until you find an 
appropriate one, then click on it and click OK.

7. Click OK.    The Account Balances box appears.
8. In the Account Balances box, type the cash balance.    Consider:

· If you are adding all previous transactions for a security, you do not need a starting balance.  
Instead, record the initial cash in the account as a transfer from another account (see 
Transferring Funds).

· If you want to avoid adding previous transactions, just enter the current balance of the 
investment account as the starting balance.    However, performance reports for the account will 
not be accurate.

· If you are creating an account for mutual funds and want to avoid adding previous transactions, 
do not enter a starting balance.    Instead, enter the current number of shares and the share 
price (see Increasing the Number of Shares ).

If you want the cash balance to have a date other than today's date, press Alt+D and enter the date.
9. If the account is a Keogh, SEP-IRA, IRA, or other retirement account, click on Tax-Free Account.    

This causes CA-Simply Money to exclude the income, such as dividends and capital gains, from the 
Tax Summary report.    For procedures on contributing to and withdrawing funds from tax-free 
accounts, see Tax-Free Investment Accounts.

10. Choose OK to return to the main window.    The new investment button appears with your other 
accounts.

Related Topics:
Considerations for Setting Up an Investment Account
Investment Accounts



Making Investment Transactions

The three basic types of investment operations are recording the purchase and sale of securities, 
recording income and expense, and transferring funds to and from an investment account. 

CA-Simply Money provides two ways to make these transactions:

· The Operation window, which you access by clicking once on a button for an investment account.    
The Operation window is most useful for recording new transactions.

· The Investment Register, which you access by dragging an investment account button to the 
Register button, then dropping it.    The Investment Register is most useful for modifying existing 
transactions. 

Related Topics:
The Investment Register
Investment Accounts



Income Types

The Income section of the Operation window lets you record the income you earn in your investment 
portfolio.    The income types are:

Interest.    You can record interest earned on your investments and specify that income as taxable or 
non-taxable.    For example, you may receive income earned on a money market fund that is the cash 
balance of a brokerage account.

Capital Gain/Loss.    CA-Simply Money automatically records the gain or loss when you sell your 
securities.    However, with mutual funds you may receive cash distributions of capital gains.    You can 
record those distributions using the Capital Gain button and specify the distributions as short term or long 
term.

Dividend.    Dividends can be in the form of additional shares of stock or cash.    Use this category for 
cash dividends.    

Miscellaneous.    Use this category for any income other than interest, capital gains, or dividends.

Related Topic:
Recording Investment Income and Expense



Expense Types

The Expense section of the Operation window lets you record the expenses you incur from investing.    
The expense types are:

Margin Interest.    Use this category to record the interest on funds you borrow from your broker.

Miscellaneous.    Use this category for any expense other than margin interest.

Related Topic:
Recording Investment Income and Expense



Transferring Investment Funds

If you have a brokerage account, you may need to add funds from other accounts to pay for purchases.    
When you sell securities or receive dividends, you need to remove funds from your investment account.    
Transferring funds to and from investment accounts is basically the same as transferring between other 
accounts in CA-Simply Money.

If transfers occur at the time of a transaction, you can perform the purchase and the transfer at the same 
time.    See Funding a Buy.

To add funds to an investment account:
1. Display the Account-to-Account Transfer box by either:

· dragging the account button the funds are coming from to the investment button.
· clicking on the investment button.    From the Operation window, choose Transfer Funds In, then

select the account name.    
2. In the Amount box, type the amount of the transfer.    In the To Account box, type the destination 

account.    Choose a method in the Transfer Via box.
3. Click on Transfer to complete the transaction.    The funds are transferred directly to the investment 

account.

Note:    If you want to view the transaction and the current balance of the investment account, click on the 
Reports button in the tool rack.

To remove funds from an investment account:
1. Click once on the investment button.    The Operation window appears.
2. Choose Transfer Funds Out.    
3. Type the destination account and transfer amount and click on Transfer to complete the transaction.

The funds are deducted from the investment account.

Related Topic:
Investment Accounts



Recording Securities Transactions

CA-Simply Money can record all the information typically involved with investment transactions, including:

· Buying and selling securities
· Recording information about each security
· Recording the increase and decrease in shares due to reinvestment
· Recording the increase in shares due to stock splits

Related Topics:
Buying Securities
Funding a Buy
Adding New Securities
Adding or Changing an Investment Goal or Type
Updating the Price of a Security
Making Securities Inactive
Modifying a Security
Changing a Security Name
Selling Securities
Increasing the Number of Shares
Decreasing the Number of Shares
Recording Share Transfers
Recording Stock Splits
Recording Security Price History
Specifying a Return of Capital
Assigning Types and Goals
Lot Grouping
Calculating Security Performance



Buying Securities

Recording security purchases in CA-Simply Money involves entering the name of the security along with 
the number of shares, share price, and commission.    You can fund the purchases from the cash in the 
investment account or by transferring funds from another account.

1. Click on the investment account button.    The Operation window appears.    
2. From the Operation window, choose Buy.    The Buy Securities box appears.    

The balance in the current investment account appears in the lower right of the box.    If 
you have already transferred funds into the account, you see a positive balance.

3. If you need to transfer funds from another account into the investment account, see Funding a Buy
4. Type the date of the purchase.
5. Type the name of the security you are buying.    The Security Browser box appears.    If you are 

purchasing a security for the first time, you need to add information about the security.    See Adding 
New Securities.    Inactive securities do not appear in the browser box (see Making Securities 
Inactive).

6. In the Shares box, type the number of shares in up to three decimal places.    
7. In the Price box, type the current price of the security.    If you have purchased the security before, 

the last recorded price for that security appears.    You can enter the share price in decimal (35) or 
fractional (3 1/2) notation.    See Entering Share Prices.
The total amount of the transaction is automatically calculated and displayed.

Note:    You can also add historical pricing for your securities.    See Recording Security Price History.

8. In the Commission box, type the amount of the commission and fees.
The total of the Amount and Commission boxes is automatically calculated and 
displayed when you click in the Total box.

9. If you wish, type a memo in the Memo box.
10. Click on Record to complete the transaction.    The Operation window appears.

The total amount of the transaction is automatically deducted from the balance of the investment 
account.    You can view the balance through a report or the register.

Related Topic:
Recording Securities Transactions



Funding a Buy

Use this procedure to transfer funds into your investment account while you are recording security 
purchases.

1. Click on the investment account button.    The Operation window appears.    
2. From the Operation window, choose Buy.    The Buy Securities box appears.    
3. In the Buy Securities box, click on Funds To/From.    The Funding Account Option box appears.    
4. Type the name of the account with which you want to fund the Buy.    The current balance in that 

account appears.
5. Continue entering security purchase information.    See Buying Securities.

Related Topic:
Recording Securities Transactions



Adding New Securities

Typically, you add a new security while buying securities, as shown here.    However, you can enter a new 
security while completing any investment operation.    

For your convenience, the ticker symbols for the DowJones Industrial Average and the S&P 500 are set 
up in CA-Simply Money.    You can use CA-Simply Money to compare the performance of securities you 
own against the performance of these averages.    For more information, see Modem Stock Price Updates
or Updating the Price of a Security.

1. Click on the investment account button.    The Operation window appears.    
2. From the Operation window, choose Buy.    The Buy Securities box appears.    
3. In the Name area, type the name of the new security.    The Security Browser box appears.    
4. Click on New to add the security to the list.    The New Security box appears.    
5. Enter the symbol and current price (see Entering Share Prices).    If you wish, enter a goal, type, and 

expiration date.
6. Click on OK to record the new security.    The Operation window reappears.    The symbol, share 

price, and any expiration date for the new security now appear along with the security name.

Note:    You can also add a new security from the menu bar on the main window.    From the Edit menu, 
choose Investments, then Securities.    The Edit Security box appears.    

Related Topic:
Recording Securities Transactions



Adding or Changing an Investment Type or Goal 

You can track your investments based on the type of investment or the goal of a security.    CA-
Simply Money provides a list of common security types and goals.    Typical types are Stock, Bond, Mutual
Fund, and IRA.    Typical goals are Growth, Income, and High Return.    You can modify these or add your 
own.

CA-Simply Money can produce reports showing the performance of securities and the success of security
types in achieving an investment goal.    

To add or change a type or goal:
1. From the Edit menu, choose either Investments/Types or Investments/Goals.

The Security Type Editor or Security Goal Editor box appears.
2. To add to the existing list, type a new name into the text box at the bottom of the dialog box and click 

New.
3. To change the name of a type or goal, select the current name in the list, type a new name in the text

box, and click Change Name.
4. To remove a type or goal from the list, select it and click Delete.

Related Topics:
Assigning Types and Goals
Recording Securities Transactions



Updating the Price of a Security

To update the price of a security:

1. From the Edit menu, choose Investments/Securities.    The Edit Security box appears.
2. In the Symbol area, type the symbol for the security.    If you want to update the price by modem, you

must use the exact ticker symbol. This is usually a 2-, 3-, or 4-character symbol.
3. Click on Update Price by Modem if you want the security price to be updated by the automatic price 

update feature.    Only securities flagged this way are included in the updates.

Related Topics:
Modem Stock Updates
Recording Securities Transactions
Viewing Security Price History



Making Securities Inactive

If some securities are not a part of your current holdings, but may be purchased again in the future, you 
can "hide" them from the browser box. 

1. From the Edit menu, choose Investments/Securities.    The Edit Security box appears.
2. Click on Active Security to remove the "X."    The security will not appear in the Security Browser box. 

When you want to make the security active, just click on Active Security again.

You can include inactive securities in any graph or report.

If the security is a bond or option, you need to record the expiration date.    The Expiration Report and the 
Advisor use the expiration date to remind you when to sell the security.

1. From the Edit menu, choose Investments/Securities.    The Edit Security box appears.
2. Click on Exp Date and type the expiration date.

Related Topic:
Recording Securities Transactions



Modifying a Security

Use this procedure to change a security's symbol, price, type, or goal.    

To change the name of a security, see Changing a Security Name.    If you want to update the price of 
security by modem, see Updating the Price of a Security.    To remove a security from the browser box, 
see Making Securities Inactive.    

To modify an existing security:
1. From the Edit menu, select Investments, then Securities.    The Edit Security box appears.    
2. Type part of the security name in the Name area.    The Security Browser appears.    Highlight a 

security name, then click OK.
3. Make the necessary changes to the security.
4. Click on Save to record the changes.

Note:    You can also add historical pricing for any security.    See Recording Security Price History.

Related Topic:
Recording Securities Transactions



Changing a Security Name

To change the name of a security:

1. From the Edit menu, select Investments, then Securities.    The Edit Security box appears.    
2. Type part of the security name in the Name area.    The Security Browser appears.    Highlight a 

security name, then click OK.
3. Click on Change Name.    The Security Name Editor box appears.    
4. Type the new name for the security.
5. Click on OK.    The new name appears in the Name area.

Related Topics:
Modifying a Security
Recording Securities Transactions



Selling Securities

When you record the sale of securities, the proceeds from the sale are either added to the cash value of 
the investment account or transferred to another account.

To sell a security:
1. Click on the investment account button.    The Operation window appears.    
2. From the Operation window, choose Sell.    The Sell Securities box appears.
3. Type the date of the sale.
4. Type part of the security name in the Name area.    The Security Browser appears.    Highlight a 

security name, then click OK.
5. Type the number of shares in up to three decimal places.    Enter the share price in decimal (35) or 

fractional (3 1/2) notation.
6. Type the amount of the commission.
7. If you are transferring the proceeds from the sale to a different account, click on Funds To/From and 

specify the account.
8. Click on Sell to complete the transaction.

CA-Simply Money automatically uses the difference between the purchase and selling prices to calculate 
the gain or loss.    The amount is attributed to the Realized Gains/Losses category and is displayed in 
reports.

CA-Simply Money uses a first-in, first-out method of calculating gains/losses.    For more information, see 
First-in, First-out Costing Method.        If you want to record your maximum gain/loss for a transaction, see 
Lot Grouping. 

Note:    When you sell short, CA-Simply Money still calculates the gain/loss, just as with a standard 
transaction.    Selling short means you sell shares of a security you do not own.    You "sell" shares your 
broker owns and buy them back in the future, hopefully at a lower price.    The transaction is the reverse of
a standard one¾you sell, then buy.    When you sell short, select Sell from the Operations menu.    Select 
Buy when you purchase the shares back. 

Related Topic:
Recording Securities Transactions



Increasing the Number of Shares

When you do not want to change the cash balance of the investment account, use the Increase/Decrease
operations.    By using these operations you can increase or decrease the value of the portfolio without 
affecting the cash balance.

These operations are useful if you do not care about recording the historical basis and/or cash value of an
account.    You can just record increases and decreases in the number of shares you hold.

You can also use the Increase/Decrease operations with mutual funds.    Mutual fund companies 
commonly reinvest dividends and capital gains directly into the investor's account.    This usually takes the
form of shares on your statement.    You can add these shares directly to your portfolio.    Certain other 
securities may use reinvestment also.    See Reinvesting Mutual Funds.

Increasing the holdings for a security is done in a way similar to buying a security.    Transferring funds 
from another account is not possible with an Increase, however.

To increase the number of shares:
1. Click on the investment account button.    The Operation window appears.    
2. From the Operation window, choose Increase.    The Increase Securities box appears.    
3. Type part of the security name in the Name area.    The Security Browser appears.    Highlight a 

security name, then click OK.
4. Enter the number of shares (in up to three decimal places), price (in decimal or fractional format), 

commission and fees, optional memo.
5. Click on Record to complete the transaction.    The Operation window reappears.    

The increase in shares appears as an Add in the investment account register.

Related Topics:
Decreasing the Number of Shares
Buying Securities
Recording Securities Transactions



Decreasing the Number of Shares

Decreasing the holdings for a security is almost the same procedure as increasing holdings.

1. Click on the investment account button.    The Operation window appears.    
2. From the Operation window, choose Decrease.    The Decrease Securities box appears.    
3. Type part of the security name in the Name area.    The Security Browser appears.    Highlight a 

security name, then click OK.
4. Enter the number of shares (in up to three decimal places), price (in decimal or fractional format), 

commission and fees, optional memo.
5. Click on Record to complete the transaction.

Related Topics:
Increasing the Number of Shares
Recording Securities Transactions



Recording Share Transfers

You may need to record a transfer of shares from one account to another.    If you transfer the shares at 
the current price, your investment reports will show a gain in the first account.    This may be desirable, but
most likely you want to transfer the shares at cost. 

To transfer the shares at cost, first determine the purchase price of the shares by looking at a Transaction 
Report.    Then use the Decrease operation to remove the shares at the purchase price.    Finally, use the 
Increase operation to add the shares to the new account at the purchase price.

If you are transferring a group of shares that were acquired in separate lots (at different prices), complete 
a series of Decrease operations at the original acquisition price.    You can determine this price with the 
Investment Transaction report.    To specify the securities you are interested in, choose Filters and Styles 
from the Options menu on the report window.    Then specify a date range in the Report Generator box, 
and click Include.

Related Topic:
Recording Securities Transactions



Recording Stock Splits

When the market price of a stock reaches an inconvenient trading range, the company may decide to split
the shares.    A stock split causes no change in the value of a stockholder's equity.    However, as a 
stockholder, you need to record the split in order to continue tracking your shares under the new share 
price.

1. Click on the investment account button.    The Operation window appears.    
2. From the Operation window, choose Split.    The Record Stock Split box appears.    
3. In the Date area, type the date of the split.
4. Type part of the security name in the Name area.    The Security Browser appears.    Highlight a 

security name, then click OK.
5. Enter the type of split.    The Number of Shares area has a place for old and new shares.    A 2:1 split 

is the most typical, however, other splits are common.

Example:    You receive notice of a 2:1 stock split for Hudson Data.    You have 100 original shares.    
The number of new shares would be twice the original or 200.

6. In the New Price for Share area, type the new price of the security (in decimal or fractional format).    
An announcement of a split is usually accompanied by the new price.

7. Click on Record to complete the transaction.    The Operation window reappears.

The transaction appears in the Investment Register and transaction reports as an Add.    The value of your
investment account remains the same.

Related Topic:
Recording Securities Transactions



Recording Investment Income and Expense

Your investment account balance changes because of income and expense.    The main sources of 
income are Interest, Capital Gains, and Dividends.    A common expense is Margin Interest.

If you need to record the reinvestment of dividends or interest (usually in a CD or mutual fund), see 
Reinvesting Mutual Funds.

Note:    The Dividend calculator calculates the interest rate equivalent to a given dividend return.    You 
can use this calculator to compare the advantage of different investment strategies.

To record the various types of income and expense:
1. Click on the investment account button.    The Operation window appears.    
2. In the Operation window, click on one of the Income or Expense buttons.    The related box appears.   
3. Type the date of the transaction.
4. Type part of the security name in the Name area.    The Security Browser appears.    Highlight a 

security name, then click OK.
5. Type the amount of the income or expense.
6. Type an optional memo.
7. In the Category box, select the appropriate category.
8. If the income/expense was transferred to/from another account, click on the Funds To/From box.
9. Click on Record to complete the transaction.

Related Topics:
Income Types
Expense Types
Investment Accounts



The Investment Register

The Investment Register is similar to the other CA-Simply Money registers.    Although you can use the 
register to record new investment transactions, it is most useful for modifying existing transactions.    You 
can change dates, view balances, add memos, and delete transactions.    (To record new transactions, 
use the Operation window, which you can access by clicking once on an investment account button.)

To display the Investment Register, drag an investment account button down to the Register button, then 
drop it.

The following columns make up the Investment Register:

Date Date of the transaction.
Oper Type of investment transaction (or operation).    These types 

correspond to the buttons on the Operation window.    To select
an operation, click in the Oper column, then select the 
operation from the browser box that appears.

Security/
Memo

The name of a security, an optional memo, and the category.   

Shares The number of shares in a transaction.
Price The price of the shares at the time of the transaction.
Comm The commission (if any).
Total The total cost:    commission plus the cost of shares (number 

of shares multiplied by price).
Cash Bal The cash balance of the investment account as of the date of 

the transaction.

The values in the box in the lower right of the investment register are:

Book Value The purchase price of securities (net of commissions) plus the 
cash balance.

Share 
Value

The purchase price of securities (net of commissions).

Related Topic:
Investment Accounts



Specifying a Return of Capital

Return of capital is a non-taxable repayment of some or all of the funds you invested in a particular 
security.    Securities that may return capital include GNMAs and unit trusts.    Return of capital is not the 
same as a capital gains distribution.    

The Oper column of the Investment Register contains a choice called "Return of Capital."    This choice is 
displayed only in the Register, not in the Operation window.

To specify a return of capital:
1. Drag an investment account button to the Register button, then drop it. 
2. In the Oper box of the Investment Register, select Return of Capital.
3. Complete the rest of the transaction and record it.

Related Topic:
Investment Accounts



Recording Mutual Fund Transactions

In general, you use the same procedure for recording mutual fund transactions as for recording stock 
transactions.    You buy and sell shares and CA-Simply Money keeps track of the cost-basis of the shares. 
Recording your mutual funds, however, may require these additional transactions:

· Capital gains distributions
· Custodial fees
· Loads
· Reinvestments

Related Topics:
Capital Gains Distributions
IRA Custodial Fees
Load Funds
Mutual Fund Reinvestments
Investment Accounts



Capital Gains Distributions

Capital gains distributions are usually itemized on your statement as reinvestments in shares of a mutual 
fund.    The distributions may be either short-term or long-term capital gains.

If your capital gains are reinvested, see Mutual Fund Reinvestments.    If you receive a cash distribution, 
you can transfer it to an account; see Recording Investment Income and Expense.

Related Topic:
Recording Mutual Fund Transactions



IRA Custodial Fees

If you invest your IRA or other retirement funds in a mutual fund, the custodian of the fund might redeem 
shares to pay your custodial fee.

To redeem shares as a custodial fee:
1. Click on the button for the mutual fund.    The Operation window appears.
2. Choose Sell from the Operation window and select the appropriate fund.    
3. Type the number of shares and the price when the shares were redeemed.
4. Type the same dollar amount in the Commission box.    This makes the net amount of the transaction

equal to zero.

Related Topic:
Recording Mutual Fund Transactions



Load Funds

Most mutual funds are no-load funds.    Some mutual funds, however, add commissions to the purchase 
price of their shares.    This commission is called a load.    The purchase price of a load fund is called the 
Offer or Buy price.    The NAV or Sell price is the selling price.    

To track the correct market value, use the Offer price when you record the purchase of a load fund.    Use 
the NAV price when you update the value of your investment.

Related Topic:
Recording Mutual Fund Transactions



Mutual Fund Reinvestments 

Some securities, particularly mutual funds, pay dividends, interest income, and capital gains with 
additional shares.    To record the reinvestment:

1. Click on the account button for the mutual fund.    The Operation window appears.
2. In the Operation window, click on the appropriate income button.    Record the information about the 

transaction as described in Recording Investment Income and Expense.
3. In the Operation window, click on Increase Securities.    Record the reinvestment information, 

including the number of shares and share price.    This information is usually on your statement.

Related Topic:
Recording Mutual Fund Transactions



Tax-free Accounts

Accounts such as an IRA, Keogh, and other retirement plans are tax free.    Income is not taxable, even if 
it comes from a normally taxable source such as bank interest or capital gains.    All or part of the money 
you put into the account may be tax-deductible.    All or part of the money you take out may be taxable 
income.    In some states, the rules for state taxation may be different from the federal rules.    Consult 
your tax advisor to determine the tax treatment of a contribution or disbursement.

Example:    You create two investment accounts, one called Broker and a second, tax-free account called
IRA.    In each account, some stock is bought and then sold at a profit.    On a Tax Summary report, the 
profit for the Broker account appears in the category Short-Term Cap. Gains\Broker.    The profit for the 
second account appears in Short-Term Cap. Gains\IRA.

Both of these amounts appear in reports such as Cash Flow.    However, in the Tax Summary report, only 
taxable profit in the Broker category appears.    The tax-free profit in IRA does not appear in the Tax 
Summary report.

Note:    For a tax-free investment account, the Operation window still includes buttons for Taxable and 
Non-Taxable interest.    Be sure to select the correct button.

Note:    Set up a 401(k) as an asset account (see Setting up an Asset or Liability Account).

Note:    To see which categories are tax-free, use the Edit Categories command (see Modifying a 
Category).    Select a category, click on Modify, and see if the Tax-Related box is selected.    You can 
always modify the tax-free status of any account.

Related Topics:
Contributing to Tax-Free Accounts
Contributing to a 401(k)
Withdrawing from Tax-Free Accounts



Contributing to Tax-Free Accounts

To make a tax-deductible contribution to an IRA or other tax-free account, either:

· record two separate transactions, as shown in this topic
· split the deposit for contributions made through payroll deduction, as shown in Contributing to a 

401(k)    

Do not use an account-to-account transfer to make a tax-deductible contribution.

To contribute by using two transactions:
1. Click on the button for the account the contribution is coming from.    An example could be your 

checking account.
2. Select the investment account to receive the funds, and type the amount.    For example, write a 

check to the tax-free account.
3. Start typing a category on the category line.    The Category Browser appears.
4. Click on the Expense radio button in the Category Browser.
5. If this is your first contribution, you may need to create a new category.    Type the category name (for

example, IRA Contribution) on the category line of the check or account register, then click the New 
button on the Category Browser.    The New Category box appears.    Click in the Tax-Related box to 
select it.
If this is not your first contribution, highlight a category (such as IRA Contribution) in the Category 
Browser, then click OK. 

6. Click on Record, then Home.
7. In the main window, click on the button for the tax-free account.    
8. Choose the type of transaction:    

Choose: For: 
Deposit Bank account
Misc. Income Investment account
Record Increases Asset account

9. Type the amount of the contribution.    Leave the Category blank.    Click on Record, then Home.

Note:    If the contribution is partially deductible, record the deductible portion using the procedure 
described above, and the non-deductible portion by an account-to-account transfer.

Related Topic:
Tax-Free Accounts



Contributing to a 401(k) 

Use this procedure for recording 401(k) contributions and other deductions from your paycheck such as 
medical insurance.    If you have not already created a 401(k) account, first create an asset account as 
detailed in Setting Up an Asset or Liability Account.

1. Deposit your paycheck (see Recording Paycheck Income).
2. Click the Distributions button in the Record Income dialog box.    The Distribution Register appears.
3. On the first blank line, start typing the name of your 401(k) account.    A browser box appears.
4. Click the Asset button in the browser.    Then click on your 401(k) account from the list, and click OK.
5. In the Amount column of the Distribution register, type the contribution amount as a negative number.
6. To add other deductions such as medical insurance, repeat steps 3 through 5, except click on 

Expense in the browser.
7. Click on Close.    The Record Income box reappears.
8. Click Record to record your paycheck income and deductions.    The Net amount on the Record 

Income box, your gross income less all deductions and adjustments, is added to the destination 
account automatically.    

The 401(k) amount is added to your 401(k) asset account.

Related Topic:
Tax-Free Accounts



Withdrawing from Tax-Free Accounts 

Funds withdrawn from a tax-free account are generally considered taxable income.

To withdraw from a tax-free account:
1. Click on the button for the tax-free account.    
2. Select the type of transaction:

Choose: For: 
Withdrawal Bank account
Misc. Income Investment account
Record Decreases Asset account

3. Type the amount of the withdrawal.    Leave the category blank.    Click on Record, then on Close to 
get back to the main window.

4. Drag the button for the account to receive the withdrawn funds to the Register button, then drop it.    
An example could be your checking account button.    The register opens.

5. Start typing the name of the tax-free account in the Pay to area.    The browser appears.    Click on 
the Accounts radio button.    If the account is not already highlighted, click on its name, then on OK.

6. Type the amount of the withdrawal in the Deposit column.
7. Start typing a category on the category line.    The Category Browser appears.    
8. Click on the Income radio button in the Category Browser.
9. If this is your first withdrawal, you may need to create a new category.    Type the category name (for 

example, IRA Withdrawal) on the category line of the account register, then click the New button on 
the Category Browser.    The New Category box appears.    Click in the Tax-Related box to select it.
If this is not your first withdrawal, highlight a category (such as IRA Withdrawal) in the Category 
Browser, then click OK. 

10. Click on Record, then Home.

Note:    Another way to withdraw is to disburse the funds directly from the tax-free account.    First use the 
procedure above, transferring the funds from the tax-free account to itself.    Then record the expenditure.

Note:    If only part of a withdrawal from a tax-free account is taxable income, record the taxable portion 
using the previous procedure for making a withdrawal.    Record the non-taxable portion with an account-
to-account transfer.

Related Topic:
Tax-Free Accounts



Recording Security Price History

The balance of your investment account reflects the latest prices you have entered for your securities.    
CA-Simply Money tracks unrealized paper gains or losses and performance using the last known security 
price as of your report date.

CA-Simply Money makes it easy to add and modify historical prices for your securities.

Related Topics:
Adding a Price
Modifying a Price
Deleting a Price
Modem Stock Updates



Adding a Price

Before recording prices for a security, you must add the security.    See Adding New Securities.

To add a historical share price:

1. From the Edit menu, choose Investments, then Securities.    The Edit Security box appears.    
2. Use the Name box to select an existing security.
3. Click on Price History.    The Security Price History box appears and displays the prices you have 

already recorded.    The list includes any prices recorded from other investment transactions, such as
Buy and Sell.

4. Click on New.    The Price History box appears.    
5. In the Date box, type the date of the historical price.
6. In the Price box, type the historical price.
7. Click on Save to save the price.    The Security Price History box displays the new price.

Related Topic:
Recording Security Price History



Modifying a Price

To modify a share price:

1. From the Edit menu, choose Investments, then Securities.    The Edit Security box appears.    
2. Use the Name box to select an existing security.
3. Click on Price History.    The Security Price History box appears and displays the prices you have 

already recorded.    The list includes any prices recorded from other investment transactions, such as
Buy and Sell.

4. In the Security Price History box, click on the price you want to change.
5. Click on Edit.    The Price History box appears.
6. Type the changes to the date or price.
7. Click on Save.

Related Topic:
Recording Security Price History



Deleting a Price

To delete a share price:

1. From the Edit menu, choose Investments, then Securities.    The Edit Security box appears.    
2. Use the Name box to select an existing security.
3. Click on Price History.    The Security Price History box appears and displays the prices you have 

already recorded.    The list includes any prices recorded from other investment transactions, such as
Buy and Sell.

4. In the Security Price History box, click on the price you want to delete.
5. Click on Delete.    The price disappears from the list.

Note:    You can only restore deleted prices by adding them again.

Related Topic:
Recording Security Price History



Assigning Types and Goals

CA-Simply Money provides a simple system for tracking the performance of your portfolio:    grouping 
investments by type or goal.    Examples of investment types are Stock, Mutual Fund, and IRA.    Typical 
goals are High Return, Growth, and Income.    

Types are valuable because what you consider successful for your stock portfolio may not be successful 
for your mutual fund investments.    Assigning Types to your investments lets you look at the performance 
of each type.    For example, you may have a stock brokerage account and also own another security 
outright.    You could assign each of these to the Stock type.    Reports and graphs could then display the 
performance of your stock investments as a whole.

Goals let you monitor investments according to the benefits you expect from them.    Suppose one of your 
stock holdings is be for High Return while another is for Growth.    You probably have different 
expectations for the two investments.    As with Types, you can display reports and graphs that show you 
how your goals are being met.

You can add your own types and goals to the ones CA-Simply Money provides, delete unused ones, or 
modifying existing ones.    For example, you may want to add T-Bill, NYSE, AMEX, NASDAQ, and Option 
as types.    As goals, you might add Low Risk, Retirement, or High Return.

You can create as many types and goals as you need.

Related Topic:
Adding New Goal and Type Options



Entering Share Prices

You can enter share prices as decimal numbers or as fractions.    Decimal values that are multiples of 
1/16 are automatically converted into fractions.    If the price is not a multiple of 1/16, it remains a decimal.

Example:    The price of 125 is displayed as 12 1/2.    The price of 124 is displayed as 124.

To enter a share price as a fraction:
1. Type the whole dollar amount, then a space, and then the fraction.    Use a slash ( / ) between the 

numerator and denominator.
Example:      12 1/8

Related Topic:
Recording Securities



First-in, First-out Costing Method

CA-Simply Money uses a first-in, first-out method for tracking the capital gains/losses of your investments.
The method is based on the assumption that the oldest shares are sold first.    The method is systematic, 
easy to apply, and conforms to accepted accounting principles.

Example:    The transactions in your stock portfolio for January are as follows:

Jan. 8 Buy     500 shares @ $ 8 $ 4,000
Jan. 25 Buy 1000 shares @ $ 9 $ 9,000
Jan. 30 Sell 1000 shares @ $ 10 $10,000

The costing method assumes that the shares sold on Jan. 30 were those acquired first:    the 500 shares 
bought on Jan. 8, and 500 of the shares bought on Jan. 25.    The cost basis of the sold shares is: 

Jan. 8 500 shares @ $ 8 $ 4,000
Jan. 25 500 shares @ $ 9 $ 4,500

Total cost $ 9,500

The resulting capital gain for the period is $500 ¾ the proceeds of the sale ($10,000) less the cost 
($9,500).



Lot Grouping

You may decide to track individual lots of stocks to balance gains and losses during the year.    For 
example, one lot of stocks might show a gain, and the other a loss, depending on the current price.    You 
may decide to sell the winner if you have losses or sell the loser if you have off-setting gains.

Example
You set up a portfolio to track purchases of SysCom stock.    In January you purchase two lots:

Jan. 6 Buy 1000 shares @ $ 6 $ 6,000
Jan. 23 Buy 1000 shares @ $ 8 $ 8,000

To keep track of the lots, you name the first lot "SysCom-1" and the second "SysCom-2."    After the 
second purchase, the Portfolio Value report shows a total SysCom value of $14,000.    The two lot groups 
use the same stock code, so the lots are grouped together on the report under SysCom.

Two months later the price is $7.    You decide to take a gain by selling the first lot.    The Realized Gain 
report shows a profit of $1,000.    The value of the SysCom portfolio is now reduced to $7,000.

To group lots:
1. From the Edit menu, choose Investments, then Securities.    The Edit Security box appears. 
2. Add a duplicate of the security:

· In the Name box, use a slightly different name
· In the Symbol box, type the exact symbol used with the original security

Each lot now appears as a separate item in the Security Browser box.    The values for lots with the same 
symbol are grouped on reports and graphs, however.

Related Topic:
Recording Securities



Calculating Security Performance

The performance of a security approximates the yearly total rate of return.    It is similar to the internal rate
of return (IRR), but is not the same calculation.

CA-Simply Money treats shares of stock as single items.    The following information is needed for each 
share of stock:

· how long it was held

· its buying and selling price    

CA-Simply Money assumes that the oldest shares (those owned the longest) are sold before newer 
shares, unless any information indicates otherwise.    For more information, see First-in First-out Costing 
Method.

Special situations apply to shares that produce income or you sell short.    For information, see Special 
Situations Affecting Performance Calculations.

These are the terms used in the performance formulas:

Cost Basis The total money spent on a stock.    It includes the price paid 
for the stock, commission, and any other expenses.

Buy Price The price of a share of stock when it is purchased.
Sell Price The price of a share of stock when it is sold.
Time Held The length of time a share of stock is owned, in years or 

fractions of years.
Profit The percent increase (or decrease) in the value of a share of 

stock.
Performanc
e

The yearly percent profit or loss per share.

Short sell The selling of shares a person does not own, but plans to buy 
later in hopes of a lower price.

For each share of a particular stock, CA-Simply Money calculates:

· Cost basis:
Cost Basis = Buy Price + commissions + expenses

· Absolute percentage of profit or loss:
Profit = (Sell Price - Cost Basis) / Cost Basis

· Yearly percentage of profit or loss (performance):
Performance = Profit / Time Held

CA-Simply Money calculates the performance of the entire security by averaging the performance of all 
the shares.    

Related Topics:
Special Situations Affecting Performance Calculations
Recording Securities



Special Situations Affecting Performance Calculations

· For shares you still hold, no sell price exists because the sale has not yet happened.    In the 
performance calculations, CA-Simply Money uses the last known price as the sell price.    The sell 
date is the last day of the time period shown in a report or graph.    The last day is controlled by the 
Ending date (System/Settings/Reports & Graphs, or on the graph or report window, Options/Filters 
and Styles).      
For shares you sold short and have not bought yet, the buy price for performance calculations is also
the last known price as of the ending date.

· Income such as interest or dividends is divided evenly among the shares owned when the income is 
received.    When one of these shares is sold, the sell price used in performance calculations is the 
actual sell price plus the income.
Example:    You buy 1000 shares of stock at $10 per share.    A dividend of $.05 per share is 
recorded two days later.    A month after the buy, you sell 500 shares at $10 per share.    $10.05 is the
selling price (the selling price plus the dividend amount), giving an annual performance of 61%, even
though the price never changed.

· For short sales, in which you "sell" shares you do not actually own, the procedure is similar to the 
one for long (normal) sales, though reversed.    The next buy determines how long the shares were 
held.
Note:    Do not record investment income on shares sold short.    You cannot get a dividend from 
shares you do not actually own.    If you record such a transaction the performance results may not 
be a true representation.

Related Topic:
Calculating Security Performance



Categorizing Your Finances

To track your finances properly, you need to allocate the funds you receive and spend to categories that 
reflect your lifestyle or business needs.    Typical categories are child care, dental, and groceries.    By 
recording transactions in various categories, you can get reports that show how much you earned from 
one area, and how much you spent in another.    These reports can help you define a budget and prepare 
for tax time.

CA-Simply Money provides default categories that are appropriate for personal and business finances.    
The categories (and subcategories) are assigned when you create a finance group (see Creating a New 
Finance Group), based on the type of finance group you choose to create:    Personal, Business, or Both.  
(For a list of categories and subcategories, see Default Categories Assigned to Finance Groups).    You 
can also create your own categories (see Adding a Category).

CA-Simply Money divides most of your financial information into four areas:    income, expense, asset, 
and liability.    Each area has categories.    For example, some typical income categories are 
Commissions, Interest, and Dividend.    Typical expense categories are Clothing, Medical, and Groceries.  
The asset and liability areas also have categories.

Note:    The Misc. Equity category is a special category for balance adjustments and starting balances.    It
is not an income, expense, asset, or liability category, and is used to add money to an account without 
recording it as income.

Each time you set up an income source or account, CA-Simply Money creates one or more categories or 
subcategories, based on the type of income or account you set up.    For example, when you create a 
paycheck income source, CA-Simply Money creates a Salary category and a subcategory with the name 
of the income source.    Also created is an Expenses category with the subcategories Federal Withholding,
FICA, State Disability, State Withholding, and Misc.    

You assign funds to categories when you record income and make payments.    You can allocate an 
amount to one category (see Distributing a Payment to 
One Category), or split it among several categories (called making a distribution; see Distributing an 
Amount to More Than One Category).    If you do not choose a category, CA-Simply Money automatically 
assigns the funds to the default Miscellaneous category.

Related Topics:
Default Categories Assigned to Finance Groups
Distributing a Payment to One Category
Distributing an Amount to More Than One Category
Editing Categories
Classifications
Tax Considerations for Categories



Editing Categories

CA-Simply Money makes it easy to change category names, delete categories you do not use, and add 
new categories that are unique to your finances.    You can also add descriptions to the categories, and 
flag certain categories for tax purposes.

Related Topics:
Adding a Category
Creating a Subcategory
Modifying a Category
Moving a Category
Merging Categories
Deleting a Category
Categorizing Your Finances



Adding a Category

You can create a custom category in two ways:

· With the Category Editor

· As you record transactions    

With the Category Editor:
1. From the Edit menu, choose Categories.    The Category Editor box appears.
2. In the Category Editor box, click on either Expense, Income, Asset, or Liability.    A list of categories 

for that financial area appears.
3. In the Create box, click on Top Level.    The Create Top Level Category box appears.    
4. Type a name, and an optional description if you wish.    If necessary, click the Tax Related box and 

choose a Tax Code.    
5. Click on OK to add the new category to the list and return to the Category Editor box.    CA-

Simply Money places the new category in its alphabetical position in the list.

As you record transactions:
1. Either:

· Click on a button for an income source or account.    If necessary, choose the type of transaction
you want to make.    

· Drag an account button to the Write or Register button.    The checkbook or register appears.
2. Fill in transaction information.
3. Type the category name in the category box of a check or dialog box, or on the category line of a 

register.    The Category browser appears.    
4. Click on the New button in the browser, then on OK.    The New Category box appears.
5. In the Name area of the New Category box, type the name of the new category.
6. In the Description area, type a short description of what the category is for.    This is optional, and will 

be printed on the voucher portion of checks.    See Setting Check Printing Options.
7. If you want this category to appear in your Tax Summary report, click the Tax Related box and 

choose a Tax Code from the list box.    Tax Codes are only relevant, and therefore only available in, 
Income and Expense categories.    Categories with tax codes appear on the Tax Schedule report and
in exported TXF files.

8. Click on OK.

Related Topics:
Tax Considerations for Categories
Editing Categories



Creating a Subcategory

You can add one or more subcategories to any category.    Subcategories allow you to group related 
categories on reports or graphs.

Example:    The Personal finance group has an expense category called Auto.    You may want to break 
down the auto category into gas and maintenance subcategories.

To create a subcategory:
1. From the Edit menu, choose Categories.    The Category Editor box appears.
2. In the Category Editor box, select the top level category for which you want to create a subcategory.
3. In the Create area, click on Subcategory.    The Create Subcategory box appears.    
4. Type the subcategory name and description.
5. Click on the Tax Related box if the subcategory will be used in assembling your tax information.
6. Choose OK to add the subcategory and return to the Category Editor box.    CA-Simply Money adds 

the subcategory under the top level category you had selected.

Related Topics:
Tax Considerations for Categories
Editing Categories



Modifying a Category

You can change the name, description, or tax status of a category at any time

1. From the Edit menu, choose Categories.    The Category Editor box appears.
2. In the Category Editor box, click on the category name you want to modify.    
3. Choose Modify.    The Modify Category box appears.    
4. Type the changes you want to make to the Name, Description, or Tax Related boxes.
5. Click OK to make the change and return to the Category Editor box.

Related Topics:
Tax Considerations for Categories
Editing Categories



Moving a Category

You can move a top level category to make it a subcategory of another top level category.    You can also 
promote a subcategory to top level category, or move it to another category.    All transactions are moved 
to the new category or subcategory.

Caution:    You can move categories across category types.    For example, a liability category could 
become an expense.    Make sure you understand the accounting ramifications before you move 
categories, however.

1. From the Edit menu, choose Categories.    The Category Editor box appears.
2. In the Category Editor box, click on the category name you want to move.    
3. Choose Move.    The Move Category box appears.    
4. In the Position box, choose Top Level if you are changing a subcategory to a top level category.    

Choose Subcategory if you are changing a top level category to a subcategory or a subcategory from
one top level category to another.

Note:    The Top Level box is disabled if the category you highlight is already a top level category.

5. In the Sub Category Of box, type a top level category.    You can use the Category Browser box to 
find a top level category.    

6. Choose OK to return to the Category Editor box, then Home to return to the main window.

Related Topic:
Editing Categories



Merging Categories

Merging categories increases the flexibility of CA-Simply Money by allowing you to dynamically rearrange 
your finances.    You might decide to merge categories to simplify your bookkeeping, or because the tax 
laws have changed.

For example, you use the Dining category only once or twice a year, so you merge it into the 
Entertainment category.    CA-Simply Money recategorizes your records so it seems you never had a 
Dining category, but always distributed such expenses to Entertainment.    The Dining category vanishes 
from your category browser.

You can merge any category or subcategory into any other category or subcategory

Caution:    You can merge categories across category types.    For example, a liability category could 
become an expense.    Make sure you understand the accounting ramifications before you merge 
categories, however.

To merge categories:
1. From the Edit menu, choose Categories.    The Category Editor box appears.
2. In the Category Editor box, click on the category name you want to merge.
3. Choose Merge.    The Merge Category box appears.    
4. In the Position box, select the category or subcategory to replace the category chosen in step 2.    
5. Choose OK to return to the Category Editor box, then Home to return to the main window.

Related Topic:
Editing Categories



Deleting a Category

If you delete a Top Level category, the transactions assigned to that category go into the Miscellaneous 
category.    When you delete a subcategory, the transactions associated with it are assigned to the next 
highest level of category or subcategory.    If you delete a category with subcategories, the subcategories 
are also deleted.

Certain categories such as Mortgage Principal are "linked" to accounts, so you cannot delete them.    The 
delete button is disabled for categories that cannot be deleted.

You never lose a transaction by deleting a category.    Transactions are permanently stored.    You can 
remove transactions only through the register for the account.

After you delete a category, you can no longer access it.    So, before deleting categories, you may want 
to:

· Run a Category Summary Report, which is a Financial Report (see Producing a Report).    This 
report displays transactions by category.    If the category you want to delete has amounts associated
with it, you may want to merge it with another category (see Merging Categories) instead of deleting 
it.    This enables you to avoid incomplete reports in the future.

· Look at the whole "tree" before deleting a category, because subcategories are deleted along with 
the category above them.    Select Categories from the Edit menu, and look at the category to be 
deleted.    Any subcategories are listed immediately below the category and indented slightly to the 
right.    Make sure that you are not deleting anything you may need in the future.

To delete a category:
1. From the Edit menu, choose Categories.    The Category Editor box appears.
2. In the Category Editor box, click on the category name you want to delete.
3. Choose Delete, then OK to confirm that you want to delete the category.

Related Topic:
Editing Categories



Classifications

Classifications are used to group related categories (distributions).    Some common uses for 
classifications are:

· Clients/Jobs:    If you want to track accounts receivable by client or job, create a classification for 
each client or job.

· Charity:    If you want to know how much you give specific charities each year, create a classification 
for each charity.

You can produce reports that identify amounts distributed to the classifications within a category.    These 
Classification Reports are in the Miscellaneous Reports grouping (see Producing a Report).

Related Topics:
Using Classifications in Distributions
Using the Rental Income Classification
Adding a New Classification
Changing a Classification Name
Deleting a Classification



Assigning Classifications

You assign classifications as you record transactions.

1. Either:
· Click on a button for an income source or account.    If necessary, choose the type of transaction

you want to make.    
· Drag an account button to the Write or Register button.    The checkbook or register appears.

2. Fill in transaction information.
3. Click on the arrowhead (or Distribution button).    In a dialog box or in the Checkbook, the arrow is in 

the Category box.    In the Register it is on the category line (the third line in standard display format, 
see Setting Register Sort and Display Options).    The Distribution Register appears.

4. In the Distribution Register, enter one or more categories and the amounts you want to assign to 
them.

5. Begin typing your classification on the first line of the Class/Note column.    The Classification 
Browser appears.

6. To use an existing classification, highlight it in the browser list and click OK.    
To add a new classification, type its name in the Class/Note column and click New in the 
Classification Browser.

7. Click Close to return to the dialog box, Checkbook, or register.

Related Topics:
Distributing an Amount to More Than One Category
Classifications



Using the Rental Income Classification

If you want to track rent payments by tenant, create a classification for each tenant.    Distribute the 
income to the rental income category and the tenant classification.    If you want to track rental income by 
property, create a classification for each piece of property.

Example:    You have a Rent income source.    Create a Rental Income category with a Rent 
subcategory.    Create classifications for each tenant (such as Jim Smith and Jane Jones).    When Jim 
sends in his rent check, assign it to the Rental Income category and the Jim Smith classification.

Related Topic:
Classifications



Adding a New Classification

You can create a custom classification in two ways:

· As you record transactions    
· With the Classification Editor

As you record transactions:
1. Either:

· Click on a button for an income source or account.    If necessary, choose the type of transaction
you want to make.    

· Drag an account button to the Write or Register button.    The checkbook or register appears.
2. Fill in transaction information.
3. Click on the arrowhead (or Distribution button).    In a dialog box or in the Checkbook, the arrow is in 

the Category box.    In the Register it is on the category line (the third line in standard display format, 
see Setting Register Sort and Display Options).    The Distribution Register appears.

4. In the Distribution Register, enter one or more categories and the amounts you want to assign to 
them.

5. Begin typing your classification on the first line of the Class/Note column.    The Classification 
Browser appears.

6. Finish typing the name of the new classification in the Class/Note column, and click New in the 
Classification Browser.

7. If necessary, enter more classifications in the Class/Note column.
8. Click Close to return to the dialog box, Checkbook, or register.

With the Classification Editor:
1. From the Edit menu, choose Classifications.    The Classification Editor box appears.    
2. In the text entry box, type the name of the classification you want to add.
3. Choose New.    The new name appears in the list box.
4. Choose Home to return to the main window.    Now you can apply the classification to your 

categories.

Related Topic:
Classifications



Changing a Classification Name

To change a classification name:

1. From the Edit menu, choose Classifications.    The Classification Editor box appears.    
2. From the list of classifications in the Classification Editor box, choose the classification name you 

want to change.
3. In the text entry box, type the new classification name.
4. Choose Change Name.    The highlighted name changes to the one you typed.
5. Choose Home to return to the main window. 

Related Topic:
Classifications



Deleting a Classification

To delete a classification:

1. From the Edit menu, choose Classifications.    The Classification Editor box appears.    
2. From the list of classifications in the Classification Editor box, choose the classification name you 

want to delete.
3. Choose Delete, then Yes to confirm deleting the classification.
4. Choose Home to return to the main window.

Related Topic:
Classifications



Tax Considerations for Categories

Categories can help you organize your tax information.    CA-Simply Money allows you to flag categories 
for taxes when you either create or modify Categories.    (See Adding a Category, Creating a 
Subcategory, or Modifying a Category.)

To make a category tax-related, check the Tax-related box.    You can also choose the Tax Code from a list
box organized by tax form and code.    Be sure to set up separate categories for items that are tax-related.

To make an account tax-free, make all the categories associated with it tax-free.    When you set up the 
account, CA-Simply Money sets up categories and/or subcategories with the account name.    Find each 
expense and income category with the account name, and make sure the Tax-related box is checked.    
See Modifying a Category.

Example:    Some donations are tax-deductible and others are not.    For tax-deductible donations, create 
a category (or use the Charity category that CA-Simply Money provides) and make sure the Tax-related 
box is checked.    For donations that are not tax-deductible, create a separate category (such as 
Donations - Not Deductible) with the Tax-related box blank.    Record donations against the proper 
category.    The Tax Summary report will list the transactions assigned to Charity but not the transactions 
assigned to Donations - Not Deductible.    (The Tax Summary report is a Financial Report; see Producing 
a Report.)

Related Topics:
Editing Categories
Exporting to Tax Programs



Grouping Buttons

The Group feature of CA-Simply Money is a powerful way to view your finances and automate tasks.    
You can group any number of income sources, accounts, or payees.

For example, you may want to view your total grocery bill for the month, but you shop at three different 
stores and have a separate payee button for each.    You can group the three grocery store buttons and 
drag the group button to the Reports button to create a monthly category summary report.    The report 
displays data only for the grouped buttons.

With just a single click on a grouped button you can display summary information about all buttons in a 
group.    You can also record transactions to groups of payees.    For example, to pay bills that are due at 
the same time each month, drag the group to your checking account button.    CA-Simply Money presents 
a check for each of the grouped payees, one after another.

You can make two types of groups:    permanent and temporary.    Temporary groups are ones you create 
on the fly.    They are easy to make and easy to undo.    You can create temporary groups as often as 
necessary, and keep them as long as you need them.

Permanent groups are represented by a button.    Make permanent groups when you use a certain 
combination of buttons on a regular basis.

Although groups are most useful for payees, you can use groups for income sources and accounts in 
order to generate reports and graphs.    You can use one button in more than one group.    The only 
limitation is you cannot combine different types of buttons; groups must be either payees, accounts, or 
income sources, not a mixture.    You can create a maximum of 32 groups, temporary or permanent.

Note:    Group actions do not apply to the Write Checks, Register, Balance, and Advise functions.

Related Topics:
Creating a Temporary Group
Creating a Permanent Group
Using Find with a Group
Modifying a Group
Merging Payees into One Button



Creating a Temporary Group

To create a temporary group:

1. Hold down the Shift key and click on the buttons you want to add to the group.    A red line appears 
around each button.    (To deselect a button, Shift and click again.)

When you drag any one of the grouped buttons, you drag them all.    The icon changes to a paper clip.    
The result of dragging and dropping affects all buttons in the group.

To undo a temporary group:

1. Click anywhere on the background.

Related Topic:
Grouping Buttons



Creating a Permanent Group

To create a permanent group:

1. Either:
· Make a temporary group by holding down the Shift key and clicking on the buttons you want to 

add to the group.    A red line appears around each button.    (To deselect a button, Shift and click
again.)    Next, drag any button in the group to the Setup button.

· From the Operations menu, choose Make Group.    The Make Groups box appears.    Choose 
the type of group you want to make.    

The Group-Add box appears.    The buttons of any temporary group are already 
highlighted in the Group Members list, which shows every income source, account, or 
payee.

2. Click on the name of buttons you want to include (if they are not highlighted) or exclude (if they are 
highlighted) from the group.

3. In the Group Name box, type a name for the group button.
4. Click OK.    A button appears for the group.

Note:    If you create a permanent group you may find you do not need the individual buttons displayed.    
Use the Hidden Button feature to "hide" them 
(see Hiding a Button).

Related Topic:
Grouping Buttons



Using Find with a Group

Suppose you create a group of the three grocery stores you frequent.    If you drag the Find button and 
drop it on one of the grouped buttons, CA-Simply Money finds all of the transactions for the grouped 
buttons.

Related Topic:
Grouping Buttons



Modifying a Group

To modify a group:

1. Either:
· Drag the button for the group to the Setup button.    Click on Modify this Button.
· From the Operations menu, choose Modify Group.    Choose the type of group you want to 

modify, then highlight the group you want to modify and click OK. 
The Modify Group box appears.    

2. If you want to add buttons to the group or remove buttons, click on the names for those buttons.
3. If you want to change the name of the group, type a new name in the Group Name box.    You can 

also choose to hide the button.
4. Click OK.    

Related Topic:
Grouping Buttons



Merging Payees into One Button

Importing files from Quicken often produces several buttons for one payee.    You can merge a group of 
payee buttons into one button.    The new button replaces all the payee buttons in the group, both 
onscreen and in your records.

For instance, if you combine buttons for "Moe's supermarket," "Moes Supermarket," and "Moz 
Supermarket" into one button named "Moe's," CA-Simply Money merges all transactions associated with 
any of the spellings into the new Moe's button.    Future transactions affect only the new Moe's payee.    

To merge a group of payees:
1. Make a temporary group by holding down the Shift key and clicking on the buttons you want to 

merge.    A red line appears around each button.    (To deselect a button, Shift and click again.)    
2. Drag any button in the temporary group to the Payee button.    The Merge Payees box appears.    
3. Type a name for the new button.    You can choose an existing name from the Payee browser or use 

a new name.
4. Click OK to merge the whole temporary group into the new button.

Related Topic:
Grouping Buttons



Budgeting

Budgeting is a critical component of any financial plan.    You set financial goals for yourself or your 
business, and you use a budget to attain your goals.    Budgets, and your success at sticking to them, 
define your financial progress in clear terms:    Were you over budget or under budget?    With which 
categories do you have trouble?    Does your income meet your expectations?    Where can you trim your 
budget to advance your rate of savings?    With CA-Simply Money, you can create a budget, use reports 
to assess the rate at which you are over or under spending, and adjust either your budget or your 
spending, or both.

The CA-Simply Money budget feature allows you to create a fixed budget by listing expenses for just one 
month and projecting them for twelve-months.    Or, you can create a variable budget by listing expenses 
for each month or season separately.    Expenses can be entered for subcategories (like Electricity and 
Gas) and then be listed by top-level categories (like Utilities).    Your budget can also include expected 
income.    The AutoBudget feature can extrapolate from your past income and expenses to an entire 
year's budget, even including seasonal variations in some expenses.

The CA-Simply Money budget tool works like an electronic spreadsheet.    Once you have entered values 
into your budget, CA-Simply Money calculates monthly and annual totals for the various categories.    
Whenever you change a value, CA-Simply Money recalculates the totals.    If a monthly expense changes,
the new expense can be projected for the rest of the year at the new level, leaving the old amounts 
unaffected.

You can evaluate a budget by generating special reports and graphs.    The reports display the difference 
between the actual and budgeted amounts.    (Budget reports are Miscellaneous Reports; see Producing 
a Report.).

Related Topics:
Making a Monthly Budget
Making a Yearly Budget
Adding Income to a Budget
Using AutoBudget to Create a Budget
Budget Display Options



Making a Monthly Budget

This procedure explains how to add expenses to a monthly budget.    To add income, see Adding Income 
to a Budget.

1. From the Edit menu, choose Budget.    The Monthly Budget box appears, showing a column for a 
fixed budget. 
The left column, Expense, lists categories.    The right column, Amount, contains empty 
cells.    At the bottom of the budget sheet, the Totals row gives the monthly expense 
total.    The Total Income row has a single cell that shows total monthly income.    

2. In the Amount column, type expense amounts for the expenses you have incurred or know you will 
incur in the current month, and those you expect to incur, if you want to include upcoming costs in 
your estimate.    You can change any value later.

3. Click OK when you have finished making entries in your budget.    This saves the budget and returns 
you to the main window.

Related Topic:
Budgeting



Making a Yearly Budget

A yearly budget can be either fixed or variable.    A fixed budget is a monthly budget projected for twelve 
months.    A variable budget has different expenses for each month.    Procedures for making both types of
budgets are explained below.

These procedures explain how to add expenses to a budget.    To add income, see Adding Income to a 
Budget.

To make a fixed budget:
1. From the Edit menu, choose Budget.    The Monthly Budget box appears, showing a column for a 

fixed budget. 
2. Type the appropriate expense amount for each category.
3. If you wish, click on Options to limit the budget to only main categories, or to sort the budget by 

amount rather than category.    For more information, see Budget Display Options.

To make a variable budget:
1. From the Edit menu, choose Budget.    The Monthly Budget box appears.    
2. Click on Variable.    The box expands to include columns for several months and a Totals column. 

Note:  The number of columns displayed depends on the resolution of your monitor.

The Totals column shows expense and income totals for twelve months, beginning with 
the current month.    Variable budgets, unlike Fixed budgets, reflect monthly or seasonal 
changes in your expenses and income, so the months you can see may not have the 
same subtotals as the others.    You can see the other months by using the horizontal 
scroll bar.

3. Type the appropriate expense amount for each category in each month.    

If an expense is the same amount each month for some or all of the year:
· Type the amount in the first month it occurs.
· Click on Fill To Right.    The amount is copied to all columns to the right.
Note:    You can use the Fill To Right command from any cell in the row.    All rows to the right of the 
cell where you choose Fill To Right will contain the amount of that cell.

Example:    Your cable TV bill is the same every month.    You have created a subcategory under 
Entertainment called Cable.    In the first cell in the Cable row, you type the monthly amount.    You 
then click on Fill To Right and the amount is entered for the rest of the year.    After three months, 
however, your cable bill goes up.    In the cell for that month, you type in the new amount, and click 
on Fill To Right.    The following months show the new amount, and the preceding months show the 
old amount.

4. If you wish, click on Options to limit the budget to only main categories, or to sort the budget by 
amount rather than category.    For more information, see Budget Display Options.

5. To return to the single-month budget, click on Fixed.

Related Topics:
Budgeting
Using AutoBudget to Create a Budget



Adding Income to a Budget

The following procedures explain how to add income to both a fixed budget and a variable budget.

To add income to a fixed budget:
1. From the Edit menu, choose Budget.    The Monthly Budget box appears, showing a column for a 

fixed budget. 
2. In the Monthly Budget box, click on the Income button.    The income categories appear in green in 

the Income column.
3. Type values for your income.    CA-Simply Money totals your entries in the Totals row.
4. If you wish, click on Options to limit the budget to only main categories, or to sort the budget by 

amount rather than category.    For more information, see Budget Display Options.
5. When you have finished entering income amounts, choose Expense, then OK to save your income 

entries.

The Expense budget appears.    The total income appears in the Income row.

To add income to a variable budget:
1. From the Edit menu, choose Budget.    The Monthly Budget box appears.    
2. In the Monthly Budget box, click on the Income button.    The income categories appear in green in 

the Income column.
3. Click on Variable.    The box expands to include columns for several months and a Totals column. 

Note:  The number of columns displayed depends on the resolution of your monitor.

The Totals column shows expense and income totals for twelve months, beginning with 
the current month.    Variable budgets, unlike Fixed budgets, reflect monthly or seasonal 
changes in your expenses and income, so the months you can see may not have the 
same subtotals as the others.    You can see the other months by using the horizontal 
scroll bar.

4. Type the appropriate income amount for each category in each month.    

If income is the same amount each month for some or all of the year:
· Type the amount in the first month it occurs.
· Click on Fill To Right.    The amount is copied to the columns to the right.

Note:    You can use the Fill To Right command from any cell in the row.    All rows to the right of the 
cell where you choose Fill To Right will contain the amount of that cell.

5. If you wish, click on Options to limit the budget to only main categories, or to sort the budget by 
amount rather than category.    For more information, see Budget Display Options.

6. When you have finished entering income amounts, choose Expense, then OK to save your income 
entries.

Related Topics:
Budgeting
Making a Monthly Budget
Making a Yearly Budget



Using AutoBudget to Create a Budget

If you have at least one month's worth of transactions, you can have CA-Simply Money automatically 
create either a fixed or variable budget based on your current financial patterns. 

1. From the Edit menu, choose Budget.    The Monthly Budget box appears.    
2. In the Monthly Budget box, click on AutoBudget.    The Automatic Budgeting box appears.
3. In the Source Date Range area, type the beginning and ending dates of the transactions you want 

CA-Simply Money to use in calculating the budget.

Note:    If you later generate budget graphs or reports, use the same date range to generate them that 
you used for the Automatic Budgeting.    You may get unexpected results if the date ranges do not match.

4. In the Auto Create Budget For area, choose All Expense Categories.
5. In the Budget Type area, choose Fixed or Variable.

A Fixed budget averages your expenses, assuming they will be the same each month. A 
Variable budget judges your expenses separately for each month, to allow for seasonal 
variations.

6. Click on OK to generate your new budget and return to the monthly budget box.

Related Topic:
Budgeting



Budget Display Options

You can display your budget information in three ways:

· All categories, sorted by category name 
· Top-level categories, sorted by value (expense amount)
· Top-level categories, sorted by name

Sorting by value has the advantage of showing just the categories with expenses, and not categories you 
have not used.    You probably want to see all categories and subcategories when you are entering 
expenses, but not when you are viewing your expenses.

Related Topics:
Displaying All Categories
Displaying Only Active Categories
Displaying Only Top-Level Categories
Budgeting



Displaying All Categories

To display all categories:

1. From the Edit menu, choose Budget.    The Monthly Budget box appears. 
2. In the Monthly Budget box, choose Options.    The Budget Options box appears.
3. In the Display area, choose All Categories to display categories and subcategories in the Expenses 

column so you can enter detailed expenses.
When you choose All Categories, the Sort By box is limited to sorting by category name.

4. Choose OK to return to the Budget box.



Displaying Only Active Categories

To display only active categories:

1. From the Edit menu, choose Budget.    The Monthly Budget box appears. 
2. In the Monthly Budget box, choose Options.    The Budget Options box appears.
3. In the Display box, choose Top Level Only.
4. In the Sort By box, choose Value.

Sorting by value places the expense categories you have already used at the top of the 
category list, beginning with the highest amount.    The categories you have not used are
at the end of the list.

5. Choose OK to return to the Budget box.



Displaying Only Top-Level Categories

When you display only top level categories in a budget, values for subcategories are included in the total 
for each top level category.    The top level categories are sorted by name.

1. From the Edit menu, choose Budget.    The Monthly Budget box appears. 
2. In the Monthly Budget box, choose Options.    The Budget Options box appears.
3. In the Display box, choose Top Level Only.
4. In the Sort By box, choose Name.
5. Choose OK to return to the Budget box.



Business Applications

CA-Simply Money offers a number of special accounts that help you track your business finances:    
payroll, payables and receivables, petty cash, and more.    You can export this information to full-fledged 
accounting software when necessary (see Exporting/Importing Data and Excel Applications).

Related Topics:
Accrual vs. Cash Basis Accounting
Setting up Payables
Setting Up Receivables
Business Reports
Payroll Accounting
Petty Cash



Accrual vs. Cash Basis Accounting

There are two ways to set up business accounting:    under a cash basis or an accrual basis.    
CA-Simply Money provides tools for both.    Your financial professional can advise you as to 
which method is best for your business.

Cash Basis Accounting
Certain service businesses (like law, architecture, or hairdressing) often use a cash basis mode of 
accounting.    Cash basis accounting is used primarily because it can provide certain income tax benefits 
and because it is simple.    

Accrual Basis Accounting
Because cash basis accounting can sometimes negatively affect the financial position and operating 
results of a business, many firms use the accrual basis of accounting. Under the accrual basis of 
accounting, revenue is recognized when it is realized and expenses are recognized when incurred, 
without regard to the time of receipt or payment.    Under the cash basis of accounting, revenue is 
recognized only when cash is received; expenses are recorded when they are paid in cash.

Related Topics:
Setting up Cash Basis Payables
Setting up Cash Basis Receivables
Setting up Accrual Basis Payables
Setting up Accrual Basis Receivables



Setting up Payables

Payables are expenses that have been or must be paid by your business.    The procedures for handling 
cash and accrual basis payables in CA-Simply Money are very different.    Click on the topics below for 
more information.

Related Topics:
Setting up Cash Basis Payables
Setting up Accrual Basis Payables
Applying Credits and Discounts to Payables



Setting up Cash Basis Payables

Cash basis payables are the most common type for small businesses.    You record your bills as you 
receive them, but you don't "recognize" them until you pay them.    

To track cash basis payables, set up a business checking account.    By writing checks and suspending 
printing, you can control recognition of bills.    

Related Topics:
Adding Cash Basis Payables
Tracking Cash Basis Payables
Making Cash Basis Payments



Adding Cash Basis Payables

To add cash basis payables:

1. When you receive a bill or invoice, write a check for it from your business checking account.    See 
Paying a New Payee.

2. Use the due date of the bill for the check date.    The pop-up calendar can help you set your dates.    
See The Calendar.

3. Click on the Print box to remove the "X".    You will probably not want to print the check until you are 
ready to pay it.    Unprinted checks are not subtracted from your checking account or detected by the 
Advisor.
You can also specify the range of dates for which you want to print checks in the Print 
Checks box when you print your checks.

4. Click on Record to complete the transaction.
5. Continue to repeat this procedure for all of your bills and invoices.

Related Topics:
Tracking Cash Basis Payables
Making Cash Basis Payments



Tracking Cash Basis Payables

To track cash basis payables you can view reports as well as scroll through your business checkbook or 
checking register.

1. Click once on the Reports button to get the list of reports.
2. Select Financial Reports.
3. Select the Accounts Payable Report and click OK.
4. Select the checking account you are using to add payables.

The report that appears lists all payees and amounts due (all unprinted checks for each payee).    This 
helps you keep track of what bills need to be paid.    See also Business Reports.



Making Cash Basis Payments

To make cash basis payments:

1. Print the Accounts Payable report and determine which payments need to be made.    See Tracking 
Cash Basis Payables.

2. Go to your business checkbook and scroll through the checks, clicking on the Print box of each 
check you want to pay.    The "Ending Balance" tells you how much will be left in the account after 
payments.

3. When the payments are set up for printing, click the Print button.    See also Printing Checks.



Setting up Accrual Basis Payables

To keep track of your payables on an accrual basis, you need both a checking account and a separate 
payables account.    A payables account is just a Liability account used for a special purpose. 

1. Drag the Accounts button to the Setup button.    
2. Give the account a name such as "Payables" or "AP," choose the Liability account type, choose a 

button icon, and click OK.
3. Use zero as the account's opening balance.    For more about liability accounts, see Setting Up an 

Asset or Liability Account.

You will add bills and invoices to this account as you receive them.    When you write a check to make the 
actual payment, the amount is deducted from both the Payables and checking accounts.    The 
appropriate expense category is also increased. 

Related Topics:
Adding Accrual Basis Payables
Tracking Accrual Basis Payables
Making Accrual Basis Payments



Adding Accrual Basis Payables

Adding a payable to your Payables account is similar to writing a check for the payee.    The only 
difference is that a "check" does not appear.

To add accrual basis payables:

1. When you receive a bill from a vendor, drag that vendor's payee button to your Payables button.    
The Liabilities Increases box appears containing information from the last transaction you entered for
that vendor.

2. In the Date box, type the due date of the invoice.    The pop-up calendar can help you set your dates. 
See The Calendar.

3. In the Amount box, type the amount of the invoice.

Note:    You don't need to make a selection in the Via box.

4. In the Category box, select the expense category to which the bill applies.    The category may 
already be displayed if you have made a payment to the vendor before.
You can also use classifications to record project or client numbers.    See Classifications.

5. You can use the ID box to record the reference number of the bill, if it has one.    You can also type 
an optional memo in the Memo box.

6. Click on Record to complete the transaction.
7. Repeat the procedure from this dialog box by typing a new name in the Payee box.    

Use this procedure for all business bills and invoices.    Every transaction you add to the Payables 
account increases your liabilities and adds to your expense categories.

Related Topics:
Tracking Accrual Basis Payables
Making Accrual Basis Payments



Tracking Accrual Basis Payables

To track payables you can scroll through your Payables account register, or you can create a customized 
report to help you keep track of what bills need to be paid.

To create a report on your payables:

1. Drag your Payables button to the Reports button.    A list of payables due on and before today's date 
appears.

2. From the Options menu, select Filters and Styles.    Then, click on Settings.    The Report Options box
appears.    

3. In the Cleared Status box, select Blank and deselect Cleared and Newly-Cleared.
4. Click OK to get the transaction report.

The filter you selected causes the report to show only pending bills.    You may want to pull down the 
report's File menu and select Memorize to use this filter again.    Give the report a name such as "Accrual 
Basis Payables."



Making Accrual Basis Payments

When making accrual basis payments, you determine which checks to write and then either use the 
checkbook or write checks by hand.

1. Print your filtered Account Transactions report ("Accrual Basis Payables") and determine which bills 
need to be made.    See Tracking Accrual Basis Payables.

2. Drag your checking account button to the payee button you want to pay.    The checkbook appears, 
displaying information that was used in the previous check to that payee.

3. Make any necessary changes to the information.    Use the Memo and Classification boxes to help 
track your payments.

Note:    You can choose to pay all or part of one or more bills with a single check.    Keep track of which 
bills are paid with the ID numbers you used in the Liabilities box.

4. In the Category box, type "Payables."    As you begin to type, the Category Browser appears.    Click 
the Liability button and accept Payables from the list of liability categories.    
This bill was already recorded as an expense when you added the transaction to your 
Payables account.    Now you are simply connecting the check payment to your Payables 
account.

5. If you want to print the check immediately, select Print.    Check printing procedures are the same as 
with any other check.

6. Click on Record to complete the transaction.    Your Payables account will be decreased by the 
amount of the check on the date of the check.

Now you need to indicate in the Payables register that the payment has been made.    Do this by 
"clearing" the transaction:

1. Double-click on your Payables button to display the register.
2. If the bill has been paid in full, click the box in the C column.    A check mark appears, which indicates

the invoice has been paid.    This keeps the transaction from appearing on your filtered Account 
Transactions report ("Accrual Basis Payables").

3. Click on Record to save the transaction.
4. Continue to record other payments, or click on Home to return to the main window.



Applying Credits and Discounts to Payables

Occasionally you will receive credit from a vendor if there has been a billing error or you have returned a 
product.    Some vendors also offer discounts if payments are made within a certain discount period.    
These types of transactions can easily be handled in CA-Simply Money.

There are two ways to handle credits and discounts:

· You can modify the original transaction by adding the credit or discount as a split distribution.    This 
keeps the entire transaction together and is much faster to complete.    

· You can add the credit or discount as a new, separate transaction.    This means you don't have to 
search for the original transaction. 

Related Topics:
As a Split Distribution
As a Special Transaction



Vendor Credits/Discounts: As a Split Distribution

To handle credits or discounts you receive from vendors as a split distribution:

1. Double-click on your Payables account button.    The Payables Register appears.
2. Select the original transaction to which you want to add the credit or discount.    See The Find 

Feature.
3. Click on the Category box.    In the Distribution Register, add an additional line for the credit or 

discount.    Type a negative amount for the value.    Use the same category that you used for the 
original transaction.

4. Click on Recalc Total, then click on Record.



Vendor Credits/Discounts: As a Special Transaction

To handle credits and discounts you receive from vendors as a separate transaction:

1. Click on your Payables account button.
2. From the Payables box, choose Record Decreases.
3. Enter the complete transaction information for the discount or credit.

Type a positive number for the amount.    The amount will be subtracted from the 
Payables balance and reduce liabilities.
Make sure you use the category that was used on the original invoice so that the credit 
or discount is applied properly.

4. Click on Record.



Setting Up Receivables

Receivables are income received by your business.    You can set up a Receivables account in CA-
Simply Money on either a cash or accrual basis:

· The cash-basis system described in this Help assumes you recognize income when you receive 
payment.

· The accrual basis system described here assumes you recognize income when you bill for your 
services.

The procedure for setting up a receivables account is the same for both accounting methods.    A 
receivables account is just an Asset account used for a special purpose. 

The procedures for recording transactions, however, are very different.    Click on the topics below for 
more information:    

Related Topics:
Setting up Cash Basis Receivables
Setting up Accrual Basis Receivables
Applying Credits and Discounts to Receivables



Setting up Cash Basis Receivables

Using a cash-basis system, you recognize income when you receive payment. To set up cash basis 
receivables, create an Asset account:

1. Drag the Account button to the Setup button.
2. Click Add an Account.
3. Give the account an appropriate name (like "Receivables" or "AR"), choose the Asset Account Type, 

and click OK.
4. Use zero as the opening balance.    For more on Asset accounts, see Setting Up an Asset or Liability 

Account.    

Related Topics:
Adding Cash Basis Receivables
Tracking Cash Basis Receivables
Recording Cash Basis Payments



Adding Cash Basis Receivables

To add cash basis receivables:

1. First, make sure you have set up an Asset account named "Receivables" and have gathered your 
invoices.    

2. Click on your Receivables account button.
3. From the Account Activity box, choose Record Increases.    The Asset Increases box appears.    
4. In the Date box, type the expected date of payment.    The pop-up Calendar can help you.
5. In the From box, type the customer name.
6. In the Amount box, type the amount of the invoice.
7. In the Category box, make any necessary changes.

Note:    If you want to attribute items in your invoice to various subcategories, use the Split Distributions 
list.    For example, if you itemize shipping costs, you might use a separate line item with a subcategory of 
"Shipping."

8. In the Memo box, type the date you issued the invoice.
9. In the ID box, type the invoice number.    You could also use the Memo box if the invoice number is 

longer than 5 characters.
If an invoice will be paid in installments, record each of the payments as a separate 
transaction.    You can use the ID to identify the installments.    For example, invoice 
#574 might become 5741 and 5742.

10. Click on Record to record the transaction.
Every transaction you add to the Receivables account increases your assets.

11. Continue to repeat this procedure for all of your bills and invoices.

Note:    You do not have to use the Via box.

Related Topics:
Tracking Cash Basis Receivables
Recording Cash Basis Payments



Tracking Cash Basis Receivables

To track your receivables due:

1. Click on the Reports button.
2. From the Reports List, select the Accounts Receivable report for your receivables account.

A list of receivables due on and before today's date appears.    The list is organized by income source
and excludes receivables which have been paid (as indicated by being cleared in the register).

Related Topics:
Adding Cash Basis Receivables
Recording Cash Basis Payments



Recording Cash Basis Payments

As you receive payments for invoices, you will modify the existing transactions in the receivables register. 
This modification decreases the value of your receivables account and increases the value of the account
in which you deposit the payment. 

When you receive payments, use the Distributions Register to update the existing cash basis 
transactions.    To record a cash basis payment:

1. Double-click on your Receivables account button to display the register.
2. Scroll through the list to find the original transaction for the payment you received.

Tip: The Find tool can help you quickly locate a particular transaction.      Also, changing the register 
display can make it easier to find transactions.    From the Register, click on Display and select the 
Mid or List display format.

3. In the Date column, change the date to the date you received the payment.    The existing date is the 
initial due date that you entered for the payment.

4. In the Category box, click on the arrow.    The Distribution Register appears displaying the sales 
category and any subcategories to which you applied the invoice.

5. In the Category column of the first blank line, type the name of the account to which you want to 
transfer the payment, like "Checking" or "Savings."

6. In the Amount column, type the amount of the payment as a negative number.
7. Click on Recalc Total to add the new amount to the old amount.    The total displayed in the top right 

of the register becomes "0.00."
8. Click on OK to return to the Receivables Register.

The Increase and Decrease columns for the transaction should be blank and display 
"0.00" for the Balance.    If the balance is not zero, the customer may owe you money, 
you may owe the customer money, or you may have made an error in the Distribution 
register.

9. If the invoice has been paid in full, "clear" the transaction by clicking the box in the C column.    A 
check mark indicates the invoice has been paid.    This keeps the transaction from appearing on the 
report of current receivables due.

10. Click on Record to save the transaction.
11. You can continue to record other payments, or click on Exit to return to the main window.

Note:    In the register of the account to which you distributed the payment, the transfer transaction is 
displayed against a yellow background.    You can only make modifications to this transaction through your
Receivables account register.

Related Topics:
Adding Cash Basis Receivables
Tracking Cash Basis Receivables



Setting up Accrual Basis Receivables

Using an accrual basis system, you recognize income when you bill for your services.    To set up accrual 
basis receivables, create an Asset account:

1. Drag the Account button to the Setup button.
2. Click Add an Account.
3. Give the account an appropriate name, like "Receivables" or "AR," choose the Asset Account Type, 

and click OK.
4. Use zero as the opening balance.    For more on Asset accounts, see Setting Up an Asset or Liability 

Account.    

Related Topics:
Adding Accrual Basis Receivables
Tracking Accrual Basis Receivables
Recording Accrual Basis Payments



Adding Accrual Basis Receivables

To add accrual basis receivables:

1. First make sure you have created an Asset account named "Receivables" and have gathered your 
invoices.

2. Click on your Receivables account button.
3. From the Account Activity box, choose Record Increases.    The Asset Increases box appears.    
4. In the Date box, type the date of the invoice.
5. In the From box, type the customer name.
6. In the Amount box, type the amount of the invoice.
7. In the Category box, make any necessary changes.

Note:    If you want to attribute items in your invoice to various subcategories, click on the arrow in the 
Category box to display the Distribution list.    For example, if you itemize shipping costs, you might use a 
separate line item with a subcategory of "Shipping."

Note:    If you use the Balance Forward method for your receivables, you should attach the customer 
name to the transaction.    Display the category Distribution list.    In the Class/Note box, type the customer
name or other classification label.

8. In the ID box, type the invoice number.    You could also use the Memo box if the invoice number is 
longer than 5 characters.
If an invoice will be paid in installments, record each of the payments as a separate 
transaction.    You can use the ID to identify the installments.    For example, invoice 
#574 might become 5741 and 5742.

9. Click on Record to record the transaction.
Every transaction you add to the Receivables account increases your assets.

10. Continue to repeat this procedure for all of your invoices.

Note:    You do not have to use the Via box.

Related Topics:
Tracking Accrual Basis Receivables
Recording Accrual Basis Payments



Tracking Accrual Basis Receivables

To track your receivables due:

1. Click once on the Reports button.
2. From the Reports list, select the Accounts Receivable report. 

A list of receivables due on and before today's date appears.    The list is organized by income source
and excludes receivables which have been paid (as indicated by being cleared in the register). 

Related Topics:
Adding Accrual Basis Receivables
Recording Accrual Basis Payments



Recording Accrual Basis Payments

There is more than one method to use for recording the receipt of accrued receivables.    Your accountant 
can advise you on the best method for your business.    You will probably use one method consistently.    

Tracking Separate Invoices
The most common method of recording accrued payments is to keep track of them as separate invoiced 
transactions. 

There are two parts to this procedure:

1. Record a transaction for the payment.
2. Then clear the original billing transaction.

Tracking the Customer
Another common method is to keep track of the running balance of a customer's account.    Sometimes 
called the "Balance Forward" method, this is useful if you receive payments that cover several invoices.    
See Tracking the Customer: Recording Payments for Multiple Invoices.



Tracking Invoices: Recording Payment

To record a payment of an accrued receivable as a separate transaction:
1. Double-click on your Receivables button to display the register. 
2. Change the date to the date you received the payment.
3. Type the customer name and the amount of the payment.
4. In the Category line, specify the account to which you want to deposit the funds (usually the checking

account).    You can use Memo line for the check number.
5. Click on the C box to indicate the payment was received.
6. Clear the original billing transaction.



Tracking Invoices: Clearing the Original Transaction

To clear the original billing transaction for an accrued receivable:
1. Scroll through the register to find the original transaction for the payment you received. 

Tip: The Find tool can help you quickly locate a particular transaction.    Also, changing the register 
display can make it easier to find transactions.    From the Register, click on Display and select the 
Mid or List display format.

2. Click on the C box to indicate the payment was received.
3. Click on Record to save the transaction.
4. You can continue to record other payments, or click on Exit to return to the main window.



Tracking the Customer: Recording Payments for Multiple Invoices

To track payments based on the customer rather than individual invoices, you need to set up a 
classification for each customer.    You can use any kind of identifying label you wish.    Type the 
appropriate class name in the distribution list when you add an invoice, as described in Adding Accrual 
Basis Receivables.

To record a payment for multiple invoices:

1. Double-click on your Receivables button to display the register. 
2. Change the date to the date you received the payment.
3. Type the customer name and the full amount you received in the Amount box..
4. In the Category line, specify the account to which you want to deposit the funds (usually the checking

account).    You can use Memo line for the check number.
5. Clear each of the original billing transactions.



Applying Credits and Discounts to Receivables

The procedures for applying credits and discounts to your customers are essentially the same as 
recording credits and discounts you receive from your vendors (see Applying Credits and Discounts to 
Payables).    The only difference is that you enter the credits in the receivables register.

There are two ways to handle credits and discounts:

· You can modify the original transaction by adding the credit or discount as a split distribution.    This 
keeps the entire transaction together and is much faster to complete.    

· You can add the credit or discount as a new, separate transaction.    This means you don't have to 
search for the original transaction. 

Related Topics:
As a Split Distrubution
As a Separate Transaction



Customer Credits/Discounts:    As a Split Distribution

To handle customer credits and discounts as a split distribution:

1. Drag the Find button to your Receivables account.    The Find box appears.
2. Select the original transaction to which you want to add the credit or discount.
3. Click on the Category box and add an additional line for the credit or discount.    Type a negative 

amount for the value.    Use the same category that you used for the original transaction.
4. Click on Recalc Total, then click on Record.



Customer Credits/Discounts:    As a Separate Transaction

To handle customer credits and discounts as a separate transaction:

1. Click on your Receivables button.
2. From the Receivables box, choose Record Decrease.
3. Enter the complete transaction information for the discount or credit.

Use a positive number for the amount.    The amount will be subtracted from the 
Receivables balance and reduces assets.
Make sure you use the category that was used on the original invoice so that the credit 
or discount is applied properly.

4. Click on Record.



Business Reports

CA-Simply Money provides several reports to help you track your receivables, payables, and other 
business accounts.    The predefined reports include:

Financial Reports:
· Cash Flow
· Net Worth
· Category Summary
· Itemized Categories
· Tax Summary
· Balance Sheet
· Accounts Receivable
· Accounts Payable

Income, Account, Payee Reports:    reports on Payroll (with summary of liabilities) and other accounts.

Miscellaneous Reports:    Employee Payroll Report.

You can modify any of these reports or add your own.    For more information, see 
Reports.



Payroll Accounting

Wages and salaries represent a major element in the cost structure of most businesses.    For some 
service businesses, the compensation paid to employees may be the largest single expense incurred.    
The procedures and requirements associated with accounting for salaries and wages include several 
different current liabilities related to a company's payroll expense.

The CA-Simply Money Payroll can automate many of your repetitive tasks, including:

· Writing and printing payroll checks
· Recording employee payroll taxes and deductions
· Writing and printing checks for payroll liabilities
· Creating payroll transaction and summary reports

Related Topics:
Setting up a Payroll System
Setting up Payroll Liabilities and Expenses
Writing Payroll Checks
Using the Payroll Register
Paying Withholding Taxes
Payroll Reports



Setting up a Payroll System

The procedures you use for paying employees depends entirely on the structure of your business.    Two 
records are basic to most payroll systems:    the individual employee earnings records and the payroll 
register.    The CA-Simply Money payroll account provides a detailed listing of every payroll transaction 
and also automatically sets up liability and expense categories for withholding. 

To set up a payroll system, follow this general procedure:

1. If you wish, create a payroll funding account.    Use this account to provide funds for the payroll.
2. Create the payroll account.    Use this account to pay employees.    The payroll account helps you 

track detailed distributions to liability and expense categories.
3. Create employee payee buttons.
4. If you wish, set up withholding destination payee button(s).

You will need to remit FICA taxes, federal income taxes withheld, and federal unemployment 
insurance taxes in accordance with the federal remittance requirements.    The state unemployment 
compensation taxes would be remitted to the appropriate state agency, according to the state 
requirements.    You may want to set up payee buttons for the bank and/or other institutions that take 
care of these liabilities for you.

Related Topics:
Setting Up a    Payroll Funding Account
Setting Up a Payroll Account
Setting Up Employee Payees
Setting up Payroll Liabilities and Expenses
Writing Payroll Checks
Paying Withholding Taxes



Setting up Payroll Liabilities and Expenses

An employer is by law a tax collector for the federal government with respect to taxes withheld from 
employees' salaries.    An employer may also withhold amounts for such items as union dues, state 
disability insurance, group life insurance, pension plans, and for purchase of savings bonds.

The payroll account itself is an expense and liability (it is actually a specialized liability account).    When 
you create a payroll account, CA-Simply Money automatically creates the necessary liability and expense 
subcategories:    

· for employer contributions
· for employee contributions

These subcategories store your current liability for each type of tax or other deduction.    In addition, there 
are two miscellaneous categories each for liability and expense.    These can be used for non-standard 
deductions, such as charitable contributions or extra withholding taxes.    The payroll expense categories 
are automatically flagged for tax reporting in the Tax Summary report.

Here's how it works:

1. Each time you write a payroll check, you deduct amounts using these predefined categories.    CA-
Simply Money keeps track of each kind of liability.    See Writing Payroll Checks.

2. You track these liabilities by looking at a Payroll Report, a Category Summary of payroll liabilities, or 
other reports.    

3. You then pay withholding taxes based on the report information.    

Related Topics:
Employer Taxes
Employee Taxes
Paying Withholding Taxes
Scheduling Tax Payments
Payroll Reports



Employer Taxes

The following subcategories are set up automatically as expenses and liabilities when you 
create a payroll account.    As an employer, you are responsible for paying these:
FICA Employer's portion of social security and Medicare. 

FUTA Federal unemployment tax.

SUI State unemployment insurance.

Disability Employer liability for disability insurance.

Misc. There are two miscellaneous categories which you can use for other employer-paid taxes
or deductions.    Miscellaneous deductions include union dues, insurance premiums, and 
retirement plans.

Note:    In a CA-Simply Money payroll account, employer liabilities are distributed as a negative amount to
a liability category and a positive amount to an expense category.    Therefore, they do not affect the 
employee's net pay.    



Employee Taxes

The following subcategories are set up automatically as liabilities when you create a payroll 
account.    These amounts are withheld from the employee's gross earnings:
FIT Federal Income Tax. 

SIT State Income Tax.

FICA Employee's portion of social security and Medicare.

SDI State disability insurance.



Setting Up a Payroll Account

CA-Simply Money makes setting up a payroll easy.    The main payroll expense category, and the 
subcategories for employer payroll taxes and other payroll-related expenses, are automatically created for
you. 

To set up a payroll account:

1. Drag the Accounts button to the Setup button.
2. Click Add a New Account.
3. In the Account Setup-Add box, name your payroll account.
4. From the Account Type list, choose Payroll, then click OK.

Note:    It may take slightly longer for    CA-Simply Money to create Payroll than other accounts.

When you create a payroll account, CA-Simply Money creates liability (payroll liability) and expense 
subcategories (payroll expense).    See Setting up Payroll Liabilities and Expenses.

Related Topics:
Writing Payroll Checks
Using the Payroll Register
Paying Withholding Taxes



Setting up Employee Payees

You can set up employee accounts as payee buttons, either by using the Setup button or by adding them 
as you write payroll checks.    See Adding Payees.    It is also helpful to group the payees.    You can write 
checks and get payroll reports quickly when you work with a group.    See Making a Group.

The employee payees on the left can be grouped into a single Payroll payee.    You can then generate 
reports and graphs analyzing your total costs in compensation simply by dragging the Payroll payee 
button to the Reports or Graphs button.



Setting up a Payroll Funding Account

If you have just a few employees you can pay them with checks drawn on the firm's regular bank account.
However, with more than a few employees, you should consider setting up a separate bank account to 
pay the payroll.    Set this up in the same way as any other checking or asset account:

1. Drag the Accounts button to the Setup button.
2. Choose Add a New Account.
3. Name the funding account.    
4. Select a Checking or Asset type account and click OK.

When you write payroll checks, use this account to fund the payroll.    When you print payroll checks, print 
them from this account.



Writing Payroll Checks

Before you can write any payroll checks you must set up a payroll account.    See Setting up a Payroll 
System.    You should also gather all necessary federal and state withholding information.

There are several ways to begin the payroll check-writing procedure:

· Click once on your Payroll account button.    
· Drag the Payroll account button to the Write button.
· Drag the Payroll account button to an employee payee button or group payee button.    This method 

calls up previous payroll information for the employee(s).

When the Select an Account box appears:

1. Select the account you want to use to fund the payroll; usually a checking account.
2. Choose Computer Printed Check or Handwritten Check.

If you choose Handwritten Check, a Start No. box appears in the lower right corner.    Type the 
appropriate check number in the box.

3. Choose OK.    The Write a Payroll Check box appears.
4. Type the date of the check.
5. In the Employee box, type the employee name.    Values from the last check written for this payee (if 

any) appear.
If you dragged your Payroll button to a payee button, the employee name and previous values 
automatically appear.
You may find that the values for many employees are exactly the same for each pay 
period.    You can then just verify the information and click on Record.

6. In the Gross box, type the amount earned by this employee for this pay period.
7. Type amounts for applicable employer and employee taxes.    These are described in detail in Setting

up Payroll Liabilities and Expenses.
Employee deductions are totaled in Deductions and subtracted from Gross to get the 
amount shown in the Net box.

8. Click on Record to go on to the next payroll check; click Close when you are finished.

Note:    You can calculate earnings and deductions using the Windows calculator to quickly insert values 
into the appropriate boxes.

Related Topics:
Adding Other Deductions
Printing Payroll Checks



Adding Other Deductions

In addition to standard federal and state tax deductions, you may need to deduct other amounts from the 
employee paycheck.    To add other deductions:

1. From the Write a Payroll Check box, click on the Distributions button.    
2. The Distribution Register appears.    Add extra categories and their deductions (as negative 

amounts).

CA-Simply Money adds these to the total deductions in the Write a Payroll Check box.    You will see a 
sum of the extra distributions in the Adjustment box below Deductions.

Note:    Employee deductions are entered as negative amounts in the Distribution Register.    Employer 
liabilities are distributed as a negative amount to a liability category and a positive amount to an expense 
category; they do not affect the employee's net pay.    If you enter an employer liability through the 
Distribution Register, be sure to distribute it as described in this note.    To check your work, run a 
Category Summary report and select the Payroll Expense and Payroll Liabilities categories.



Printing Payroll Checks

Printing payroll checks uses the same procedure as printing any other check.    If you print on voucher 
checks, CA-Simply Money prints the first fifteen lines of category information. 

To print payroll checks:

1. Click once on the checking account that you are using to fund the payroll.    (Or, drag the checking 
account button to the Write button).    The checkbook appears.

2. If necessary, scroll through the checks and mark appropriate checks for printing.
3. Click on the Print button.    



Using the Payroll Register

Use the payroll register to change, delete, or view payroll transactions.    You can also use it to record 
payroll information, but it is better to use the Write a Payroll Check box, since that box lists your common 
distributions and makes data entry simpler (see Writing Payroll Checks).

Editing Payroll Transactions
To change or view a payroll transaction:

1. Drag your payroll button to the Register button.
2. Scroll to the desired transaction.
3. Change the information as needed.
4. Choose Record to update the transaction.
5. When you are finished using the payroll register, choose Exit to return to the main window.

Deleting Payroll Transactions
To delete payroll transactions:

1. Drag the your payroll button to the Register button.
2. Scroll to the desired transaction.
3. Choose Delete, then Yes.
4. When you are finished using the payroll register, choose Exit to return to the main window.



Paying Withholding Taxes

The methods and schedule you use to pay your payroll liabilities depend on your specific situation.    The 
following is a general procedure.

1. Use a report to find the amount of current liability.    Drag your payroll button to the Reports button.    
The Payroll report appears with a summary of liabilities.

2. Set up a payee for the destination of the withholding funds if you haven't already.
3. Drag the checking (or other) account button to the payee you set up in step 2.
4. From the Category box, select the payroll liability account you are paying off.
5. Click on Record.    CA-Simply Money automatically makes the appropriate changes to information the

liability category stores, and to the payee, and to the funding accounts.
Use the Distribution Register if you make more than one kind of tax deposit per period.

6. Click the Print button to print the check.

Related Topics:
Scheduling Tax Payments
Setting up Payroll Liabilities and Expenses



Scheduling Tax Payments

The Scheduler is very helpful in making sure you run your payroll on time and pay your withholding 
liabilities when they are due. 

To schedule a payment:

1. Use the Schedule button, or select Schedule Actions from the Tools menu, to open the Schedule 
Actions box.    See The Scheduler.

2. In the Schedule Actions box, specify the payee or group name, and the frequency of payment.    Use 
the next scheduled payday as the First Payment Date.    



Payroll Reports

CA-Simply Money provides a number of reports to help you.    See Reports if you need to make special 
reports.

Payroll.    Shows employer expenses/liabilities for a period.

Employee Payroll.    Shows the amounts withheld from employee paychecks.

Payroll Register.    Shows payroll transactions with full detail.    From the Button Reports, select Account 
Reports, then your Payroll account.

Category Summary.    Select the payroll expense and liability categories from this report and save it as a 
memorized report.



Petty Cash

A petty cash fund is a fixed amount used for making small expenditures that are most conveniently paid in
cash.    The petty cash fund is restored to its original amount at frequent intervals by writing a check to 
Petty Cash.    The replenishment check is equal in amount to the expenditures made from the fund.
The size of the fund should be sufficient to meet normal needs for small cash payments for a period of 
two or three weeks.    As each cash payment is made, you record a transaction in the Petty Cash account.
Typically the person holding the petty cash will keep a list of disbursements showing what was withdrawn,
by whom, and for what.

Related Topics:
Setting Up a Petty Cash Account
Recording Petty Cash Disbursements
Infrequent/One-time Payees
Replenishing Petty Cash
Using a Petty Cash Fund: An Example



Setting Up a Petty Cash Account

To set up a petty cash account for your business:

1. Drag the Accounts button to the Setup button.    Choose Add a New Account.
2. Give the account a name, such as Petty Cash, and choose the account type "Cash."
3. Use your existing cash balance in the Starting Account Balance box, or, to start fresh, enter zero as 

the starting amount.
4. Click OK to set up the account.
5. If you start with a zero balance, you need to add cash to the account.    Drag the button of the funding

account (usually a checking account) and drop it on your petty cash button.    The Account-to-
Account transfer box appears.

6. In the Amount box, type the amount of cash you expect to need in the Petty Cash account.
7. Click on Record to complete the deposit.
8. Use the procedures below for recording disbursements and replenishing the account.

Related Topics:
Recording Petty Cash Disbursements
Replenishing Petty Cash



Recording Petty Cash Disbursements

To record disbursements:

1. Click on your Petty Cash button, then click on Withdrawal.    The Cash Out box appears.    
If a payee is already set up in your finance group, you can drag your petty cash button 
to the appropriate payee button.

2. If necessary, select the payee and the appropriate category.
3. In the Amount box, type the amount of the disbursement.
4. You can use the ID or Memo fields to describe the disbursement and/or identify the person who 

withdrew the cash.
5. Click on Record to save the transaction.

Related Topic:
Infrequent/One-time Payees



Infrequent/One-time Payees

Many petty cash disbursements will be to one-time payees.    If the payee is not currently in your list, the 
Payee Setup-Add box appears.    You can click on the one-time only Payee box to prevent the payee from
being added to the Payee Browser list.    If a payee will be used more than once, but infrequently, you can 
click on Hidden Button.    This adds the payee to the Payee list but prevents a button from displaying in 
the main window.



Replenishing Petty Cash

The petty cash account is typically replenished every two weeks.    Funds are generally transferred from 
the checking account to the petty cash account.    

1. Double-click on your petty cash button to view the petty cash register.    Use the Windows Calculator 
to calculate the amount required to replenish the account.    Subtract the current balance from the 
regular balance of the account to get the replenishing amount.

2. Click on your petty cash button, then click on Deposits.    The Cash In box appears.    
3. Use the From box to select the account from which you are transferring the replenishing funds.    This

is usually the checking account.
You can also drag the button of the funding account and drop it on your petty cash 
button.    The Account-to-Account Transfer box appears.    

4. In the Amount box, type the amount you calculated in step 1.
5. Click on Record to complete the deposit.    The balance of the fund is now restored to the original 

amount.



Using a Petty Cash Fund:    An Example

Example:    On March 2, a petty cash fund of $200 was established for the purpose of paying certain bills. 
Here are the itemized list of disbursements for the subsequent two week period:

Mar. 5: Misc. Expense $ 29.00

Mar. 10: Office 
Expense

$43.53

Total $ 72.53
The account was replenished by making a deposit from the Checking account on March 16.    The total 
disbursement was $72.53; the regular balance ($200.00) less the current balance    ($127.47).



Support Tools

In addition to the main functions and features, CA-Simply Money provides a variety of helpful tools.    They
are listed in alphabetical order below.    Click on each for more information.

The Financial Calculators
Reports
Graphs
The Scheduler
The Kiplinger's Financial Advisor
The Find Feature
The Alert Utility
The Calendar
The Notes Feature
Exporting and Importing Data



The Financial Calculators

In addition to the standard Windows calculator, CA-Simply Money has five financial calculators.    They are
the tools you need to make decisions about your loans and investments.    They let you calculate:

· amortization tables
· refinancing costs and benefits
· effective interest rates
· current yield from stock dividends
· amounts to invest to reach your financial goals

Related Topics:
Using the Loan Calculator
Using the Refinance Calculator
Using the Interest Calculator
Using the Dividend Calculator
Using the Investment Calculator
Using the Windows Calculator
Pasting a Calculation into CA-Simply     Money  



Pasting a Calculation into CA-Simply Money

To paste a calculation into CA-Simply Money:

1. Make your calculation.
2. Highlight the information you want to copy from any of the number boxes.
3. Press CTRL+C to copy to the Windows clipboard.
4. Select the box where you want to paste the information.
5. Press CTRL+V.    The number is pasted into the transaction.



Using the Loan Calculator

The Loan calculator helps you to determine how large a loan you can afford or, given a particular loan 
amount, what your payments will be.    The loan calculator also allows you to build an amortization table, 
which shows the contribution of each payment to principal and interest and the amount of principal 
remaining after each payment. 

To calculate a loan:

1. From the System menu, choose Financial Calculators, then Loan.    The Loan calculator appears.
2. Click the Principal, Payment, or Annual Interest Rate button.    CA-Simply Money calculates the value

you choose.
3. Type the appropriate amounts in the other two boxes.
4. In the Number of Years box, type the length of the loan.
5. In the Payments per Year box, choose the payment frequency.
6. If payments will be made at the end of the period, click the Payment Made at End of Period box.
7. Click Solve.    CA-Simply Money fills in the missing value.
8. To recalculate with different starting values, type the new value or values into their boxes and click 

Solve again.

Related Topics:
Calculating a Loan:    An Example
Pasting a Calculation into CA-Simply Money



Calculating a Loan:    An Example

Example:    You are looking for a loan of $100,000 to buy a house.    Your bank offers you a rate of 10% 
over thirty years.    What will your monthly payments be?

1. From the System menu, choose Financial Calculators, then Loan.
2. Click the Payment radio button to "Solve" for this amount.
3. Type 100000 in the Principal box.
4. Type 10 in the Annual Interest Rate box.
5. Type 30 in the Number of Years box.
6. Click Solve.    CA-Simply Money tells you that your monthly payment will be $877.57.
7. If you want to see an amortization schedule, click the Amortize button.    Use the scroll bar to see 

payments that do not show in the window.
If you want to print the table, click the Print button.

8. Click OK to return to the calculator.

You can also display and print an amortization table when you set up a mortgage account.    



Using the Refinance Calculator

The Refinance Calculator helps you decide if you should refinance a loan.    The refinance calculator 
figures out how long it will take you to break even on the refinance. 

To calculate a refinance:

1. From the System menu, choose Financial Calculators, then Refinance.    The Refinance Calculator 
appears.

2. In the labelled boxes, type your current payment and the parameters of the proposed refinance.
3. Click Solve.    The new payment, saving, and break-even time are shown at the bottom of the 

calculator. 

Related Topics:
Calculating a Refinance:    An Example
Pasting a Calculation in CA-Simply Money



Calculating a Refinance:    An Example

Example:    Your bank offers to refinance your $100,000 mortgage at 8% over thirty years for 
a charge of $2000.    Your current monthly payment is $870.32.    How long will it take you to 
break even?    By how much can you lower your payment?
1. From the System menu, choose Financial Calculators, then Refinance.
2. Type 870.32 in the Current Monthly Payment box.
3. Type 100000 in the Refinance Amount box.
4. Type 30 for Length of Loan.
5. Type 8 for Interest Rate.
6. Type 2000 for Closing Costs.
7. Type 0 for Points.
8. Click Solve.    The Analysis box tells you that your new monthly payment will be $733.76 and that it 

will take you about 15 months (14.65) to break even on the deal.



Using the Interest Calculator

Interest rates are often quoted as nominal rates, which do not take interest compounding into account.    
The Interest Calculator allows you to convert between the nominal rate and the effective rate (which does 
include compound interest.) 

To convert nominal and effective interest rates:

1. From the System menu, choose Financial Calculators, then Interest.    The Interest Calculator 
appears.

2. Click the button next to the rate for which you wish to "Solve."
3. Type the known rate into the appropriately labeled box.
4. Click Solve. The Financial Calculator displays the other rate.

Related Topics:
Converting Interest Rates:    An Example
Pasting a Calculation into CA-Simply Money



Calculating the Effective Interest Rate:    An Example

Example:    You have been offered a loan at a nominal rate of 8% interest. With compounding interest, 
how much is the effective rate?

1. From the System menu, choose Financial Calculators, then Interest. 
2. In the Nominal Rate box, enter 8.
3. Click the radio button next to Effective Rate.
4. Click Solve.    The Effective Rate box shows 8.3%.    This is the effective rate, with compounding 

interest, for this loan.



Using the Dividend Calculator

The Dividend Calculator translates cash dividends for stocks into an annual yield. You can compare the 
annual yield to other investments that make periodic payments.    To calculate the annual yield:

1. From the System menu, choose Financial Calculators, then Dividend. The Dividend Yield calculator 
window appears.

2. Type the share price in the Share Price box.    Use the share price at the time the dividend was paid.
3. Type the dividend per share into the Dividend box. 
4. Click Solve. The annual yield is displayed next to "Yield."

Related Topics:
Calculating Annual Yield:    An Example
Pasting a Calculation in CA-Simply Money



Calculating Annual Yield:    An Example

Example:    A security you own has a price of $28 ¼ and pays a dividend of $1.43.    What annual yield will
this investment return?

1. From the System menu, choose Financial Calculators, then Dividend. 
2. Type 28.25 in the Share Price box. 
3. Type 1.43 in the Dividend box. 
4. Click Solve. The annual yield is 5.06%.



Using the Investment Calculator

The Investment Goal Calculator helps you achieve your financial goals by letting you calculate:

· how much money you will have if you invest a set amount regularly (see Calculating the Result of 
Investing:    An Example)

· how much money to invest regularly in order to accumulate a set amount (see Calculating How Much
to Invest:    An Example)

· how much money you need to start with in order for a set amount invested regularly to accumulate to
a set amount (see Calculating a Starting Amount:    An Example)

You specify the number of years your money can accumulate, and how often you invest (monthly, 
quarterly, and so on).    You can enter an inflation rate if you want to see the value of your future money in 
today's dollars.    CA-Simply Money can either subtract taxes, or calculate a tax-free investment.    

CA-Simply Money can increase the amount you regularly invest to compensate for inflation.    To see the 
steadily increasing amounts, click on the Payments button.    An amortized investments payment schedule
appears.    It is similar to the payment schedule you can calculate for a mortgage or other loan (see 
Amortizing Loans).

The parts of the Investment Goal Calculator are:

Initial 
Investment

Starting Amount.    How much money you have or need to 
have at the start of your investment.

Target Amount.    The target amount of your investment.

Future Value (inflation adjusted).    The value of the Future 
Amount in today's dollars.    CA-Simply Money calculates this if
you enter a percentage in the Expected Inflation Rate (%) box.

Ongoing 
Investment

Periodic Investment Amount.    The amount you invest 
regularly.    This can be a set amount, or it can increase to 
counteract inflation (click on Adjust Investments for Inflation).

Investments Made.    How often you invest.    This drop-down 
list has these choices:    weekly, bi-weekly, monthly, bi-monthly,
quarterly, semi-annually, annually.

Time and 
Yield

Number of Years.    How long you will invest, in years.

Expected Pre-tax Annual Total Return on Investment (%).   
The percent return you expect to earn on your investment.    

Inflation Expected Inflation Rate (%).    The annual percent of inflation
you expect during the time you invest.    If you enter an 
inflation rate, CA-Simply Money calculates the Future Value 
(inflation adjusted).

Adjust Investments for Inflation.    Indicates that you want 
CA-Simply Money to increase the amount you invest (Periodic 
Investment Amount) to counteract inflation.

Taxes Tax Rate (%).    The percent of taxes you pay (your tax 
bracket).    Enter a tax rate if you want CA-Simply Money to 
deduct taxes from your investment.

Investment is Tax-deferred or Tax-free.    Indicates that you 
do not want taxes deducted from your investment.    CA-Simply
Money does not deduct taxes unless you enter a tax rate, so 
you do not need to click on this if the Tax rate (%) box is 



empty.

For examples of the three types of calculations you can make with the Investment Goal Calculator, click 
on the Related Topics.

Related Topics:
Calculating the Result of Investing:    An Example
Calculating How Much to Invest:    An Example
Calculating a Starting Amount:    An Example
Using the Investment Payments Schedule



Calculating the Result of Investing:    An Example

This example shows how to use the Investment Calculator to calculate the money you will have if you 
invest a set amount regularly.

Suppose you invest $200 a month for 10 years, earning 9% on your investment.    You expect the rate of 
inflation to be 4%.    You already have $10,000.    How much will your investment grow to become?

1. Display the Investment Goal Calculator by either:
· pulling down the System menu, choosing Financial Calculators, then Investment
· double-clicking on the Investment Calculator icon in the CA-Simply Money program group

2. Click the option button next to Target Amount.    This is the amount you will calculate.
3. Type $10,000 in the Starting Amount box.
4. Type $200 in the Periodic Investment Amount box.
5. Make sure Investments Made is set to Monthly.
6. Type 10 in the Number of Years box.
7. Type 9 in the Expected Pre-tax Annual Total Return on Investment (%) box.
8. Type 4 in the Expected Inflation Rate (%) box.    This causes CA-Simply Money to display the Future 

Value (inflation adjusted).
9. Click Solve.    The Target Amount box shows 63,216.43, and the Future Value (inflation adjusted) is 

42,403.43.    



Calculating How Much to Invest:    An Example

This example of the Investment Calculator shows how to calculate what you need to invest in order to 
accumulate a set amount.

Suppose you want to have $100,000 in 10 years.    You already have $20,000.    If you earn 9% on your 
investment, how much do you need to invest each month?    You want the monthly investments to 
increase to counteract the effect of inflation.

1. Display the Investment Goal Calculator by either:
· pulling down the System menu, choosing Financial Calculators, then Investment
· double-clicking on the Investment Calculator icon in the CA-Simply Money program group

2. Select the option button next to Periodic Investment Amount.    This is the amount you will calculate.
3. Type $20,000 in the Starting Amount box.
4. Type $100,000 in the Target Amount box.
5. Make sure Investments Made is set to Monthly.
6. Type 10 in the Number of Years box.
7. Type 9 in the Expected Pre-tax Annual Total Return on Investment (%) box.
8. Type 4 in the Expected Inflation Rate (%) box.    This causes CA-Simply Money to display the Future 

Value (inflation adjusted).
9. Select the box next to Adjust Investments for Inflation. 
10. Click Solve.    The Periodic Investment Amount box shows 221.12.    This is only the amount to invest 

in the first month, however.
11. Click the Payments button to display the adjusted monthly investments, which steadily increase to 

account for the 4% yearly inflation rate.    The Investment Payments Schedule appears.
12. If you wish, print the payment schedule by clicking on the Print button.



Using the Investment Payments Schedule

When you click on the Payments button of the Investment Calculator, the Investment Payments Schedule 
appears.    It has these columns:

Payment.    Consecutive payment numbers.

Amount.    The amount of each payment.    The amounts steadily increase if you selected Adjust 
Investments for Inflation on the Investment Calculator.

Balance.    The steadily increasing balance of your investment.

Use the scroll bar to see any payments that do not show in the window of the Investment Payments 
Schedule.

If you want to print the schedule, click on the Print button.    To go back to the Investment Calculator, click 
on OK.



Calculating    a Starting Amount:    An Example

This example of the Investment Calculator shows how to calculate the amount you need to start with in 
order for a regularly invested amount to accumulate to a set amount.

Suppose you want to have $100,000 in 10 years, after taxes.    You can invest $300 a month.    If you earn 
9% on your investment, how much do you need to start with?

1. Display the Investment Goal Calculator by either:
· pulling down the System menu, choosing Financial Calculators, then Investment
· double-clicking on the Investment Calculator icon in the CA-Simply Money program group

2. Click the option button next to Starting Amount.    This is the amount you will calculate.
3. Type $100,000 in the Target Amount box.
4. Type $300 in the Periodic Investment Amount box.
5. Make sure Investments Made is set to Monthly.
6. Type 10 in the Number of Years box.
7. Type 9 in the Expected Pre-tax Annual Total Return on Investment (%) box.
8. Type 31 in the Tax Rate (%) box.    
9. Click Solve.    The Starting Amount box shows 27,059.73.    



Using the Windows Calculator

You can use the standard Windows calculator from CA-Simply Money.    The calculator is useful when you
need to adjust figures before recording a transaction.

To display the Windows Calculator:

1. From the System menu, choose Calculator.    The calculator appears.
2. Click on the buttons just as you would press buttons of a real calculator.    To copy the number in the 

display to the Clipboard, choose Copy from the Edit menu or press Ctrl+C.

See your Windows User's Guide for other details on using the calculator.

Related Topic:
Calculating Figures: An Example



Calculating Figures:    An Example

Example:    You paid for four nights at a hotel with a credit card.    You want to record the first three nights 
of a hotel stay as a business expense and the last night as a personal (travel) expense.    Instead of 
calculating the two entries by hand, or looking for a calculator, use the Windows Calculator:

1. With your credit card register open, pull down the System menu and choose Calculator.
2. Make the appropriate calculations for the three business nights plus tax and other services.
3. Press Ctrl+C to copy the amount.
4. Open the credit card distribution list and use CTRL+V to paste the amount into the distribution 

register under a business category.
5. Assign the remaining amount to an entertainment or other personal category.



Reports

CA-Simply Money can generate a variety of detailed reports to help you manage your finances.    
Displaying or printing a report is as easy as choosing the type you want.    You can choose date ranges, 
page numbers, and founts.    You can also choose from numerous formatting options to customize your 
reports.

CA-Simply Money offers six types of reports: 

Transaction
Financial
Button (Income, Account, Payee) 
Investment
Miscellaneous
Memorized

You can also import BillPay USA Records.

Note:    If your report shows no data, you may want to change the report dates.    See Setting the Report 
Title and Date Range.

Related Topics:
Producing a Report
Customizing Your Report
Memorizing Custom Reports and Graphs
Generating a Transaction Report or Graph
Setting Default Report and Graph Options
Printing a Report or Graph
Exporting a Report to Another Program



Setting Default Report and Graph Options

This procedure explains how to choose a default range of dates for your reports and graphs to cover.    It 
also shows how to choose color or monochrome reports and graphs.

Note:    You can also set date ranges from within a report or graph.    On the report or graph window, pull 
down the Options menu and choose Filters and Styles.    Then follow the same procedure explained 
below for Dates Ranges.

To set default report and graph options: 

1. From the System menu, choose Settings, then Reports & Graphs.    The Reports & Graphs Settings 
box appears.    

2. Make changes to defaults (see Date Ranges and Color/Monochrome below).
3. Click OK to set the new defaults and return to the main window.

You can access the main window System menu from within the Report display, but the default changes 
will not take effect until the next report is generated.

Date Ranges
To set a default date range:    
1. Either:

· Type dates in the Starting on and/or Ending boxes.    
· Click on the Dates button and make a selection from the drop-down list that appears.
The dates in the Starting on and Ending boxes change to reflect the choices you make. 

The date range you specify is used for all reports and graphs, unless you change the dates using Filters 
and Styles from the Options menu in the Report or Graph window.

Color/Monochrome
All reports and graphs by default include colors.    Reports include red and blue.    If you are using a 
monochrome laptop, you may want to turn the report colors off.    To set the display to monochrome:

1. In the Display box, click to deselect the Use Color on Reports box.



Producing a Report

To produce a report:

1. Click on the Reports button.    The Report Selections box appears.    Some other ways to get to this 
box are:
· From the Tools menu, choose Produce Reports.      
· Drag the Reports button to an income, account, or payee button
· From a report display window, pull down the Options menu and choose Report List.

2. From the Report Selections box, choose one of the six types of reports:
Transaction 
Financial 
Button (Income, Account, Payee) 
Investment 
Miscellaneous 
Memorized 

The list of available reports for the chosen report type appears in the box to the right.
3. In the box, click on the specific report you want to generate, then click on OK.

The report appears in the report display window.    Use the scroll bar to browse the report.

Related Topics:
Customizing Your Report
Printing a Report or Graph
Exporting a Report
Setting Default Report and Graph Options



Customizing Your Report

Each report represents a special view of your finances.    That view changes based on the information you
choose to include and the format in which you display the report.    To get a more specialized view of your 
finances, you can customize any CA-Simply Money report:    Use the Options menu in the report display 
window to select any of the following:

Filters and Styles
Decide which items to "filter" out of or to include in your report.    Decide how you want numbers 
displayed, how often you want amounts subtotaled, and choose among many other options.    

Title and Body Font
Choose different fonts to use for the report title and for the body of the report.

Click OK in each dialog box to accept changes.    Memorize the report if you want to use your changes in 
the future.

Report List
This option does not change the current report; it lets you choose a different report to produce.

Related Topics:
Setting the Report Title and Date Range
Changing Report Settings
Including and Excluding Information
Choosing Report Fonts
Memorizing Custom Reports and Graphs
Setting Default Report and Graph Options



Setting the Report Title and Date Range

To change the report title and choose dates that the report will cover:

1. From the report display Options menu, choose Filters and Styles.    The Report Generator box 
appears.    The predefined title appears in the Title box and the default date range appears in the 
date boxes.    

2. Type your customized title in the Title box.    Use codes if you wish.    
3. In the Date Range box, click on the Dates button.    A list displays nine date range options.    Choose 

a range, or, in the Starting on and Ending boxes, type in the dates you want to include in your report. 

Note:    You can set a default date range for all reports, as described in Setting Default Report and Graph 
Options.

4. Make further changes by clicking the Settings and/or Include buttons, then click OK to produce a new
report.    You can use these changes for this report only or memorize them to use with other reports.   

Settings.    Click the Settings button to choose among report format and style options.    

Include.    Click the Include button to specify information (accounts, payees, categories, etc.) to include in 
the report.    

Related Topics:
Changing Report Settings
Including and Excluding Information
Choosing Report Fonts
Memorizing Custom Reports and Graphs
Using Title Codes



Changing Report Settings

You can customize your report by changing report settings in the Report Options box.    To get the Report 
Options box:

1. From the Report display Options menu, choose Filters and Styles.    The Report Generator box 
appears.    

2. Click on the Settings button.    The Report Options box appears.

Report Options are divided into five boxes.    Click on each below for more information:

· General.    Set decimal format, turn on time and date, and turn on page numbering.
· Date Subtotal.    Set a time interval for subtotaling amounts.
· Cleared Status.    Limit information based on whether transactions are cleared or not.
· Show.    Limit the kinds of transaction information shown in the report.
· Amount Range.    Limit transactions shown to certain dollar amount ranges.

After making all changes, click OK to save your changes and return to the Report Generator box.    You 
can use these changes for this report only or memorize them to use with other reports. 

Related Topics:
Setting the Report Title and Date Range
Including and Excluding Information
Memorizing Custom Reports and Graphs



Setting General Options

The Report Options "General" box provides three options for customizing your report.    Click boxes to turn
these options on (marked) or off (empty).

Show cents on Amounts.    Turn this option on to include two decimal places for cents.    Turn it off to 
show only whole-dollar amounts.

Time/Date Stamp.    Turn this on to show the time and date the report was generated.    

Page Numbers.    Turn this on to print page numbers on each page.    Turn it off to show no page 
numbers.    This option only applies when the report is printed.



Setting Date Subtotal Options

The Report Options "Date Subtotal" box lets you set time intervals for subtotaling your dollar amounts in 
the report, ranging from weekly to annually.    Choose the subtotal interval by clicking on a button.    You 
can use only one option at a time.    

You can request a subtotal at the end of each:

· Week
· Two week period
· Half month period
· Month
· Quarter
· Half year
· Year

Example:    A typical Transaction Summary might sum your payments made during the entire year.    
Suppose you want to see how much you spent in each category on a monthly basis.    Select Month from 
the Date Subtotal box.    Now the monthly totals for each category are also displayed.



Setting Cleared Status Options

The Report Options "Cleared Status" box lets you choose which account transactions to include in a 
report based on their cleared status.    Click boxes to turn any or all of these options on (marked) or off 
(empty):

Blank.    Shows checks that have not cleared.

Cleared.    Shows checks that have cleared and have been reconciled.

Newly Cleared.    Shows checks that have cleared but have not been reconciled.



Setting Show Options

The Report Options "Show" box lists items that may or may not be included in transactions.    For 
example, if you type memos on your checks, you may not want those to show in your report.    Click boxes
to turn these options on (marked) or off (empty):

Transactions.    When you generate report containing transaction information, you can show Date and 
Paid From information (on) or exclude it (off).

Distributions.    If you distribute parts of payments to different categories, you may choose to show this 
information (on) or not show it (off).

Tax-Related Categories Only.    Turn on this option to show only information from the categories that you
have assigned for tax reporting.

Memos.    You can choose to show memos for transactions (on) or not show them (off).

Subcategories.    Turn this on to report amounts in subcategories.    Turn it off to display only top-level 
category amounts.



Setting Amount Range Options

The Report Options "Amount Range" box lets you select a range of amounts to show in transaction 
reports.    You can also show all transaction amounts.    Choosing an amount range might be helpful in 
tracking levels of expenses.    Click buttons to turn options on (marked) or off (empty).

All Amounts.    Shows every transaction.

Amount Range.    Shows all transactions within the range you set.

Low:.    An amount for the bottom of the range.

High:.    An amount for the top of the range.



Including and Excluding Report and Graph Information

You can customize your report, graph, or QIF export file by choosing which income sources, accounts, 
payees, categories, or classifications to include.    By default, CA-Simply Money includes all information 
that applies.    By manually choosing items to include, you can effectively exclude certain items, 
categories, and/or classifications that would otherwise have been included in the report, graph, or QIF file.

Select information from the Include box.    To include items in a report, graph, or export file:

1. Display the Include box by clicking the Include button in the Report or Graph Generator box or in the 
Export Data box.    
The Include box contains a list (on the left) and a series of buttons (on the right).    The contents of 
the list depends on the button that is selected.    For example, if the Accounts button is selected, you 
see a list of all accounts.    Any highlighted item in the list will be included in the report.    Items that 
are not highlighted will be excluded.    

2. Change the selection list by clicking the buttons on the right.    Only buttons relevant to the report, 
graph, or export file are available.    Others are dimmed.

3. Highlight an item in the selection list on the left by clicking on it.    Deselect an item by clicking to 
remove the highlight.
To select all items, mark the Select/Deselect All box.    Deselect all items by clearing the 
Select/Deselect All box.    

4. Click OK to display the report or graph.    

If you are producing a report or graph, you can memorize your information selections for use with future 
reports or graphs.    

Related Topics:
Selecting Report Information:    An Example
Exporting to QIF:    An Example



Selecting Report Information: an Example

Example:    You have produced an Account Transaction Report on your checking account.    Now you 
want to print the report limiting it to transactions for Barton's Pharmacy and Albert's Food:

1. Pull down the Options menu and choose Filters and Styles.    
2. Click on Include.    The Includes box appears.    
3. Click the Payees button.    All payees appear highlighted in the list.
4. Click to clear the Select/Deselect All box.    
5. Click on Barton's and on Albert's in the Payee list.



Choosing Report Fonts

There are separate menu commands for selecting the fonts for the body and the title of a report.    
However, the procedures are identical. 

To choose fonts for a report:

1. From the Report display Options menu, choose Title Font or Body Font.    The Report Font box 
appears.    

2. From the Font box, choose a typeface.
3. From the Font Style box, choose a style (Regular, Italic, Bold, etc.).
4. From the Size box, choose a font size.
5. In the Effects box, choose any or all of the options.

Text appears in the Sample box with the selected typeface, font style, and size.    The 
Font, Font Style, and Size boxes list all of the options you installed in Windows for your 
printer.    A message appears under the Sample box indicating whether you have 
selected a printer or screen font.    See your Windows User's Guide for more information 
about using fonts.
Printer fonts are accompanied by the  icon.

6. Click Apply to see what your choices do to the report.    Click OK to set the changes and close the 
Report Font box.    



Printing a Report or Graph

To print a report or graph:

1. Display the desired report or graph.    
2. From the File menu on the report or graph itself, choose Print.    The report or graph prints on the 

selected printer.

Related Topic:
Printer Setup



Exporting a Report to Another Program

You may want to include the data from your report in another application.    The Export command from the 
report display File menu converts the report to a standard ASCII or database format.    Other options for 
exporting reports are:

· Export a Tax Summary Report for use by a tax program; see Exporting to Tax Programs.
· Export several investment, transaction, and category reports for use in Excel applications; see Excel 

Applications.

To export a report in standard ASCII format:
1. Display the report.
2. From the File menu in the report display window, choose Export.    The Print Report to Disk box 

appears.    
3. In the Filename box, type the full path destination for the report file, or use the Browse button.
4. In the Report type box, choose ASCII (PRN) file or Comma delimited.

ASCII.    ASCII files are standard text files you can use with word-processing software.
Comma delimited.    Comma-deliminted files arrange report information into standard 
data records that you can use with most database or spreadsheet software.

5. Click on the Include header box to include the date, title, and column labels in the exported report.
6. If you export in ASCII format, you can specify the maximum number of Lines/page.
7. Click OK to export the report and return to the Report display.    Now you can open the file from your 

other application.

Related Topics:
Exporting Data
Exporting to Tax Programs
Excel Applications



Memorizing Custom Reports and Graphs

You may find that you use several customizing options with certain report or graph types on a regular 
basis.    Instead of selecting these options every time you generate a report or graph, you can "memorize" 
the entire format.    In the future, you simply choose that memorized format from the Reports or Graphs 
list. 

To memorize a report or graph:

1. Generate a report or graph and choose the options you want from the display window's Options 
menu. 

2. From the report or graph display window File menu, choose Memorize.    The Save Memorized 
Report or Graph box appears.    

3. In the Enter Descriptive Name box, type a name that describes your report or graph.    A box displays 
the reports or graphs you have already memorized.    The name you choose will appear in the 
Reports or Graphs selection list, allowing you to use it again.

4. Choose Save to save the report or graph and return to the Report or Graph display window.

Related Topics:
Using a Memorized Report or Graph
Deleting a Memorized Report or Graph



Using a Memorized Report or Graph

Once you memorize custom report or graph settings, you can use the format again:

1. Display the Report Selections box or Graph Selections box using one of these methods:
· Click on the Reports button or Graphs button in the main window
· Pull down the Tools menu and choose Produce Reports or Draw Graphs
· From the report or graph itself, pull down the Options menu and choose Report list or Graph list

2. Choose Memorized Reports or Memorized Graphs on the left side of the dialog box. 
3. Choose a report or graph name from the list that appears, then click OK.    
4. If necessary, choose items to be displayed and click OK to draw the report or graph.

Related Topic:
Deleting a Memorized Report or Graph



Deleting a Memorized Report or Graph

To delete a memorized report or graph:

1. From a report or graph display window, pull down the File menu.    Select Memorize Report or 
Memorize Graph.    A dialog box listing all memorized reports or graphs appears.

2. Highlight the memorized report or graph you wish to delete.
3. Click the Delete button.



Graphs

A picture can be worth a thousand words, and CA-Simply Money can present your financial picture in 
many colorful ways.    You can choose from a wide array of graph types, and use them to present different
aspects of your finances.    All graphs represent transactions occurring within a specified range of dates.    
You can nearly always change the graph type to pie, bar, line, etc.    Each preset graph can be customized
to your particular needs.

CA-Simply Money offers four types of graphs:    

Income & Expense
Assets & Liabilities
Investment
Budget

Note:    If your graph shows no data, you may want to change the graph dates.    See Setting the Graph 
Title and Date Range.

Related Topics:
Drawing a Graph
Setting Default Report and Graph Options
Customizing a Graph
Printing a Report or Graph
Copying a Graph to Another Application



Drawing a Graph

To draw a graph:

1. Click on the Graphs button.    The Graph Selections box appears.      Some other ways to get to this 
box are:
· From the Tools menu, choose Draw Graphs.
· Drag the Graphs button to an income, account, or payee button.
· From a graph display window, pull down the Options menu and choose Graph List.
There are five graph topic areas.    Each area displays a set of graph subjects relating to 
it in the list box.

2. Choose from the following graph topics: 
Income & Expense - To examine income and expense patterns.
Assets & Liabilities - To see your assets and liabilities at a glance.
Investment - To keep track of your investments.
Budget - To create overviews of your budgets and expenditures.
Memorized - To use customized graph formats you memorized. 
The list of available graph subjects for your choice appears in the box to the right.

3. In the box, click on the specific subject you want to graph, then click on OK.

The graph appears in the graph display window.    

Note:    You can display the values associated with any graph.    Click and hold the mouse button on any 
bar or pie slice.    CA-Simply Money displays the value of the data that is represented.

Related Topics:
Customizing a Graph
Memorizing Custom Reports and Graphs
Printing a Report or Graph
Copying a Graph to Another Application



Copying a Graph to Another Application

CA-Simply Money can place a copy of your graph on the Windows clipboard so you can use it in other 
Windows applications.

To copy a graph to the clipboard:

1. Display the graph.
2. From the File menu of the graph display window, choose Copy.    

Use the Paste function from your other application to bring in the graph.    

Note:    The graph will be erased from the clipboard with the next Cut or Copy command from any 
application.    See your Windows documentation for more on the clipboard.



Customizing a Graph

You can make changes to an existing graph with just a few clicks.    When you display a graph, it becomes
a separate window and has its own menu bar.    You can access the graph settings and change its format 
while looking at your graph.    With the graph displayed, use the Options menu in the graph display 
window to make your changes.

Filters and Styles
Change the graph title and date range.    Decide which items to "filter" out or to include in your graph.    
Make other graph setting changes.

Settings
Choose a different graph type for this data: a bar, pie, line, or area graph.    Change the style of the graph,
set labels, specify how often you want amounts subtotaled, and choose among other options.

Click OK in each dialog box to accept changes.    Memorize the graph if you want to use your changes in 
the future.

Graph List
This option does not change the current graph; it lets you choose a different graph to draw.

Related Topics:
Setting the Graph Title and Date Range
Changing Graph Settings
Changing the Graph Type
Including and Excluding Report and Graph Information
Memorizing Custom Reports and Graphs



Setting the Graph Title and Date Range

To change the graph title and choose dates that the graph will cover:

1. From the graph display Options menu, choose Filters and Styles.    The Graph Generator box 
appears.    The predefined title appears in the Title box and the default date range appears in the 
date boxes.    

2. Type your customized title in the Title box.    Use codes if you wish.    
3. In the Date Range box, click on the Dates button.    A list displays nine date range options.    Choose 

a range, or, in the Starting on and Ending boxes, type in the dates you want to include in your graph. 

Note:    You can set a default date range for all graphs, as described in Setting Default Report and Graph 
Options.

4. Make further changes by clicking the Settings and/or Include buttons, then click OK to draw a new 
graph.    You can use these changes for this report only or memorize them to use with other reports.   

Settings.    Click the Settings button to turn this graph into a bar, pie, line, or area graph and to choose 
new style settings.    

Include.    Click the Include button to specify information (accounts, payees, categories, etc.) to include in 
the graph.    

Related Topics:
Changing Graph Settings
Changing the Graph Type
Including/Excluding Information
Memorizing Custom Reports and Graphs
Using Title Codes



Using Title Codes
The following codes are available to use in title and label text in your reports and graphs:    

%s Start date

%e End date

%b Button name

These codes add the current report or graph information automatically.    

Example.    Suppose you generate a report about a payee button named "Acme," covering information 
from 1/1/93 to 1/1/94.    You might enter this title in the Report Generator box:

Payments %s to %e about %b
When you click OK to leave the Generator box, you get:

Payments 1/1/93 to 1/1/94 about Acme
When you memorize this report and use it again, the codes pick up the new dates and button name. 

Related Topics:
Setting the Graph Title and Date Range
Setting the Report Title and Date Range



Changing the Graph Type

One way you can customize your graphs is by changing the graph type.    For example, you can change a
bar graph to a pie, line, or area graph. 

To select a different graph type:

1. From the Options menu of the graph display, choose Settings.    The Settings box appears.
2. From the Type box, choose a graph type.    See the table of graph types below. 
3. Click OK to draw the graph. 

CA-Simply Money provides several different types of graphs to help you better understand your finances:

Graph Types Uses

Bar Graph Shows individual figures at a specified 
time, or draws comparisons between 
items.    In a stacked bar (column chart) 
categories are organized vertically instead 
of horizontally, placing less emphasis on 
time flow.

Pie Graph Shows the relationship or proportions of 
parts to a whole.    Always contains just 
one data series.    Good for highlighting a 
significant element.

Line Graph Shows trends or changes in data over a 
period of time.    Emphasizes time flow and
rate of change.

Area Graph Shows the relative importance of values 
over a period of time.    Emphasizes the 
amount of change (magnitude of value) 
rather than the rate of change.



Changing Graph Settings

You can customize each graph you draw by selecting additional presentation details, such as formatting, 
sorting, and subtotals.    Make various changes to the graph style from the Settings box. 

To modify the graph style:

1. From the graph display Options menu, choose Settings.    (Or choose Filters and Styles, then click 
Settings.)    The Settings box appears.

2. In the Type box, click to choose a new graph type, if you wish.    Choose from Bar, 3D Bar, Pie, 3D 
Pie, Line, and Area.    See Changing the Graph Type for help on choosing an appropriate type.

3. In the Styles box, click to mark the features you want to use in your graph: 
Draw labels.    Labels the segment on pie graphs; labels the axis on bar, line, and area 
graphs.
Draw X/Y Grid lines.    Includes grid lines on bar, line, and area graphs.    Usually, a 
graph without grid lines has a cleaner look.
Column labels.    Puts labels in a column on the right side of the graph display.    With 
certain types of graphs, you will not be able to deselect this option.

4. Click the More Styles button to view specific style options for the type of graph you have chosen.    
5. Click the Expand button to view additional settings, such as subtotal options. 
6. Click OK to accept the settings and draw the customized graph.    If you wish, memorize the graph to 

use the settings you have selected with other graph data.

Related Topics:
Changing the Graph Type
Bar Graph Styles
Pie Graph Styles
Additional Graph Options
Memorizing Custom Reports and Graphs



Bar Graph Styles

When you choose to change a graph to a Bar or 3D Bar type, you can click More Styles to get the 
following choices.    Click to mark your choices:

Draw clustered bar chart.    Displays a bar for each item value.    Use this option to compare multiple 
items over time.    For example, with multiple income sources you could modify an Income Trend graph 
(normally a stacked bar chart) to show income in clusters rather than in a column for each time period. 

Draw stacked bar chart.    Combines values for all items in a stacked bar.    Use this option to compare 
multiple items, emphasizing amounts of each for each period, rather than progress of each over time.

Draw percentile bar chart.    Displays bars as percentages of the total amount rather than dollar 
amounts.    Use for graphs with more than one set of bars.

Draw bars horizontally.    CA-Simply Money draws bars vertically by default.    This option draws the bars
horizontally.

Cluster bars in Z-axis.    Each item is displayed in a different row along the Z-axis.

Note:    Depending on the data you have selected and on your other choices, some items may show no 
effect.

Related Topic:
Changing the Graph Type



Pie Graph Styles

When you choose to change a graph to a Pie or 3D Pie type, you can click More Styles to get 
the following choices.    Click to mark your choices:
Omit label lines.    Leaves out the lines connecting the label to the segment in a pie graph.

Label colors = segments.    The default color for the labels is black.    This draws the label in the same 
color as its related segment in a pie graph.    Colored labels may be more difficult to read. (Applies only to 
color monitors and printers.)

Give percentages.    The segments are labeled with a percentage value and the percent symbol.    For 
example, if half your expenses for groceries occurred in July, the July segment on the pie graph is labeled
50%.    This option is disabled if column labels are not turned on.

Related Topic:
Changing the Graph Type



Additional Graph Options 

In the graph Settings box, click Expand to display the following choices:
Top Items.    You can limit the items included in your graph so that the graph does not become muddled 
with too much detail.    Choose from the following:    

· No limits.    
· Limit to Top.    Select this to limit items shown in the graph to those with values within a percentage of

the largest value.    For example, enter 10 in the box to show only items with values in the top 10 
percent. 

· Limit to Best Fit.    Select this to let CA-Simply Money choose items for the best looking distribution.
· Collect Remainder into 'Other'.    This is valid if you choose a limit.    Check this box to sum values of 

remaining items (which do not fit within the limit) and display them as one graphical element.    

Subtotals.    On graphs for which a date range is specified, you may also set a time interval for 
subtotaling your dollar amounts.    These subtotals will make up each of the data points of the graph.    
Click to request a subtotal at the end of each:

· Week
· Two week period
· Half month period
· Month
· Quarter
· Half year
· Year

X/Y Labels.    Anything you type here will appear on the graph along the X- and Y- axes.

Keep Dialog Expanded.    Tells CA-Simply Money to expand this Settings box every time you choose 
Settings from the graph Options menu (for this session).    Click to mark this box.

Related Topics:
Including/Excluding Information
Memorizing Custom Reports and Graphs



Printer Setup

CA-Simply Money lets you print:

· Checks
· Reports
· Graphs

Before you can print, you must have a printer connected to a port on your computer.    CA-Simply Money 
offers a convenient shortcut to Windows print setup.    You can change printers, change paper sizes, and 
more.    See your Windows User's Guide for further information, or click Help on any printer box for 
specific information.    

In general, here is how to set up your printer:

1. From the File menu, choose Printer Setup.    The standard Print Setup box appears.    
2. Choose the Default or a Specific Printer.    You can scroll through a list of all printers to which you are 

connected.
To use a printer not in the list, you need to make the change in the Windows Control Panel under 
"Printers."    See your Windows User's Guide for further information.

3. To reconfigure the printer, click the Options button on the Setup box.    Use the Help button on the 
Options box that appears to get help for your particular printer driver.

4. Click on the OK button to continue.

Related Topic:
Setting Check Printing Options



The Scheduler

If you have bills that come due regularly, you can tell CA-Simply Money to prepare each transaction and 
remind you to make the payments, automatically, at a specific time each month.    Transactions are 
prepared using the information you supply in the Schedule Actions box.    You receive scheduled 
transaction reminders from the 
Financial Advisor.    When you "act" on these scheduled transactions, you can edit each as it comes up.    

Here are a few ways to use the Scheduler:

· Get reminders, through the Advisor, when scheduled transactions are due.
· Set up payment of standard monthly bills (rent, car payment, etc.).
· Set up an insurance payment that comes due once every six months.
· Set up a single payment in advance, so you won't forget to pay it.
· Set up routine deposits or account-to-account transfers.
· Write memos to yourself and have them brought to your attention at the appropriate time.    For 

example, if you are expecting a refund by a certain date, you can schedule it and then take 
appropriate action if you do not receive it.

Related Topics:
Scheduling a Transaction
Using the Scheduler:    An Example
Scheduling a Memo Reminder
Completing Action Items
Editing a Scheduled Action
Deleting a Scheduled Action
Scheduling an Investment Action



Using the Scheduler:    An Example

Suppose you have grouped your monthly bills and want to make sure you pay them on time:

1. Drag the Scheduler button to the "Monthly Bills" payee button.
2. In the From box, enter your bank checking account name.    "Monthly Bills" is already in the To box.    

Choose a monthly Frequency, click Record, and then Close.    See Scheduling a Transaction.
3. When the next payment date approaches, the Advisor alerts you that scheduled transactions are 

due.    Pull down the Operations menu and select Action Items to see your scheduled transaction.
4. From the Action Item box list, select the scheduled "Monthly Bills" transaction and click the Act 

button.    See Completing Action Items.
5. Choosing the scheduled transaction takes you straight to the transaction box, where a transaction for

each monthly bill has been prepared.    You simply record each transaction.
6. You can then print the checks.



Scheduling a Transaction

Set up scheduled transactions from the Schedule Actions box.    You can get this box using any of the 
following methods:

· Click on the Schedule button
· From the Tools menu choose Schedule Actions.
· Drag the Schedule button to an Income, Account, or Payee button.

It is easiest to schedule the transaction at the time you fill in information for the initial transaction.    For 
example, you can click the Schedule button from the checkbook.    The information you have supplied in 
the check appears in the Schedule Actions box.

To schedule a transaction:
1. In the From box, type the name of the account (or income source) that will fund the payment.
2. In the To box, type the name of the payee (or account) that will receive the payment.
3. In the Amount box, type the amount of the transaction.
4. Make a selection from the Frequency box, if the action occurs at an interval other than monthly.    

Note that One Time is at the end of the list for one-time scheduled transactions.
5. In the Next Payment Date box, specify the next date of a regularly occurring payment.    If the 

payment is a one-time payment, type the date it should be made.
6. In the Category box, type the category for the transaction.
7. Type an optional memo.
8. Click on Record to schedule the transaction or memo.    A blank Schedule Actions box appears, 

ready to record your next scheduled transaction.
9. Click on Close to return to the main window.



Scheduling a Memo Reminder

You can use the Scheduler to act as a reminder of an action you want to take, without processing a 
transaction.

1. Click on the Schedule button.    The Schedule Actions window appears.
2. In the Memo box, type the reminder message you want to schedule.
3. From the Type list, select Memo Only.
4. Select Frequency:    if this is a one-time reminder, choose One Time.
5. In the Next Payment Date box, enter the date when you want to be reminded.
6. Click Record.



Editing a Scheduled Action

If you have scheduled more than one transaction, you can scroll through transactions in the Schedule 
Actions box to view or edit them.

1. Click on the Schedule button to get the Schedule Actions box.
2. If there is more than one scheduled action, use the scroll bar to find the scheduled transaction or 

memo you want to change.
3. Make the desired changes.
4. Click on Record.
Note:    A scheduled action is either a deposit or a withdrawal, depending on the information you enter in 
the From and To boxes of the Schedule Actions box.    Deposits occur when From is an income source 
and To is an account.    Everything else is a withdrawal.    The only way to change a withdrawal to a 
deposit, or a deposit to a withdrawal, is to delete the scheduled transaction and enter a new one.



Deleting a Scheduled Action

To delete a scheduled action:

1. Click on the Schedule button to display the Schedule Actions box.
2. If there is more than one scheduled action, use the scroll bar to locate the transaction or memo you 

want to delete.
3. When the right transaction is displayed, click on Delete.    The transaction is removed from the 

schedule.



Scheduling an Investment Action

You can schedule an investment transaction, just as you can any other type of transaction.    When you 
choose an investment transaction Type, the Schedule Actions box changes to show "Account" instead of 
"From," and "Security" instead of "To."

1. Click the Schedule button to get the Schedule Actions box.
2. From the Type box, select the type Investment transaction.
3. In the Account box, enter the investment account name.
4. In the Security box, enter the security name. 
5. If applicable, enter a dollar Amount.    For example, if you expect to receive dividends or capital gains 

regularly, you would enter the amount.
6. If applicable, enter Investment information:    number of Shares, Price per share, and amount of 

Commission.    You must enter this information if you want to buy, sell or remove shares.    
Remember, you can edit this information when you "act" on the scheduled transaction date.    

7. Select a Frequency, if the interval is other than monthly.
8. Set the payment date.
9. Click on Record.



The Kiplinger's Financial Advisor

When you click the Advice button, you see a list of advice subjects, with the most recent advice on top.    
These messages are related to your particular financial data.    The list may be a combination of 
reminders to take action and general advice messages:

· Action items remind you to complete scheduled, post-dated and recurring transactions. 
· General messages are provided when the Advisor detects a situation where you might benefit from 

financial tips. 

You can view more information or delete messages,which are described in more detail below.    See 
Viewing and Deleting Advisor Messages

Action Items
The following advice subjects are action items.    If you select an action item, you proceed to an Action 
Item box where you can complete one or more transactions.    See Completing Action Items.

· The Advisor always notes transactions that you have scheduled to take place using the Scheduler.    
· The Advisor automatically notes recurring transactions you make; for example, weekly payments to a

grocery store or to an office supply store are recurring.    
· The Advisor alerts you when unprinted checks in the checkbook are post-dated and when accounts 

have been overdrawn.
· When a recurring transaction seems unusually large or small, the Advisor brings it to your attention.   

For example, if your electric bill never exceeded $80 last year, but this month you accidentally 
recorded a payment for $923, you would get a message saying that the amount seems excessive.

Advice Messages
If you select a general advice message, you proceed to an informative Financial Advisor message.    See 
Getting Advice.    

The Advisor has dozens of useful tips relevant to your specific financial situation.    For example, you are 
paying large amounts of interest on your credit cards, yet you have a large amount of home equity.    The 
Advisor suggests that you take out a home equity loan to pay off the credit card interest and make 
significant savings.

Once you review a piece of advice, the Advisor does not act again on that advice until the next session.    
Some Advisor warnings have longer alert dates; for instance, some reminders about your taxes appear 
only once a year.

Accessing the Advisor
The Advisor button appears in the main window, the Register, the Checkbook, and in transaction 
windows.    The Advisor performs different functions depending on when it is selected.    Clicking on the 
Advisor button while in the Checkbook displays a list of advice specific to the current checking account, 
like "Balance is in the red."    The Advisor button in the main window displays all current advice.    The 
Action Items notice always appears if there are actions pending, regardless of the current window.

Related Topics:
Viewing and Deleting Advisor Messages
Completing Action Items
Getting Advice
Advice Conditions
Using Reminders



Viewing and Deleting Advisor Messages

The Advisor signals you to read your messages by displaying a message on the window message line, as
well as visibly animating the eyes on the Advice button.    If you have Audio option turned on (see System 
Settings), a short tune will play.    The Advice button eyes move until you look at the messages.

To address a particular message:

1. Display the General Advice list.    You can either:
· Click on the Advice button, or 
· From the Tools menu, choose Get Advice.    

2. Highlight the message by clicking on it.
3. To get more information, click Advice.    You can also double-click on the message for the same 

result. 
To delete the message, click Delete.    This simply removes the message from the display.    For 
example, if you have overdrawn an account, the problem does not go away until you deposit more 
funds.

4. To leave the Advice box, click Close.

Related Topics:
Completing Action Items
Getting Advice



Completing Action Items

The Advisor detects any situation that may require a transaction:    scheduled transactions, recurring 
transactions, post-dated checks, and so on.    When it does, it displays a line in the General Advice box to 
remind you to make the transaction: "Scheduled or recurring transactions due."

To complete transactions using the Advisor:

1. Display the General Advice box by clicking on the Advice button.    Then, double-click on the 
"Scheduled, recurring, or due transactions" item.    

-or-

Pull down the Operations menu and choose Action Items.    The Action Items box appears.    
2. In the Action Items box, highlight an item in the list.    The box shows a short description with each 

item.    Double-click on the item, or click on the Act button, to open the dialog box for that action.
You can also choose to skip or ignore the item. 

Note:    Skipping a recurring payment on the Action Items list removes it from both the Action Items list 
and the Scheduled Actions list in the Scheduler.    Skipping a one-time scheduled item removes it from the
Action Items list but leaves it in the Scheduled Action list to be reset or deleted.    

3. To pay a scheduled or recurring bill, choose a transaction from the Action Items box, and click on Act.
The Record Transaction box appears.    
The Record Transaction box contains the information you supplied when you scheduled 
the action in the Scheduler, or the information from the last payment made to a payee 
on a recurring basis.

4. To complete the transaction, make any changes required to the transaction information in the Record
Transaction box, and choose Record.

5. When you have completed the transactions you want to pay or delete, choose Close to return to the 
General Advice box.



Getting Advice

The Advisor monitors your buttons, registers, transactions, and other financial data.    At certain points, it 
offers financial advice for your particular situation.    Advice may be on checking accounts, budgeting, 
credit cards, mortgages, investments, or other subjects.      (See Advice Conditions.)    When the Advisor 
has advice for you, it displays a one-line message describing the advice in the General Advice box.

To receive advice from the Advisor:

1. Click on the Advice button to display the General Advice box.
2. In the General Advice box, choose a description other than the Scheduled Transactions item, and 

click on Advice (or double-click on the message).    A message box appears explaining the nature of 
the problem and offering a solution or solutions. 

You can use the Advice message box the same way you use the online Help.    Use the File menu to print 
the advice message.    Use the Contents and Search buttons to explore other tips from the Advisor.    For 
information about using Help, select the Help menu from a Help window.



Advice Conditions

The Advisor notifies you only if something happens in the environment you happen to be in.    For 
instance, if you are in the Checkbook, the Advisor responds to information entered into a checking 
transaction.    The Advisor in the Register responds to events there.    The Advisor watches all of your 
income and expense transactions.    The main window Advisor button lets you access all advice, but it 
signals you only when something happens on button setup or for messages on first entering the program, 
such as scheduled payments coming due.    Events that can activate the Advisor include:

· Entering or exiting a register, the Checkbook, or a transaction box for a particular account when 
conditions in that account warrant a message.

· Recording, modifying, or deleting a transaction (for example, the amount might be excessively large, 
given the history of payments to that payee).

· Creating a button on the main window for the first time.
· Entering or exiting the program when conditions warrant a message.
· Scheduled or recurring transactions coming due.

When the Advisor detects a certain situation within the current finance group, the Advisor icon animates 
and you hear a distinctive tune (if the Audio option is on).    

The Advisor continues to alert you until you view the Advisor list.    The main window Advisor is also quiet 
if the only messages involve scheduled and recurring transactions.    You can choose to disable the 
Advisor completely through the General Settings option in the System menu.    See System Settings.



Using Reminders

CA-Simply Money provides several reminder settings that let you control the Advisor to a 
certain extent, as well as make sure your financial data is backed up when you exit.    To set 
reminders:
1. From the System menu, choose Settings, then Reminders.    The Reminder Settings box appears.
2. All reminders are on by default.    Click to clear a reminder and turn it off.    Each reminder is 

described below.

Run CA-Simply Money Alert when Windows Starts.  Alerts you to Action Items when you first open 
Windows, before CA-Simply Money is started.    See CA-Simply Money Alert.    Deselect this item to turn 
Alert off.

Backup Finance Group.    Reminds you to back up your finance group to disk (in a location separate 
from the CA-Simply Money data files) each time you exit CA-Simply Money.    See Backup.

Unprinted Checks.    Tells the Advisor to remind you that you have written but not printed checks.    The 
message is removed from the Action Items list when you print checks.

Postdated Checks.  Tells the Advisor to notify you that pending checks are postdated.    The message is 
removed from the Action Items list when you print checks.

Scan for Recurring Transactions.    Tells the Advisor to look for recurring transactions and notify you 
when they may be due.    Each recurring transaction is removed from the Action Items list as you act on it 
or skip it.

Notification Level.      Raises or lowers the number of transactions needed before the Advisor displays a 
recurring transaction message.    Move the slider toward High if you want a high degree of sensitivity to 
catch any recurring transactions.    Move the slider toward Low if you want only transactions that have 
occurred many times. 

Scheduled Transactions.    Tells the Advisor to list all scheduled transactions in the Action List and notify 
you when they are due.    See The Scheduler.    

Number of Days in Advance to Give Reminders.      Lets you specify the timer for when the Advisor is to
begin alerting you about scheduled transactions. 



CA-Simply Money Alert

The CA-Simply Money Alert monitoring utility alerts you to scheduled actions and other action items when
you first open Windows, before starting CA-Simply Money.    CA-Simply Money Alert checks to see if any 
actions require your attention.    If there are Action Items, you can jump directly to CA-Simply Money to 
view them and act on them.

Action Items are transactions you have scheduled or transactions recognized as recurring. 

To complete Action Items from CA-Simply Money Alert:
1. In the Alert box, click OK.    You get the Action Items box.
2. View the Action Items then click Start CA-SM to go directly to the program.    In CA-Simply Money, 

the Action Items are redisplayed and you can act on them.

To turn off CA-Simply Money Alert:
1. Pull down the System menu and select Settings, then Reminders.
2. Click to deselect Run CA-Simply Money Alert when Windows Starts.    Alert is on by default.

Related Topics:
Completing Action Items
The Advisor
The Scheduler



Modem Stock Price Updates

CA-Simply Money makes it easy to update the prices of your securities.    All you need is a modem and 
software.    

The prices are transmitted from the CompuServe information service.    You do not need a CompuServe 
account, because you can use the Kiplinger's CA-Simply Money Stock Quote Service, which provides 
900-number access to a special CompuServe area.    The charge of $1.00 per minute (subject to change) 
is added to your telephone bill.    The updating is very fast, usually only a minute or two.    The exact length
of time depends on the number of quotes you request.

Of course, if you have your own CompuServe account, you can use it instead of the 900 service.    If you 
would like details about joining CompuServe, see the CompuServe information included in your CA-
Simply Money package.

CA-Simply Money uses "Basic Quotes" stock prices, which are included in CompuServe's basic monthly 
subscription.    You can retrieve prices for any security or mutual fund listed by CompuServe.

Note:    Stock quotes are delayed by at least fifteen minutes from current prices on the stock exchange.

Here is the procedure for updating prices.    You need to perform the first two steps only once:

1. Prepare the securities you want to update.    See Setting up Securities for Price Updating.
2. Set up your modem.    See Setting Up Your Modem.
3. Update the prices.    See Updating Prices.

Note:    Use of the Kiplinger's CA-Simply Money Stock Quote Service is subject to the CompuServe 
Service Agreement Terms found in the Kiplinger's CA-Simply Money User Guide.

Related Topics:
Setting Up Securities for Price Updating
Setting Up Your Modem
Updating Prices
Viewing Security Price History



Setting Up Securities for Price Updating

Before you can update security prices by modem, you must have the securities set up in your investment 
portfolios (accounts).    The securities must be active and flagged for updating.    Once you have flagged a 
security for updating, you can update the price at any time.    For more information on setting up 
securities, see Setting Up an Investment Account.

For your convenience, the ticker symbols for the Dow Jones Industrial Average and the S&P 500 are set 
up in CA-Simply Money.    You can update these averages by modem at the same time you update stock 
prices.    Use the following procedure to prepare them for updating by modem.

You need to perform this setup procedure only once.

1. From the Edit menu, choose Investments, then Securities.    
The Edit Security box appears.    

2. Type the name of the security in the Name box.    The Browser appears.    
Select an existing security or add a new one.    If you are adding a new security, be sure to enter all 
appropriate information.    You must include the security symbol.    
Note:    If you need to look up the ticker symbol, refer to the Wall Street Journal or Investor's 
Business Daily.    You can also find the ticker symbol on CompuServe by typing GO LOOKUP.    For 
mutual fund ticker symbols, call the mutual fund.

3. Select Update Price by Modem. 
4. Make sure Active is selected.
5. Click Save to save changes for this security.    
6. Click Close to leave the Edit Security box.    

Related Topic:
Modem Stock Price Updates



Setting Up Your Modem

Before you can update stock prices by modem, you must specify the information for communication.    You
need to perform this setup procedure only once. 

You can set your modem to access CompuServe with either:

· the Kiplinger's CA-Simply Money Stock Quote Service.    This 900-number service costs $1.00 per 
minute (subject to change), and is added to your telephone bill.

· your own CompuServe account, if you have one
Note:    Use of the Kiplinger's CA-Simply Money Stock Quote Service is subject to the CompuServe 
Service Agreement Terms found in the Kiplinger's CA-Simply Money User Guide.

You need to perform this procedure only once.

1. From the System menu, select Settings, then Modem.    The Modem Settings box appears.    
2. If you are using the 900 service, make sure the check box next to "Use CA-Simply Money Stock 

Quote Service" is selected.
If you are using your own CompuServe account, type your access information:    the local 
CompuServe phone number, your User ID, and your password.    Note that the password shows as 
asterisks, so make sure you type it correctly.

3. From the Baud Rate list, select the speed of your modem.    The default is 2400 baud.    Other options
are 1200 and 9600.
Note:    If you are using the Kiplinger's CA-Simply Money Stock Quote Service, 9600 baud is not 
available.

4. From the COM Port box, select the communications port    to which your modem is connected.    The 
default is COM1.    Other options are COM2, COM3, and COM4.

5. If you need to access an outside line, or temporarily disable call waiting, click on Advanced.    Another
dialog box appears.    In the Dial Prefix box, type the following at the end of the dial prefix:
· "9," if you need to dial 9 to get an outside line.    For example, the default dial prefix ATDT would 

become ATDT9,. 
· "*70" for tone phones or "1170" for pulse phones to disable call waiting for the current call (for 

example, ATDT9,*70).    If you have call waiting, an incoming call would disrupt the transmission 
of information.    The prefixes *70 and 1170 work in most areas.    If they do not work for you, 
consult your local telephone company for more information. 

You can also change other modem commands from the Advanced Modem Options dialog box.    For 
information about these other modem commands, consult your modem user's guide.

6. If you are using the 900 service, and your telephone system does not require you to dial "1" before a 
long-distance number, clear the 1 from the 900 # Long Distance Prefix area.

7. Click on OK to save the settings.    Your modem setup is now complete.

Related Topic:
Modem Stock Price Updates



Updating Prices

Before updating stock prices, make sure your modem and securities are set up properly (see the Related 
Topics below).    You need to set them up only once; from then on you can update security prices as often 
as you like.

The updated stock prices come from the CompuServe information service.    You can access 
CompuServe through the Kiplinger's CA-Simply Money Stock Quote Service (a 900 number), or you can 
use your own CompuServe account, if you have one.

Note:    Use of the Kiplinger's CA-Simply Money Stock Quote Service is subject to the CompuServe 
Service Agreement Terms found in the Kiplinger's CA-Simply Money User Guide.

CA-Simply Money can store up to one price a day for each security in its price history database.    The 
current price is used to calculate the current value of shares you own or sold short.

To update stock prices:

1. From the Operations menu, select Stock Price Update.    
CA-Simply Money logs on to CompuServe, gets the current price(s), and logs off.    A 
message tells you when the price updating is complete.    Updated prices are stored 
offline in a box that you can scroll.
Note:    If you are using the Kiplinger's CA-Simply Money Stock Quote Service, and you 
get a disconnect tone or a recording, make sure 900 numbers have not been suppressed
from your phone service.

2. Click OK.    CA-Simply Money displays a dialog box asking whether you want to update the prices in 
your price history database.    

3. Choose Yes to update the prices, No to leave the price update program without updating the 
database, and Cancel to look at the prices again. 

Related Topics:
Setting Up Securities for Price Updating
Setting Up Your Modem
Viewing Security Price History



Viewing Security Price History

CA-Simply Money stores current and historical stock prices so you can assess the performance of your 
portfolio.    By opening certain windows or generating specific reports and graphs, you can see how well 
your investments are doing.

Reports and graphs base portfolio performance or value on the current security price, which is the last 
price recorded either automatically or manually.    CA-Simply Money assumes that all unsold shares were 
sold on the last day shown on the report.    For complete information on CA-Simply Money calculations, 
see Calculating Security Performance.    

To view security prices and assess the performance of your investments, display one of the following 
windows:    

· Edit Security box.  This box shows the current stock price.    You can scroll through each security, 
and click Price History to get a price history for each security.    To display the Edit Security box, pull 
down the Edit menu, choose Investments, then Securities.

· Investment account register.    The register lists the date and price at the time of each transaction 
in the investment portfolio.    To display the register, drag the button for the investment account to the 
Register button.

· Security List Report.    This report shows the current price of each security.    To display the Security 
List Report, click on the Reports button and select Investment Reports.

· Security Price History Report.    This report shows the price history of each security.    To display 
the Security Price History Report, click on the Reports button and select Investment Reports. 

Related Topics:
Modem Stock Price Updates
Recording Security Price History



The Find Feature

If you need to find a specific transaction, use the Find feature.    You can search for transactions by using 
a combination of several criteria.

Selection criteria include:

· Date ranges
· Specific accounts
· Specific Payees/Payors
· Memo text
· Dollar amounts
· Transfer methods
· Cleared transactions

The more explicit the selection, the fewer transactions you will have to wade through to find the desired 
transaction.    CA-Simply Money selects only the transactions that meet all of the criteria.

Related Topics:
Finding a Transaction
Specifying Find Criteria



Finding a Transaction

To find a transaction:

1. Click on the Find button.    The Find Transactions box appears.    Other ways to display this box are:
· From the Tools menu, choose Find.      
· Drag the Find button to the button of the account, income source, or payee for which you want 

to find a transaction.    This opens the Find Transaction box with the Account or Payor/Payee 
name already entered.

2. In the Find Transactions box, type or select the criteria you want to use to narrow your search.    See 
Specifying Find Criteria.

3. Choose Find to search for all the transactions that match your criteria.    If there is a match, the 
information for the first transaction appears in the text box, and a message above the box tells you 
how many transactions were found.

4. If there is more than one transaction, click on the Next and Prev buttons to scroll forward and back 
through the list of transactions.
Once you have located the transaction you are looking for, you can jump right to the 
register entry of the transaction.    Once in the register, you can modify or delete the 
transaction.

5. Click on Register to display the register entry of the currently displayed transaction.

Related Topic:
Specifying Find Criteria



Specifying Find Criteria

In the Find Transactions box you can specify several criteria to find transactions.    Use one or more of the
following fields to help you narrow down the list.

Date(s).    Specify a range of dates or use the default range.

Account.    Specify an account by name. 

Payee/Payor.    Specify a payee, account, or income source.    

Memo.    Specify all or part of a memo related to one or more transactions.    To search for an entire memo
exactly as you typed it, click on Exact.

Amount.    Specify dollar amounts.

Type an amount, then choose one of these operators: 

= finds the exact amount
<= finds any amount less than or equal to that number
>= finds any amount greater than or equal to that number

Via.    Specify a transfer method.    Click on the down arrow to display a list of selections.

Cleared Only.    Specify only transactions that have been cleared through account balancing.



Exporting and Importing Data

CA-Simply Money makes it easy to export and import transactions among QIF-compatible (Quicken 
Interchange Format), MXF-compatible (CA-Simply Money Exchange Format), and TXF-compatible (Tax 
Exchange Format) programs.    You can also import data from BillPay USA with the BMF format.

Related Topics:
QIF Files
MXF Files
TXF Files
BMF Files
Exporting Data
Exporting to Tax Programs
Merging Finance Groups
Importing Data



QIF Files

Most financial software applications, including CA-Simply Money, support QIF (Quicken Interchange 
Format) for transferring data to other applications.    QIF uses special characters to identify transactions in
a text file.

Note:    QIF is provided so that you can send data to other programs, however, due to limitations in the 
format, not all of the data you may have in CA-Simply Money can be transferred with QIF.    Some 
mortgage information, program customization information, and stock price histories will be lost.    You 
should use TXF only for exporting data to tax programs, and QIF only when sending data to or from other 
programs.    Use MXF whenever possible.

Exporting and importing with QIF files is useful for:

· Moving data to other financial programs.
· Adding transactions from Quicken or other programs.

Related Topic:
Exporting and Importing Data



MXF Files

Exporting to MXF produces a text file that includes all the extended information in CA-Simply Money.    
MXF exports everything except Advice History comments.    

Exporting and importing MXF text is useful for:

· Exporting entire finance groups between CA-Simply Money programs.
· Moving data between different CA-Simply Money database file formats.
· Merging income from two or more finance groups.
· Merging portions of finance groups.
· Archiving data in a format you can read as text.
· Transferring a large number of transactions from one account to another.    If you entered 

transactions in the wrong account, you could export the transactions out of the account and import 
them back to the proper account.

Note:  You can obtain detailed technical specifications for MXF from CA customer support.

Related Topic:
Handling MXF Export Problems
Exporting and Importing Data



Handling MXF Export Problems

If a problem occurs when you export to an MXF file, you can choose to view the error or warning.    These 
are the messages you may see, followed by explanations and suggested solutions:

Category does not have a valid type.    The category is not one of these valid types:    income, expense, 
asset, liability, equity.    Edit the MXF file to give the category a valid type.    

Invalid date.    A date is not correct.    Edit the finance group, then export the data again.    Or edit the MXF
file.    

Unknown reference type in field X.    A field contains a reference to something that does not exist.    Edit 
the finance group, then export the data again.    Or edit the MXF file.    

Reference in field X not found.    A field contains a reference to something that does not exist.    Edit the 
finance group, then export the data again.    Or edit the MXF file.    

Reference to nonexistent button.    A field contains a reference to something that does not exist.    Edit 
the finance group, then export the data again.    Or edit the MXF file.    

Database error - invalid ID ref.    A field contains a reference to something that does not exist.    Edit the 
finance group, then export the data again.    Or edit the MXF file.    

WARNING - INVALID <Field Name> <Value>.    A field contains an invalid value.    Restoring the MXF file
will set the field back to a default value and fix the problem.



TXF Files

CA-Simply Money lets you export to the TXF file format.

The TXF file format is used by many specialized tax programs.    Once you've assigned Tax Codes to your
categories, and categorized your financial transactions, CA-Simply Money has most of the information 
needed for your tax returns.      The TXF file format exports this information to your tax software.    See 
Exporting to Tax Programs for details. 

Related Topic:
Exporting Data



BMF Files

CA-Simply Money allows you to pay your bills electronically through Prodigy and BillPay USA.    BillPay 
USA keeps a record of all payments you've made.    You can export a BillPay USA report to the BMF file 
format, and then import the BMF file to CA-Simply Money to update your accounts.    See Importing 
BillPay USA Records.



Exporting Data

CA-Simply Money provides several options for exporting data.    When exporting to QIF, you can include 
or exclude transactions in certain categories, making it easy to work with specific data.    This feature is 
not available in many financial programs.    You may also filter transactions in either QIF or MXF by 
selecting a date range.    

Another way to export data is to print a report to disk.    See Exporting a Report to Another Program.    

For exporting data to tax programs, see Exporting to Tax Programs.

To export data:

1. From the File menu, choose Export.    The Export Data box appears.    
2. In the File Name box, type a name and an (optional) extension for the exported data file, or use the 

Browse button.    CA-Simply Money does not automatically assign an extension.
3. Click the Dates button and select a date range, or type starting and ending dates for the transactions 

you want to export.    All the transactions in that date range are exported.
4. If you are exporting to QIF, click the Include button to specify which transactions to include in the 

export.    See Including and Excluding Information.
Note:    When exporting to a QIF file, do it one account at a time.

5. Choose Export options.    See Setting Export Options 
6. Choose a Compatibility option.    See Setting Compatibility Options.
7. Click on OK to export the file.

During an export to an MXF file, a progress meter shows the percentage completed of 
the current portion of the Finance Group.    When exports to MXF or QIF are complete, a 
message appears.    You can then access the file from your application software.

8. If there are any problems during the export, you have the option of reviewing messages about them 
after the export is complete.    For MXF exports, these messages are duplicated as comments in the 
export file to help you find and fix the problems.

Related Topics:
Setting Export Options
Setting Compatibility Options
Including and Excluding Information
Exporting to QIF:    An Example
Exporting to Tax Programs
Handling MXF Export Problems



Setting Export Options

Click to select or deselect Export Options in the Export Data box:
Transactions.    Transactions are exported by default.    Transactions are any activity between accounts, 
income, and payees.    Deselect this item only if you want to limit the export exclusively to one or more 
items below.

Account List.    Exports the account list.    If you are exporting to QIF, you can export multiple accounts 
into one file.      

Categories and Classes.    Exports a list of categories and classes.

Scheduled Transactions.    Exports all scheduled transactions.



Setting Compatibility Options

Click to select one of these formats in the Export Data box:
Strict QIF.    Quicken-compatible format.    This is most useful if you plan to import the data into a Quicken 
version earlier than 5.0.    The export file includes no investment accounts and only one account from the 
Include list.    For more on the QIF format, see QIF Files

Extended QIF.    This is more useful for recent versions of Quicken.    You can export an Account List of 
multiple accounts using this format.

MXF.    CA-Simply Money Exchange Format.    Includes groups and icons; the most complete 
export/import option for CA-Simply Money.    For more on the MXF format, see MXF Files.    

Note:  To export to TXF format, select Tax Export from the File menu.    See Exporting to Tax Programs.



Exporting to Tax Programs

Before you export data for use with a tax program, make sure you have done the following:

· Use Tax Related categories for your distributions.
· Assign a tax code to each of the tax-related categories you use.    See Editing Categories.    The Tax 

Codes are grouped by tax form and listed alphabetically within each tax form.    See Modifying a 
Category, to modify an existing category.

To export information to a tax program:

1. From the File menu, choose Tax Export.    
The Tax Export box appears.    

2. Type a file name.    Use the Browse button to set the drive and path.    Be sure to add the filename 
extension .TXF.    If you don't specify another path the file will be exported to the S-MONEY directory 
where CA-Simply Money was installed.

3. Change the Date Range by typing new starting and ending dates, or click Dates and choose a range 
from the list that appears.    The default range is the year to date.    

4. Click OK to export the file to the specified directory.
5. To use the TXF file with a tax program, follow that program's procedures for importing data.

Related Topic:
TXF Files



Merging Finance Groups

You may find it necessary to move transactions from one finance group to another.    For example, you 
might decide that transactions involving auto maintenance should be in business transactions, instead of 
personal transactions, because you use your car in running your business.    To make the switch between 
Finance Groups, use the Import and Export options.

To merge two finance groups:

1. Export the appropriate data to an MXF file.    See Exporting Data.
2. Open the finance group into which you want the transactions merged.
3. From the File menu, select Import.    The Import Browse box appears. 
4. Select the MXF file you exported in step 1.
5. In the MXF Import box, choose whether to add the imported information to the open finance group or 

to restore the imported information as another finance group.    See Importing an MXF File.
6. Click on OK to import the file.



Exporting to QIF:    An Example

Example:    You want to export all of the transactions for Barton's Pharmacy and Albert's Food to a QIF 
file.    

1. From the File menu, choose Export.
2. In the Export Data box, enter a file name with a .QIF extension.    Choose a path using the Browse 

button, if you wish.
3. Select dates.    Since you want all transactions, choose a starting date on or before the date you 

began recording transactions for the two payees.
4. Choose the Strict or Extended QIF format.    See QIF Files for help in choosing the format.
5. Click Include to limit the export to the two payees.    
6. In the Export Include box, choose Payees, then Deselect All.    Click to highlight Barton's and Albert's 

in the Payee list.
7. Click OK to accept your selection, and OK again to begin the export.



Importing Data

CA-Simply Money lets you import data to combine with an existing finance group, or to add to a new 
finance group.    You can import these types of files:

QIF Files
MXF Files
BMF Files

To import files:
1. From the File menu, select Import.    The Import Browse box appears.    
2. From the List Files of Type box, select a file type to display:    Quicken (*.QIF), CA-Simply Money 

(*.MXF), BillPay USA (*.BMF), or all files.
3. Select from Drives or Directories to change the path, if necessary.
4. Select the file you wish to import from the File List.
5. Click OK.    A dialog box appears prompting for more information about the import.    Click on the 

Related Topics below for information on importing the different file types.

Related Topics:
Importing a QIF File
Importing an MXF File
Importing BillPay USA Records
Importing Other Files



Importing an MXF File

When you select an MXF file from the Import Browse box, you get the MXF Import dialog box.    This box 
gives you the following choices:

Add to Current Finance Group.    Choose this button to combine the MXF file data with your current 
finance group.    This would be your choice if you wish to merge information from another finance group 
into the current finance group.    If you wish to change the name of the finance group, choose File and 
Change name.

Restore original Finance Group from file.    Choose this button to bring the data from file into a new 
finance group.    The original finance group name is used.    This would be your choice if you wish to move 
a finance group from one CA-Simply Money installation to another.    

Click OK to begin importing the file. A meter showing the import's progress appears.    If you need to halt 
the import, click on Cancel.

Related Topic:
Handling MXF Import Problems



Handling MXF Import Problems

If a problem occurs when you import an MXF file, you can choose to view the error or 
warning.    
1. In the error or warning box, click Yes.    A window displays each error or warning message under the 

label Problems.
2. Click on a problem to see the actual code in the file that caused the message to appear.    
3. Fix the problem by following the instructions for the specific message.    To see the messages and 

suggested solutions, refer to the Kiplinger's CA-Simply Money User Guide.



Importing a QIF File

When you select a QIF file from the Import Browse box, you get the QIF Import box.    This box gives you 
the following choices:

Import to Account.    Type the name of the CA-Simply Money account the imported 
transactions should go into, if the QIF file does not specify an account.    (Quicken for 
Windows and Quicken version 4 do not specify accounts.)    Normally you export Quicken 
transactions one account at a time.    CA-Simply Money prompts you every time it encounters
a possible account and/or new category.    This allows you to control how accounts and 
categories are added to the finance group.    See Importing Unknown QIF Accounts and 
Categories.
Match other side of transfers.    Select this option to eliminate duplicated transfer 
transactions between accounts.    Duplicates may occur when you import multiple accounts 
with transfers to CA-Simply Money.    Click this box to turn this feature on or off.    
If the file contains transfers, make sure you use the name of the account whose transactions
you are importing in the Import to Account box.    This ensures that transfers are imported 
correctly.
Automatically create referenced accounts.    Select this option to create automatically 
any accounts referenced in the imported transactions.    Use this option only if you are 
importing checking account information.    Do not use it for account types other than 
checking. 
Click on OK to begin importing the file.    

Related Topics:
Merging Payees into One Button
Importing Unknown QIF Accounts and Categories
Handling QIF Import Problems



Handling QIF Import Problems

Usually an import proceeds to completion without any complications.    However, the imported data might 
include a category or account that is not used in the current finance group.    When this happens, CA-
Simply Money prompts you to indicate whether it should create the account or category.    You can also 
specify the category type, which may not exist in the QIF file.

1. If you want to stop the import, click on the Cancel button.
If you want CA-Simply Money to use the Miscellaneous category instead of creating a new one, click 
on the Skip button.
Otherwise, if you want CA-Simply Money to create the account or category, go on to steps 2 through 
4.

2. Select the category type:    Expense, Income, Asset, or Liability.
3. If you do not want CA-Simply Money to prompt you the next time it encounters a new account or 

category, select Automatically create categories.
4. Click on OK to proceed with the import.



Importing Unknown QIF Accounts and Categories

When CA-Simply Money encounters a category in a QIF file that is not in the current finance group, it 
assumes the category should be either a new account or a new category, and it specifies a type 
(Expense, Income, Asset, Liability).    For example, CA-Simply Money assumes the category "Salary" 
should be imported as an Income button.    

If you did not select "Automatically create referenced accounts" in the QIF Import box, CA-Simply Money 
prompts you to verify, change, or cancel the creation of each new category or account.    

1. The box contains three radio buttons.    Select one of these:
Auto create.    Choose this to continue the import without being interrupted by these 
Import boxes.    CA-Simply Money will create categories and accounts automatically as it 
sees fit.
Never create.    Choose this if you do not want to create any new categories or 
accounts.
Ask for each.    Choose this to continue the prompting at each unrecognized category 
in the QIF file.

2. To continue, click on one of the following buttons at the bottom of the box:    
Yes.    Go ahead and create the new category or account.    You get the standard CA-
Simply Money category or account setup box.    After the new category or account is set 
up, the import continues.
No.  Do not create the new category or account.    Assign the transaction to a 
miscellaneous category.
Cancel.    Stop the import.



Importing BillPay USA Records

BillPay USA allows you to pay your bills electronically, without writing or printing checks at all.    This 
service is available through Prodigy; see the Prodigy leaflet in your CA-Simply Money package for 
information about obtaining an account.    BillPay USA keeps a record of all payments you've made 
through it, and this record can be imported to CA-Simply Money to update your accounts automatically.

Note:    If you pay your bills through BillPay USA, make sure your credit card and mortgage are set up as 
payees rather than as accounts.

To import a payments report from BillPay USA:

1. In BillPay USA, export your records.    BillPay USA puts a copy of your payment records in a file 
named PAYMENT.BMF.    

2. In CA-Simply Money,    from the File menu, choose Import.    The Import Browse box appears.
3. In the List Files of Type box, choose the BillPay USA format, .BMF.    Select PAYMENT.BMF, then 

click OK.    The Import from File box for BMF files appears.
4. In the the Import to text box, type the name of the account the payments were made from.

Note:    Specify Match other side of transfers to prevent recording payments twice.    By default, BillPay 
USA exports your entire transaction history, so after the first import you import the same transactions 
again.    You can specify a date range for the export, but checking for duplicated transactions is a useful 
caution.    

5. Click OK to import the report.    CA-Simply Money records all the payments made through BillPay 
USA and adjusts your account balance accordingly.

Note:    Your imported records include only transactions that have actually been completed, not 
necessarily all the payments you've just told BillPay USA to make.    Completion is not immediate, but 
should take no more than a few days.



Importing Other Files

If the file selected does not have a .MXF, .QIF or .BMF extension, CA-Simply Money chooses the most 
likely type of file by looking at the contents.    If the file has been edited, rename it with the correct 
extension.



The Calendar

CA-Simply Money makes it easy to consult a calendar and enter dates automatically into any date field.

To insert today's date:
1. Click on a date box and press F3.    Today's date is automatically entered in the field.    

To insert any calendar date:
1. Click on a date box and press F4.    A calendar appears.
2. Click on a date, then click OK.    The date is automatically inserted into the date field.

· Click on the scroll bar arrows to change the month.
· Click on the scroll bar to change the year.



The Notes Feature

Use the Notes feature to record notes to yourself about a specific transaction.    You can add, edit, or view 
notes in the Register, the Checkbook, and in many transaction dialog boxes.    Notes are just like memos, 
only they can accept more text and they are private.    Your notes do not appear on any checks or reports.

You can use notes to:

· Document circumstances or conditions at the time of payment, such as a salesclerk's name or 
information given at the time of purchase.

· Remind yourself what a payment was for.
· Give reasons for unusually high or low payments (as in monthly utilities during unusual weather).
· Record any information you want regarding a payment.

You can make a note at any time during or after completion of a transaction.    When a note is recorded 
with a transaction, it is "attached" to that transaction, just like any other transaction information.    To view 
a note, select the transaction line and click on the Notes button.

Example:    If you dispute a charge on a credit card bill, you can make a note to yourself that the payment
does not include the amount of the disputed item and to look for credit on the next bill.    Additionally, you 
could schedule a memo so that you remember to check the bill when it arrives (see Scheduling a Memo 
Reminder).

Related Topic:
Creating and Editing a Transaction Note



Creating and Editing a Transaction Note

To make notes on a transaction:

1. In a Register or the Checkbook, click on a transaction line to begin a transaction or select a 
completed transaction.

2. At the bottom of the window, click on the Notes button.    The Notes box appears.    If a note has 
already been recorded with this transaction, it appears in the Note box.    You can drag the edges of 
the box to a more readable width and height.

3. Type your note regarding the transaction, or make changes to the existing note.
4. Close the Notes window to make any further entries for this transaction. 
5. Click Record to save the note with the transaction and return to the Register.    Clicking Record 

closes the Notes window if it is still open.

Note:    If the Confirm Cancel option is turned on (see System Settings) when you close the note and 
leave the transaction without recording the note, CA-Simply Money asks if you want to "Save this Entry?" 
and it reiterates the transaction information.    Choose OK to save the note.    



Browse Files

When you open or save a file in CA-Simply Money (during an import, export, etc.) you can browse your 
drives and directories to make sure you get or save the correct file.    The Browse file box includes the 
following:

Filename:  Type the name of the file, if you know it.    Otherwise, select a name from the file list.

File Type:  Select to see a list of all files of a type.    *.* indicates all file types.    The files are displayed in 
the file lits.    

Directories and Drive:  Select a directory to view.    Change to a different drive, if necessary.

Click OK to select the file displayed in the file name box.



Other Options

Several CA-Simply Money options help you protect your data, customize the screen, use the Windows 
clipboard, take advantage of Dynamic Data Exchange (DDE), and order checks and other supplies.

Passwords
Backup
System Settings
Button Arrangement
Background Patterns
Ordering Supplies
Printer Setup
Copying and Pasting
Customizing Some Operations at Startup
Excel Applications



Passwords

CA-Simply Money provides you with the ability to prevent casual snooping into your financial affairs.    You
can use a password to protect any or all of your finance groups.    If you use CA-Simply Money at your 
job, you can assign security to your personal finances.

Please note that although the CA-Simply Money password is encrypted, it may not deter an experienced 
and determined snoop.    Also, the password protects only the currently displayed financial group.    If you 
want to protect more than one group, you must assign a password to each.    You can use the same 
password for each group if you like.

Caution:    It is imperative that you make a written note of your password, and keep it in a safe place.    If 
you forget your password, you will not be able to access your data.

Related Topics:
Creating a Password
Changing Your Password



Creating a Password

Caution:    It is imperative that you make a written note of your password, and keep it in a safe place.    If 
you forget your password, you will not be able to access your data.

To create a password:
1. From the System menu choose Settings, then Password.    The Password box appears.
2. In the New Password box, type the password.    An asterisk appears for each letter you type.
3. Click OK.    CA-Simply Money prompts you to type the password again to make sure you typed it 

correctly.
4. Type the password and click OK to record it.

You will now be required to type the password each time you open the current finance 
group. 

Related Topic:
Correcting Password Errors



Correcting Password Errors

When you get an error message while creating a password:

1. Try typing the password again.    If you get the error message again, choose Cancel to return to the 
Password box.

2. Delete the asterisks in the New Password box and repeat steps 2 through 4 of the 
previous procedure.

Note:    The security passwords are meant to prevent unwanted browsing of your finances by other 
people.    However, passwords are not necessarily protection against a determined effort by someone to 
gain access to your data.



Changing Your Password

Caution:    It is imperative that you make a written note of your password, and keep it in a safe place.    If 
you forget your password, you will not be able to access your data.

To change your password:

1. From the System/Settings menu, choose Password.    The Password box appears.
2. In the Original Password box, type the current password.    You see only asterisks.
3. In the New Password box, type the new password, then click OK.
4. Type the password again and click OK.    
Note:    You can remove password protection by leaving the New Password box empty and choosing OK. 
When prompted to type the password again, leave the box empty and click OK.    This eliminates any 
password associated with the finance group.



Backup

We strongly recommend that you back up your data on a regular basis.    This will protect you in the event 
of a hard disk failure or other calamity.    A good plan is to back up after each CA-Simply Money work 
session to a set of diskettes that you rotate regularly.    The built-in CA-Simply Money backup function 
makes it easy to back up, restore, and archive your data.

The Reminders feature has a default setting that reminds you to back up your finance groups each time 
you exit CA-Simply Money.    You can turn this reminder message off at any time.    See Using Reminders.

Related Topics:
Backing Up Data
Restoring Data
Archiving Data



Backing Up Data

When you backup your CA-Simply Money data, all information from a finance group is copied into a 
separate directory or disk.    You can make backups of a finance group as often as you wish.    Each new 
backup replaces the previous backup file.    If something happens to your original data, you can recover a 
backed-up finance group by using the Restore feature described in Restoring Data.

Note:    If you want to keep a copy of a finance group as of a certain date, use the Archive feature 
described in Archiving Data.

To back up finance group data, follow this procedure:

1. The first time you back up data, format a floppy disk and create a backup directory from the Windows
File Manager.    We recommend backing up to a floppy disk so that your data is protected if 
something happens to your hard disk.    

2. Return to CA-Simply Money and choose Backup from the File menu.    The Backup Finance Group 
box appears.    (CA-Simply Money Reminders also prompt you to back up data when you exit the 
program.)

3. In the Group Name box, specify the group you want to back up.
4. In the Directories box, choose a path for the backup.
5. Choose OK.    The Continue Backup box appears to verify backup of the named finance group to the 

named directory.    Choose OK.    If the specified directory does not yet exist, CA-Simply Money 
creates it.

6. If the data files already exist, CA-Simply Money asks if you want to overwrite the files or create a new
finance group.    Choose Overwrite Finance Group to overwrite.

7. When the backup is complete, a messages informs you that the backup is successful.    Choose OK 
to return to the main window.



Restoring Data

The Restore feature lets you copy backup finance groups to the main CA-Simply Money data directory.    
You may need to restore backup data if something happens to the disk containing the original data.    You 
may also find Restore useful for transferring data into a new finance group.

Note:    The Restore feature can only restore data that was backed up using the Backup feature.    Make 
frequent backups.    The data you restore is only as recent as the date of the last backup.

Related Topics:
Restoring to an Existing Finance Group
Restoring to a New Finance Group



Restoring to an Existing Finance Group

To restore data to an existing finance group:

1. From the File menu, choose Restore.    The Restore Finance Group box appears. 
2. In the Restore From box, type the path to the directory containing the backed up files.
3. Choose Find Groups.    All of the backed up groups in the specified directory appear.
4. From the Finance Groups box, choose the group whose data you want to restore to your hard disk.
5. Click on OK.    If the backup file you want to restore already exists, the Continue Restore box 

appears.
6. Make sure you have selected the right file to restore, then click on OK to continue.    The Restore box

appears.
7. Click on Overwrite Finance Group.    The backup copy of your data is copied over the current data in 

the specified finance group.
8. The Restore box appears when the operation is complete.    Choose OK to return to the main 

window.



Restoring to a New Finance Group

You may find the Restore feature useful for creating a copy of an existing finance group.    You could then 
use the new finance group for a different purpose.    The Archiving feature can be used for the same 
purpose. 

To restore data to a new finance group:

1. From the File menu, choose Restore.    The Restore Finance Group box appears. 
2. In the Restore From box, type the path to the directory containing the backed up files.
3. Choose Find Groups.    All of the backed up groups in the specified directory appear.
4. From the Finance Groups box, choose the group whose data you want to restore to your hard disk.
5. Click on OK.    If the backup file you want to restore already exists, the Continue Restore box 

appears.
6. Make sure you have selected the right file to restore, then click on OK to continue.    The Restore box

appears.
7. From the Restore box, click on Create New Finance Group.    The New Finance Group box appears.  
8. Type a name for the new finance group.    You can also type a comment to describe the new group.
9. Click on OK to continue.    A new finance group is created using the data from the backup copy you 

have chosen.



Archiving Data

Use the Archive feature to create an exact copy of your data as of a certain date.    This is useful if you 
want to keep copies of your finances at different points in time.    Archiving is different from a backup 
because you can have many different archived copies of the same finance group.    With a backup, you 
only have the latest copy of your data.    You can use Archive to:

· Close out your accounting for a year.    Make the end date of the archive the last day of the year in 
question, then select Remove Transactions.

· Archive your current data at the end of each month.    This gives you a "snapshot" of your finances at 
the time of the archive.    

· Fix mistakes.    If you find that you made a major error in the past, you could open an archived copy 
of the finance group from before the time of the error.    Then you would only have to add the 
transactions which were added since that archive.

· Remove transactions from a finance group for a certain period of time.
Once you archive a file, it becomes just another finance group.    You can open it, modify it, add 
transactions, and perform any other CA-Simply Money operations.

To archive a finance group:
1. From the File menu, choose Archive.    The Archive box appears.
2. You can choose to archive a range of data by typing a date in the End Date box.    The default is 

today's date.    All transactions on or before the end date are archived.    
3. Choose OK.    CA-Simply Money creates a copy of the specified finance group in the \S-MONEY\

DATA directory.
The Archive box appears to tell you the Archive was successful.

4. Choose OK to return to the main window.

Related Topics:
Renaming or Deleting an Archived Group
Removing Transactions During an Archive



Renaming or Deleting an Archived Group

Renaming an Archived Group
An archived finance group retains the same name as the original group.    You may want to rename either 
the original group or the archived group by using the File/Change Name command.    See Modifying a 
Finance Group.    You can also use the Comment to distinguish archived groups.    The comment for all 
archived files shows the date the archive was created.

Deleting an Archived Group
You can delete archived finance groups the same way you delete other finance groups, using the 
File/Delete command.    See Deleting a Finance Group.



Removing Transactions During an Archive

You can remove transactions from a finance group during an Archive procedure.    This is useful at the end
of the year for storing past transactions and continuing with only transactions from the beginning of the 
new year.    By choosing Remove Transactions, you delete all transactions occurring on or before the End 
Date.    Your archived copy contains all transactions; your current finance group contains transactions 
beginning at the End Date. 

To delete transactions using Archive:

1. From the File menu, choose Archive.    The Archive box appears.
2. Type a date in the End Date box.    
3. In the Archive of Finance Group box, click on the Remove Transactions box.
4. Choose OK to make an archive copy of the finance group and to delete all data before the End Date 

from the original group.



System Settings

The System menu option Settings provides many choices for making CA-Simply Money look and act as 
you wish.    

To change system settings:

1. From the System menu, choose Settings, then General.    The General Settings box appears.    
The CA-Simply Money settings are grouped into three categories:    Main, Financial 
Advisor, and Transactions.    Click on the topics below for more information.

2. Choose any or all of the settings, then click on OK.

Related Topics:
Main Settings
Financial Advisor Settings
Transaction Settings



Main Settings

When you choose System/Settings/General to display the General Settings box, you can 
choose among the following Main settings.    Click to turn each on or off.
Audio On.  Set Audio On to hear a beep upon completion of every transaction, including setting up and 
modifying accounts, income sources, and payees.    A brief tune plays when the Advisor has a message 
and when you delete transactions, buttons, and Advisor messages.    (Default is On.)

Drag & Drop Info On. Turn this on to display descriptive text in the Help line at the bottom of the program
window.      The text is related to the position of the mouse cursor over buttons or menu items.    (Default is 
On.)

Auto Payee Setup.    Turn this option on to add a new payee without using the Payee Setup-Add box.    
This box normally appears when you write a check or record payment in the register to a new payee.    
This option adds the new payee automatically with a hidden payee button.    You are not prompted for 
additional information.    (Default is Off.)

Newcomer Hints.    Turn this option on to display a window of help text every time you encounter 
significant program features.    The Newcomer Hints aid in the proper use of the features.    (Default is On.)

Auto Button Layout.    Turn this option on to let CA-Simply Money arrange buttons on the main window 
according to which are most used.    Turn this option off to arrange buttons yourself.    For more 
information, see Button Arrangement.    (Default is On.)



Financial Advisor Settings

When you choose System/Settings/General to display the General Settings box, you can 
choose among the following Financial Advisor settings.    Click to turn each on or off.
Active.    Turn this option on to receive Advisor messages at any time by clicking on the Advisor button.    
When information is available, the Advisor icon animates to give you a visual indication that you have a 
message.    When you turn this option off, the Advisor does not analyze your data, and the icon does not 
animate.    (Default is On.)

Popup Messages.    Turn this option on to see Advisor messages as they are triggered in popup boxes.    
Simply click on the popup box to close it.    Turn this off to suppress the popup boxes.    You can still view 
Advisor messages by clicking on the Advise button.    (Default is On.)



Transaction Settings

When you choose System/Settings/General to display the General Settings box, you can 
choose among the following Transaction settings.    Click to turn each on or off.
Confirm Cancel.    Turn this on to be prompted to save changes when you attempt to exit from a modified
transaction without choosing Record.    If Confirm Cancel is turned off, the transaction is canceled 
automatically.    (Default is On.)

Warn on Blank Payees.    Turn this on to pop up a warning box if a payment transaction is entered with 
no payee.    (Default is On.)

Require Categories.    Turn this option on to receive a message when you record a transaction without 
providing a category.    (Default is Off.)



Customizing Some Operations at Startup

By taking advantage of some features of the Windows Program Manager, you can do the following when 
you activate CA-Simply Money:

· open a specific finance group
· control some operations of the registers and the checkbook
To affect only the CA-Simply Money session you are about to start, use the Windows Run command.    To 
affect every session, change the Program Manager command line.    

Related Topics:
Using     the     Windows Run Command  
Changing the Program Manager Command Line



Using the Windows Run Command 

By starting CA-Simply Money with the Windows Run command, you can open a specific finance group 
and/or control some operations of the registers and the checkbook.    

1. Select Run from the File menu on the Windows Program Manager window.    A dialog box appears.
2. Click on the Browse button.    Another dialog box appears.
3. Select the directory containing the CA-Simply Money files (usually S-MONEY), then double click on 

CASMMAIN.EXE.    The first dialog box reappears, with CASMMAIN.EXE and its path in the 
Command Line text box.

4. Type one or more of the run time codes (-k, -r, -c, "finance group"), leaving a space before and after 
them.    
Here are examples.    The lowercase letters are the ones you type:
C:\S-MONEY\CASMMAIN.EXE -k "my finances"
C:\S-MONEY\CASMMAIN.EXE personal -c

5. Click on OK.    CA-Simply Money starts.

Related Topics:
Customizing Some Operations at Startup
Run Time Codes



Changing the Program Manager Command Line

By changing the command line in the Program Manager, you can open a specific finance group and/or 
control some operations of the registers and the checkbook.

If you have several finance groups, you can make each one appear with a separate icon in the Program 
Manager.    This enables you to start CA-Simply Money with the finance group of your choice.    To do this, 
you copy the CA-Simply Money icon several times, then assign each icon to a finance group.

To copy the icon:
Follow this procedure if you want to assign an icon to each finance group.    Otherwise, skip ahead to the 
next procedure, "To change the command line."

1. In Program Manager, click once on the CA-Simply Money icon.
2. From the File menu, choose Copy.    The Copy Program Item box appears.    
3. From the To group drop-down list box, select the program group you want the icon copied to (usually 

the group the icon is copied from).
4. Click OK, and follow the next procedure.

To change the command line:
1. In Program Manager, click once on the CA-Simply Money icon.
2. From the File menu, choose Properties.    The Program Item Properties box appears.    
3. At the end of the command line, add one or more of the run time codes (-k, -r, -c, finance group), 

leaving a space before and after them.    
Here are examples.    The lowercase letters are the ones you type:
C:\S-MONEY\CASMMAIN.EXE -k "my finances"
C:\S-MONEY\CASMMAIN.EXE personal -c

4. Click OK.
5. If you copied icons, repeat steps 1 - 4 for each icon.

Related Topics:
Customizing Some Operations at Startup
Run Time Codes



Run Time Codes

By using these codes when you activate CA-Simply Money, you can open a specific finance group and/or 
control some operations of the checkbook and registers:

-k This "keep position" switch affects the behavior of the Register button in the checkbook and in 
account transaction dialogs (paying a mortgage, adding to savings, and so on).    When an 
existing transaction is active and you click on the Register button, CA-Simply Money opens the 
account register and goes directly to that transaction.    Without this switch, the cursor goes to 
the end of the register.

-r This switch causes the Return key to record the current check in the checkbook.    Otherwise, by
default, the Return key moves the cursor to the next field.

-c This switch causes check printing on dot matrix printers to always be done in character mode.    
Otherwise, by default, printing is done in the best available mode.

"finance group"    Opens the finance group whose name you specify.    If the name is more than one
word, surround it with double quotation marks.

Related Topics:
Customizing Some Operations at Startup



Button Arrangement

When you create a new finance group, your first task is to create your income sources, accounts, and 
payees (see Finance Buttons).    By default, CA-Simply Money automatically arranges your finance 
buttons according to how often you use them for transactions, putting the most frequently used buttons at 
the top.    You may not even notice the buttons have moved.    The system setting for this feature is Auto 
Button Layout (see Changing System Settings).    When you turn off the Auto Button Layout option, you 
can rearrange your finance buttons in any order that you choose.

Related Topic:
Rearranging Buttons



Rearranging Buttons

To manually rearrange buttons: 

1. From the System menu, choose Settings, then General.    The General Settings box appears.
2. From the Main box, turn the Auto Button Layout option to OFF.    Choose OK to return to the main 

window.
3. While holding down SHIFT, drag and drop a button into the desired position (you must place the 

button in an area currently occupied by another button).    It is automatically repositioned.
When buttons are not visible on the window, use the scroll bar to see the button you 
want to move.    Hold down SHIFT and drag the button to the up or down arrow on the 
scroll bar.    The buttons will begin to scroll.    Drop the button in the desired position.



Background Patterns

CA-Simply Money gives you choices for the background colors and patterns of your main window, the 
Register, the Checkbook, and the check itself.    You can even edit the patterns or design your own.

Related Topics:
Selecting a Background Pattern
Editing a Background Pattern
Changing Squares of Color
Adding a Background Pattern



Selecting a Background Pattern

To select a background pattern:

1. From the System menu, choose Background Pattern.    The Background Patterns box appears.    
2. In the Apply to box, choose the area of CA-Simply Money you want to change¾the Main Screen, 

Check Book, Check, or Register.
3. From the Select/Change box, click on a pattern.    Use the scroll bar to view over 30 backgrounds.
4. Choose OK.    The pattern automatically changes in the area you selected.



Editing a Background Pattern

You can modify any of the patterns included in CA-Simply Money, or add your own.

To edit a pattern:

1. From the System menu, choose Background Pattern.    The Background Patterns box appears. 
2. From the Select/Change box, click on a pattern to edit.
3. Click on the Edit button.    The Edit Pattern box appears.    
4. From the Screen Colors palette, choose a color.    Any of the 16 colors in this palette can be added to

the pattern.
5. In the Pattern box, click on a square.    The color of the square changes to the screen color you have 

selected.    Each square you click on changes to the color selected in the Example box.
The Pattern box represents a very small portion of the Example box.    Notice that as you 
work on your design pattern, the Example box gradually changes to reflect your 
developing pattern.

6. Continue selecting colors and adding them to the pattern.    Choose OK when you have completed 
your pattern design.

7. From the Background Patterns box, choose an area to apply the edited pattern to, then click OK.
The new pattern appears in the appropriate CA-Simply Money window area.    This 
pattern remains in your gallery of patterns, whether you currently use it or not.



Changing Squares of Color

If you want to change all squares of one color to a different color, you can use the Pattern Select method:

To color multiple squares:

1. From the System menu, choose Background Pattern.    The Background Patterns box appears.    
2. Choose a pattern to edit, then click on Edit.    The Edit Pattern box appears.
3. Choose a color from the Screen Colors palette.
4. Use the right mouse button to click on one square in the pattern.

All of the squares of the same color as the square you clicked on are changed to the new
color.    If all the squares are the same color, the entire box changes color.



Adding a Background Pattern

There are a number of blank pattern boxes available that you can use for your own designs.

To add a new pattern:

1. From the System menu, choose Background Pattern.    The Background Patterns box appears.    
2. Scroll through the Select/Change list and choose a blank box. 
3. Click on Edit.    The Edit Pattern box appears.
4. Choose a color from the Screen Colors.
5. Click in the Pattern squares to define a pattern.    Choose additional colors, if you wish to complete 

the pattern.
6. Click OK.    The new pattern appears in the blank box you chose in the Background Patterns box.    
7. Choose an area to apply the pattern to and click OK.



Default Categories Assigned to Finance Groups

Categories let you group similar transactions for budgets, reports, and graphs.    For example, you might 
want to budget a certain amount of money for groceries.    At tax time you probably want a report of tax-
related earnings and expenses.    Or, you may generate a graph showing the trend of medical payments 
over the past year.

CA-Simply Money provides default categories and subcategories for the types of finance groups you can 
create:    Personal, Business, and Both.    The following table shows the default categories for expenses.    
A dot indicates that the category is provided for Personal and/or Business finance groups.    The Both type
of finance group includes all categories.

Note that you can add more categories as you record income and make payments.    You can also edit 
categories.

Expense Personal Business
Advertising ·
Auto · ·
Charity · ·
Child Care ·
Clothing ·
Commissions ·
Dental ·
Dining ·
Entertainment ·
Gifts · ·
Groceries ·
Home Repair ·
Insurance · ·
    Auto · ·
Interest · ·
Invest Expns ·
Leasing ·
Legal Fees ·
Medical ·
Misc. Expns · ·
Office Expense ·
Property Tax ·
Recreation ·
Rent · ·
Repairs ·
Service Chrg · ·
Subscriptions · ·
Travel · ·
Utilities · ·
    Electricity · ·
    Gas · ·
    Sanitation · ·
    Telephone · ·
    Water · ·

Related Topic:
Categorizing Your Finances



Ordering Supplies

You can save time by printing checks directly from CA-Simply Money.    Choose from a wide variety of 
custom checks designed to work with CA-Simply Money.    Ordering personalized checks is as simple as 
making a phone call to the CA-Simply Money toll-free number.    You can also print the order form and fax 
or mail it to the CA-Simply Money store.

Some other supplies you can order are envelopes, letterhead, and deposit slips.

Related Topics:
Viewing and Printing the Supplies Order Form
Exporting the Supplies Order Form



Viewing and Printing the Supplies Order Form

Use the supplies order form to order checks and other supplies for use with CA-Simply Money.    If you 
order over the telephone, you will probably want to print the form and fill it in for your records. 

To look at and print the supplies order form:

1. From the System menu, choose Order Supplies.    The Supplies box appears.
2. To browse through the supply list, use the scroll bar.
3. To print the form, choose Print from the Supplies box File menu.
4. When you have finished browsing the supply list, choose Exit from the Supplies File menu.

You can also export the form to a word processing form.    See Exporting the Supplies 
Order Form.



Exporting the Supplies Order Form

To export the supplies order form:

1. From the Supplies box File menu, choose Export.    The Print Report to Disk box appears.
2. Follow the procedure Exporting a Report to Another Program.



Copying and Pasting

Copying and pasting is a technique for moving contents from one place to another in the Windows 
environment.    You can move contents between CA-Simply Money and other Windows applications.    

CA-Simply Money lets you Copy, Cut, and Paste text from the Edit menu.    When you Copy or Cut, the 
information is placed in the Clipboard, a temporary storage space that understands information from all 
Windows programs.    When you Paste, any information currently in the Clipboard is placed in your 
application.    For further information, see your Windows User's Guide.

Related Topics:
Copy Command
Cut Command
Paste Command



Copy Command

Places a copy of the text on the Clipboard, leaving the original information unchanged.    This lets you 
copy text to other locations in CA-Simply Money or to other applications.    You can also copy graphs to 
other applications (see Copying a Graph to Another Application).    

To copy text:

1. Use the mouse to highlight the text.
2. Pull down Edit and select Copy.    The text is copied onto the Clipboard.

Use Paste to paste the text in a new location.



Cut Command

Removes the selected text and places it on the Clipboard.    This lets you move text to other locations in 
CA-Simply Money or to other applications.

To cut text:

1. Use the mouse to highlight the text.
2. Pull down Edit and select Cut.    The text is removed and copied onto the Clipboard.

Use Paste to paste the text in a new location in CA-Simply Money.



Paste Command

Copies text from the Clipboard to the active window, inserting it at the Windows cursor.    Use Paste after 
using Copy or Cut in CA-Simply Money or in another Windows application.

To paste text:

1. Pull down Edit and select Paste.    The contents of the Clipboard appear at the cursor.

The Clipboard retains the same contents until you use Copy or Cut again.



Excel Applications

CA-Simply Money supports Dynamic Data Exchange (DDE).    CA-Simply Money acts as a server 
(provides information) to other Windows applications.    Any Windows application that supports DDE can 
access CA-Simply Money data.    

The Excel sample starts CA-Simply Money from within Excel if it is not already loaded.    See the sample 
Excel worksheet and macro or other Windows application documentation for more information.

The sample Excel macros fill or read the sample worksheet starting from the top row on down as far as it 
needs to run.    When you view the sample worksheet, move horizontally across to view the different 
buttons provided to execute the macros.

To see the macro DDE calls made from Excel to CA-Simply Money, refer to the Appendix in the Kiplinger's
CA-Simply Money User Guide.    You can use these same calls in any other Windows application macro 
language that supports DDE.

1. From Excel, open the file CASMXDDE.XLW.    This loads the Excel worksheet CASMXDDE.XLS and 
the macro CASMXDDE.XLM.

Related Topics:
Exporting Securities Information to Excel
Exporting Transaction Information to Excel
Exporting Category Information to Excel



Exporting Securities Information to Excel

Four sets of information about securities can be retrieved from CA-Simply Money into Excel 
(or any other DDE-compatible worksheet or database program).    Click on any of the items 
below for more information.

· A list of individual securities
· Update prices for individual securities
· A securities transaction report
· A securities price history report

Related Topics:
Exporting Transaction Information to Excel
Exporting Category Information to Excel
Excel Applications



Exporting a List of Individual Securities
An Excel Application

You can export a list of all individual securities in the current finance group.    This is useful for updating 
current market prices (see Exporting Update Prices for Individual Securities).    This list retrieves the 
security name, symbol, number of shares held, current market price, and the current market value of each
holding.

To obtain a listing:

1. Click on the Securities Report button in the sample worksheet.

Related Topics:
Exporting Securities Information to Excel



Exporting Update Prices for Individual Securities
An Excel Application

You can automatically update the current market price of each holding.    However, the number of shares 
and the symbol are not updated. 

1. Use the List Securities macro or manually add the appropriate data into the worksheet.
2. Click on the Current Price button underneath the Securities Report button in the sample worksheet to

obtain price updates.

Related Topics:
Exporting a List of Individual Securities
Exporting Securities Information to Excel



Exporting a Securities Transaction Report
An Excel Application

This report provides a list of all transactions within a specific date range.    The list includes any securities 
transactions recorded in the currently open finance group within the specified date range.    CA-
Simply Money provides the transaction date, security name, type of securities transaction, symbol, 
number of shares, total cost (excluding commission,) commission and current price.    The date range is 
optional.

1. Click on the Securities Transactions button on the sample worksheet to obtain this report.

Related Topics:
Exporting Securities Information to Excel



Exporting a Securities Price History Report
An Excel Application

You can export a price history of all securities within a certain date range in the currently open finance 
group to Excel or other DDE-compatible applications.    The report provides the reference data, security 
name, symbol, and price per share.    The date range is optional.

1. Click on the Securities Price History button to access price history within CA-Simply Money.

Related Topics:
Exporting Securities Information to Excel



Exporting Transaction Information to Excel

You can export three sets of transaction information from CA-Simply Money into Excel (or any
other DDE-compatible worksheet or database program).    Click on any of the items below for 
more information.

· A transaction report
· A transaction summary
· The amounts of unique transactions

Related Topics:
Exporting Securities Information to Excel
Exporting Category Information to Excel
Excel Applications



Exporting a Transaction Report
An Excel Application

You can export a transaction report within a specified date range from the currently open finance group.    
The date range is optional.    The transaction report provides the transaction date, payee name, payor 
name, and transaction amount.

1. Click on the Transaction Report button on the sample Excel worksheet.

Related Topics:
Exporting Transaction Information to Excel



Exporting a Transaction Summary
An Excel Application

You can export a list of unique transactions.    Use this macro with the Amounts for Unique Transactions 
macro.    A unique transaction is a transaction with the same payee name and payor name.    The list 
provides a start date, end date, payee name, and payor name.    The start date is the first transaction date
for the unique transaction and the end date is the last recorded transaction.

1. Click on the Transaction Summary button on the sample Excel worksheet.

Related Topics:
Exporting Amounts for Unique Transactions
Exporting Transaction Information to Excel



Exporting Amounts for Unique Transactions
An Excel Application

You can export transaction amounts for each unique transaction.    The amount represents all transaction 
amounts recorded between the start date and end date for the payee name and payor name. 

1. Use the Transaction Summary macro or manually add the appropriate data into the worksheet.    If 
you type the data manually, you must add the payee name and, optionally, any or all of the following: 
start date, end date, and payor name.

2. Click on the Amount button underneath the Transaction Summary button on the sample Excel 
worksheet.

Related Topics:
Exporting a Transaction Summary
Exporting Transaction Information to Excel



Exporting Category Information to Excel

You can view categories from Excel and other DDE-compatible applications in two forms:

· category list
· category balance

Related Topics:
Exporting Securities Information to Excel
Exporting Transaction Information to Excel
Excel Applications



Exporting a List of Categories
An Excel Application

You can export a list of all categories within a specified date range in the currently open finance group.    
This list includes the category name, whether or not it is a taxable category, and the category balance.    
The date range is optional.    The list defaults to providing all categories within the date range.    Use the 
zero suppression flag to only get those categories with non-zero balances.

1. Click on the Category Report button on the sample worksheet.    Set the zero-suppression flag to 
TRUE if you want to suppress reporting on categories with zero balances.    The flag is located 
underneath the Category Report button on the sample worksheet.

Related Topics:
Exporting Category Information to Excel



Exporting Category Balances
An Excel Application

You can export a category balance for categories of any distribution amounts within the specified date 
range. 

1. Use the Category List macro or manually add the appropriate data into the worksheet.    If you type 
the data manually, you must add the category name and optionally any or all of the following: start 
date, end date, and category type.

2. Click on the Balance button underneath the Category Report button on the sample worksheet.

Related Topics:
Exporting a List of Categories
Exporting Category Information to Excel



Procedures for Basic Tasks

The following topics are quick steps for using CA-Simply Money.

Creating a New Finance Group
Opening a Finance Group
Setting up Income Sources, Accounts, and Payees
Preparing Checks For Printing
Recording Checks in the Checkbook Register
Printing Checks
Paying a Mortgage or Credit Line
Transferring Funds Between Accounts
Depositing Money in an Account
Depositing Your Paycheck
Withdrawing Money from an Account
Assigning One Category
Assigning Several Categories (Making a Distribution)
Grouping Income Sources, Accounts, or Payees
Reconciling an Account
Generating a Transaction Graph or Report
Generating a Report
Customizing a Report
Saving a Report Format
Making a Graph
Customizing a Graph
Saving a Graph Format
Budgeting
Importing Data
Exporting Data
Exporting Tax Information
Preventing Others from Seeing Your Finances
Moving Buttons
Entering Dates



Creating a New Finance Group - Quick Steps

1. Select New from the File menu. 
2. Type a descriptive name for the finance group.    If you wish, add a comment.
3. Click on OK.
4. Select the type of finance group you want by clicking on Personal, Business, or Both.

Related Topic:
Finance Groups



Opening a Finance Group - Quick Steps

1. Select Open from the File menu. 
2. Click on a finance group name.
3. Click on OK.

Related Topic:
Finance Groups



Setting up Income Sources, Accounts, and Payees - Quick Steps

1. Gather all paperwork (pay stubs, checkbook, statements).
2. Drag the Income, Accounts, or Payees button down to the Setup button, then release the mouse 

button.
3. Click on whichever of these buttons is on your screen:    Add Income Source, Add an Account, Add a 

Payee.
4. Type the name of an income source, account, or payee.
5. Select the type of income, account, or payee:    

· click the down arrow near Type
· click on one of the types listed

6. Add an address, telephone number, contact person, and/or account number:
· click on the Address button
· type the information in the spaces provided
· click OK

7. If desired, change the icon:    
· click on the Icons button
· locate the icon you want 
· click on the icon of your choice
· click OK

8. If desired, check the box next to Hidden Button. 
9. If you are adding a tax free account such as an IRA, 401(k), or annuity, check the box next to Tax-

free Account.
10. Click on OK.
11. If you are adding an account, fill in the starting amounts CA-Simply Money asks for.
12. Click on OK.

Related Topic:
Finance Buttons



Preparing Checks For Printing - Quick Steps

The checkbook register is updated automatically when you prepare checks for printing.

1. Drag the checking account button down to the Write button, then drop it.
2. Type any letter on the Pay to the Order of line, then choose a payee by either:

· Clicking on a payee, then on the OK button.
· Typing a name, then clicking on the New button.    (You are then prompted to add the new payee.)

3. Enter an amount.    Type a memo if you wish.
4. If desired, enter a category.    (See Assigning One Category or Assigning Several Categories (Making

a Distribution).)
5. Click on the Record button.
6. Prepare as many checks as needed.    Print them now or later by clicking on the Print button and then

on OK.
7. Click Home to return to the main screen.

Related Topic:
Printing Checks



Recording Checks in the Checkbook Register - Quick Steps

1. Drag the checking account button down to the Register button, then drop it.
2. Type a letter, then choose a payee by either:

· Clicking on a payee, then on the OK button.
· Typing a name, then clicking on the New button.    (You are then prompted to add the new payee.)

3. Enter an amount.
4. If desired, enter a category.    (See Assigning One Category or Assigning Several Categories (Making

a Distribution).)
5. If necessary, change the date.    (See Entering Dates.)
6. If you are going to print a check with CA-Simply Money, type a "p" in the Via column.

If you are recording a check you wrote, type the check number in the Via column.
7. Click on the Record button.
8. Click on the Home button.

Related Topic:
Using an Account Register



Printing Checks - Quick Steps

1. If necessary, change printing options:    from the System menu select Settings, then Check Printing. 
2. Drag the checking account button down to the Write button, then drop it.
3. If necessary, write some checks.
4. Click on the Print button. 
5. Click on OK.

Related Topic:
Printing Checks



Paying a Mortgage or Credit Line - Quick Steps

By updating the mortgage or credit line account, you also automatically enter the information in the check 
register, and prepare a check for printing.

1. Click once on the button for the account.
2. Click on whichever of these buttons appears:    Pay Mortgage, Pay Bill.
3. If you amortized your mortgage, change (if necessary) any amount in the Amortized Payment box, 

then click on OK.
4. Enter principal and interest.
5. Type a letter in the space labeled From Account or Income Source.
6. If necessary, click the button next to Income, Accounts or Special in the Account browser.
7. Indicate the income source or account by either:

· Clicking on an income source or account, then on the OK button.
· Typing a name, then clicking on the New button.    (You are then prompted to add the new income

source or account.)
8. Click on the Record button.
9. Click on the button next to either of these:    Prepare Check for Printing, Just Record Transaction.
10. Click on OK.

Related Topics:
Mortgages
Credit Line and Loan Accounts



Transferring Funds Between Accounts - Quick Steps

1. Drag the button for one account to the button for the other account, then drop it.
2. Type an amount.
3. If necessary, click the down arrow near Transfer Via, then click on the method of transfer:    Cash, 

ATM, Wire, or Direct.
4. Click on the Transfer button.

Related Topic:
Transferring Funds



Depositing Money in an Account - Quick Steps

1. Drag the account button down to the Register button, then drop it.
2. Type a letter.
3. Click the button next to Special, then either:

· Click on a type of deposit, then on the OK button.
· Type a method of deposit that is not on the list, then click on the New button.

4. Type an amount in the Deposit column.
5. If desired, enter a category.    (See Assigning One Category or Assigning Several Categories (Making

a Distribution).)
6. If necessary, click the down arrow near Transfer Via, then click on the method of transfer:    Cash, 

ATM, Wire, or Direct.
7. Click on Record.

Related Topic:
Recording Income



Depositing Your Paycheck - Quick Steps

1. Drag your paycheck button to an account button, then drop it.
2. Record gross income and deductions.    (To record extra deductions such as health insurance, click 

on the Distributions button, then enter amounts.)
3. If necessary, click the down arrow near Via, then click on the method of transfer:    Cash, ATM, Wire, 

or Direct.
4. Click on the Record button.

Related Topic:
Recording Income



Withdrawing Money from an Account - Quick Steps

1. Drag the account button down to the Register button, then drop it.
2. Type a letter.
3. Click the button next to Special, then either:

· Click on Withdrawal, then on the OK button.
· Type a method of withdrawal that is not on the list, then click on the New button.

4. Type an amount in the Payment column.
5. If desired, enter a category.    (See Assigning One Category or Assigning Several Categories (Making

a Distribution).)
6. If necessary, click the down arrow near Transfer Via, then click on the method of transfer:    Cash, 

ATM, Wire, or Direct.
7. Click on Record.

Related Topic:
Recording a Withdrawal



Assigning One Category - Quick Steps

Categories let you track your finances by grouping similar transactions for budgets, reports, and graphs.    
Sample categories are utilities, dental, and clothing.    You assign categories while recording income, 
updating accounts, or writing checks.

1. Drag an account button down to the Register button, then drop it.
2. Type a letter on the category line (the line with the small arrowhead).
3. If necessary, click the button next to Expense, Asset, Income, or Liability on the browser.
4. Indicate the category by either:

· Clicking on a category in the list, then on OK.
· Typing a new category, then clicking on the New button.    Enter a description for the category, 

and indicate whether it is tax related.    Click on OK.

Related Topic:
Distributing a Payment to One Category



Assigning Several Categories - Quick Steps

Distribute the amount to more than one category if, for example, a bill is for clothing and food.

1. Drag the checking account button down to the Write or Register button, then drop it.
2. Enter a payee, then the amount of a bill.    
3. Click on the small arrowhead on the category line.
4. Type a letter in the Category column.
5. If necessary, click the button next to Expense, Asset, Income, or Liability on the browser.
6. Indicate the category by either:

· Clicking on a category in the list, then on OK.
· Typing a new category, then clicking on the New button.    Enter a description for the category, 

and indicate whether it is tax related.    Click on OK.
7. Type an amount for that category in the Amount column.
8. Repeat steps 3 - 6 for every category. 
9. If necessary, click on the Recalc Total button.
10. Click on the Close button.
11. Click on the Home button.

Related Topic:
Distributing a Payment to More Than One Category



Grouping Income Sources, Accounts, or Payees - Quick Steps

Grouping income sources, accounts, or payees lets you summarize information on reports and graphs, 
and automate tasks such as check writing.    For example, if you group payees before writing checks, CA-
Simply Money displays a check for each one automatically, one after the other.

Temporary group:
1. Hold down the Shift key and click on the buttons you want to group.    (To deselect a button, press 

Shift and click on it again.    To deselect all buttons, click on the background.)
2. To generate reports or graphs, drag any one of the grouped buttons to the Reports or Graphs button. 

To write checks, drag any one of the grouped buttons to the button for your checking 
account.

Permanent group:
1. Make a temporary group.
2. Drag any one of the grouped buttons to the Setup button.
3. Type a group name.
4. If desired, add a member to the group by clicking on an unselected income source, account, or 

payee.    Omit a current member by clicking on a highlighted item.
5. If desired, select a new icon or hide the button.
6. Click on the OK button.

Related Topic:
Grouping Buttons



Reconciling an Account - Quick Steps

1. Drag the account button down to the Balance button, then drop it.
2. Enter statement balance, any service charge, interest earned or paid, then click on OK.
3. For transactions included on the statement, click in the column labeled C (cleared).    (To clear 

consecutive checks, click on the Clear Range button and enter the range of check numbers.)
4. If you need to change or record any transactions, click on the Register button.
5. Click on the Home button.
6. If the account does not balance, click on the Add or Don't Add button.

Related Topic:
Interpreting the Balance Window



Generating a Transaction Graph or Report - Quick Steps

You can quickly generate a Transaction report for a single Income Source, Account, or Payee.

1. Drag an income, account, or payee button down to the Graphs or Reports button.

Related Topics:
Graphs
Reports



Generating a Report - Quick Steps

1. Click on the Reports button.
2. Click on the button for the type of report you want.
3. Click on the report you want, then on OK.

If you want to print the report, pull down the File menu on the report window and choose Print.

If you want to use the data on the report in another application, pull down the File menu on the report 
window and choose Export.

Related Topic:
Reports



Customizing a Report - Quick Steps

Before generating the report:
· To specify a range of dates, select the System menu, then Settings, then Reports & Graphs.
· To specify the income sources, accounts, or payees for your report, group their buttons.

After generating the report, while it is on the screen:
· To change the title, pull down the Options menu on the report window, then choose Filters and 

Styles. 
· To specify the income sources, accounts, or payees for your report, pull down the Options menu on 

the report window.    Choose Filters and Styles, then click on Include.    Select (highlight) or deselect 
items by clicking on them.    

· To control totals, number format, and more, again choose Filters and Styles from the Options menu 
on the report window.    Click on Settings.

· To specify fonts, choose Title Font or Body Font from the Options menu on the report window. 

For more detailed information, see Customizing Your Report.



Saving a Report Format - Quick Steps

This procedure lets you keep the format of a customized report for future use. 

1. Customize a report.    (See Customizing a Report.)
2. Choose Memorize from the File menu of the report window.    
3. Use the format in the future by clicking the Reports button to generate a report, then the button next 

to Memorized Reports. 

For more informaiton, see Memorizing Custom Reports and Graphs.



Making a Graph - Quick Steps

1. Click on the Graphs button.
2. Click on the button for the type of graph you want.
3. Click on the graph you want, then on OK.

If you want to print the graph, pull down the File menu on the graph window and choose Print.

If you want to include the graph in another Windows application, copy it to the clipboard.    Pull down the 
File menu on the graph window and choose Copy.

Related Topic:
Graphs



Customizing a Graph - Quick Steps

Before generating the graph:
· To specify a range of dates, select the System menu, then Settings, then Reports & Graphs.
· To specify the income sources, accounts, or payees for your graph, group their buttons.

After generating the graph, while it is on the screen:
· To change the title, pull down the Options menu on the graph window, then choose Filters and 

Styles. 
· To specify the income sources, accounts, or payees for your graph, pull down the Options menu on 

the graph window.    Choose Filters and Styles, then click on Include.    Select (highlight) or deselect 
items by clicking on them. 

· To switch to another type of graph, choose Settings from the Options menu on the graph window. 
· To control whether items such as grid lines and labels appear, again choose Settings from the 

Options menu on the graph window.    

For more detailed information, see Customizing a Graph.



Saving a Graph Format - Quick Steps

This procedure lets you keep the format of a customized graph for future use. 

1. Customize a graph.    (See the preceding procedure.)
2. Choose Memorize from the File menu of the graph window.      
3. Use the format in the future by clicking the Graphs button to make a graph, then the button next to 

Memorized Graphs. 

For more information, see Memorizing Custom Reports and Graphs.



Budgeting - Quick Steps

1. From the Edit menu choose Budget.
2. If necessary, click the button next to Expense or Income.
3. Either:

· Enter amounts in the Amount column (for expenses) or the Income column (for income).
· Click on AutoBudget, make selections, then click on OK.

4. If you want to make a budget for several months, click on the Variable button.
5. If you want to sort by value, or show top-level categories only, click on the Options button.

Related Topic:
Making a Yearly Budget



Importing Data - Quick Steps

You can import these file formats: 

MXF (CA-Simply Money Exchange Format) 
QIF (Quicken Interchange Format)
BMF (BillPay USA Format)

1. From the File menu choose Import.
2. Select a file, then click on OK.
3. If it is a MXF file, choose to add the data to the current finance group or make a new finance group.

If it is a QIF or BMF file, specify the account to receive the data.
4. Click on OK. 

Related Topic:
Exporting/Importing Data



Exporting Data - Quick Steps

You can export these file formats: 

MXF (CA-Simply Money Exchange Format) 
QIF (Quicken Interchange Format)

1. From the File menu choose Export.
2. Type a name for the file, or select a name by clicking on the Browse button.
3. If necessary, indicate a date range and file compatibility. 
4. Specify the items to be exported.
5. If you want to specify the income sources, accounts, or payees to be exported, click on the Include 

button.    Select (highlight) or deselect items by clicking on them.
6. Click on OK.    

Related Topic:
Exporting/Importing Data



Exporting Tax Information - Quick Steps

1. From the File menu choose Tax Export.
2. Type a name for the file, or select a name by clicking on the Browse button.
3. If necessary, indicate a date range.
4. Click on OK.

Related Topic:
Exporting to Tax Programs



Preventing Others from Seeing Your Finances - Quick Steps

1. From the System menu choose Settings, then Password.
2. Type a password (asterisks appear for each letter), then click on OK.
3. Type the password again, and click on OK.
4. Write down your password and keep it in a safe place.

Related Topic:
Security



Moving Buttons - Quick Steps

By default CA-Simply Money positions your most frequently used buttons at the top of the work area.    To 
change the button positions:

1. From the System menu choose Settings, then General.
2. Click on the box next to Auto Button Layout to deselect it, then click on OK.
3. Hold down the Shift key and drag a button.    The new location must currently be occupied by another

button.    If the desired location is off the screen, position the button over the up or down arrow on the
scroll bar until the location comes into view.

Related Topic:
Button Arrangement



Entering Dates - Quick Steps

To insert today's date:

1. Click on a date field and press F3.

To insert another date:

1. Click on a date field and press F4.    The calendar appears.
2. If necessary, change the month by clicking on the scroll bar arrows.    Change the year by clicking on 

the scroll bar.
3. Click on a date, then on OK.
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account
A place where you hold your money.    In CA-Simply Money, accounts are the records of each way you 
transfer funds.    They can include checking accounts, credit cards, investments, and more.    



accrual basis accounting 

A method of keeping books where revenue is recognized when realized and expenses are recognized 
when incurred, without regard to the time of receipt or payment. 



Advisor 

A special feature of CA-Simply Money that reminds you of regularly-scheduled events, tells you when 
payments seem unusually high, and offers valuable, money-saving tips.    Transactions that you make 
trigger advice tailored to your particalar situation.



annual yield 

The amount of money you make in a year on an investment.    



asset 

A non-monetary item you own (such as a coin collection, a car, or a computer) that has real value.    



balance adjustment 

An amount automatically added during account reconciliation by CA-Simply Money if you choose to make
an adjustment to an unbalanced account.    A balance adjustment is a special.    



balance sheet 

A listing of total assets, liabilities, and equity designed to give an overall picture of the health of a 
company.    



bank balance 

The amount of money the bank says you have.    It is determined by the amounts of cleared transactions, 
and is different from the current balance, which is your up-to-date record that may contain deposits, 
checks, and other transactions that have not cleared the bank.    Also known as a statement balance.    



bond 

An investment in the form of a loan to a government or corporation.    Usually represented by a certificate 
which details the terms of the loan.    



book value 

The purchase price of securites (net of commissions) plus the cash balance in an investment account.



brokerage account 

A CA-Simply Money account that represents the account your broker uses for you.    As you receive your 
statements, you can copy the transactions into CA-Simply Money.    



Browser Box 

A feature of CA-Simply Money that helps you enter information in a field without having to type it each 
time.    Typing one or more letters in certain boxes produces a pop-up browser box which contains a list of
related buttons, categories, or classifications.    



budget 

Simply a plan of how much you intend to spend in various categories throughout the year.    



capital gains distribution 

The part of a payment received from a mutual fund which is the result of realized profits from the sale of 
securities.    For tax-reporting purposes, these are technically not income.    



cash basis accounting 

A method of keeping books where revenue is recognized when cash is received and expenses are 
recorded when they are paid in cash.    



category 

A method of organizing and tracking income and expenditures. CA-Simply Money provides a list of 
common categories you can use and modify.    You can also create your own categories.    See also 
classification.    



classification 

Used to group related distributions.    You might use the classification to assign a client code to track 
expenditures for specific clients across categories.    See also category.    



cleared balance 

The balance of your account excluding the credits and debits that have not yet cleared (have been 
transacted between the time your statement was prepared and now).    



compounding 

When the calculation of interest occurs more than once per year. The interest rate is divided by the period
(for example, monthly). Then the periodic interest rate is multiplied by the principal at the end of each 
period and the resulting interest is added to the principal. Subsequent calculations include the previously 
added interest as well as the principal; the result is the effective interest rate, which is higher than the 
annual rate.    



cost basis 

The total money spent on a stock including the actual price paid, commissions, and other expenses.    



costing method 

Refers to tracking capital gains/losses of your investments.    CA-Simply Money assumes that the oldest 
shares of a stock are sold first.    



current balance 

The actual amount of money you have available in an account.    This is different from the bank balance, 
which is the bank's total of cleared transactions. 



distribution 

The assignment of transaction amounts to one or more categories.    



dividend 

A sum paid, usually quarterly, to the owner of a security to return some of the company's profit to the 
investor.    



Drag & Drop Button 

A feature of CA-Simply Money that makes it easy to accomplish all your financial activities.    Drag a 
button over another, then release it, to perform a transaction.



Dynamic Data Exchange 

A method that Windows applications use to exchange information.    



effective rates 

The interest rates based on compounding interest.    See also compounding. 



equity 

The money value of a property you own minus the amount you owe on it.    



expense 

Anything you spend money on.    



Export 

Move data from CA-Simply Money to other programs.    



finance group 

A collection of financial income and outflows.    



first-in, first-out method (FIFO) 

The method CA-Simply Money uses to track capital gains/losses of your investments, based on the 
assumption that the oldest shares are sold first.    See also 
costing method.    



Import 

Bring data from other programs into CA-Simply Money.    



income source 

Places where you obtain (earn) money.    



investment account 

One or more securities that you want to track as a group.    Also called a portfolio.



liability 

Something for which you owe money.    The principal on a mortgage is one example of a liability.    



load 

The commission added into the price of some mutual funds.    



lot grouping 

Tracking individual groups (lots) of stocks to balance gains and losses between lots during a year.    In 
CA-Simply Money you do this by assigning slightly different names to each lot of a particular security.    



money market account 

A type of mutual fund which invests only in short term loans to companies or governments.    



mutual fund 

A group of stocks, bonds, and other securities purchased by a professional management company and 
sold as shares to individual investors.    



net worth 

The sum of all your assets minus the sum of your liabilities.    



Newcomer Hints 

A feature of CA-Simply Money that displays helpful instructions on the screen when you use a feature for 
the first time.    You can turn Newcomer Hints on or off from the Settings box.    



nominal rates 

Interest rates that do not take compounding into account. 



paid-in equity 

The amount of your real property (such as your house) that you have paid for.    Every payment on your 
mortgage increases your paid-in equity. 



payable 

An item you owe. A term usually reserved for business accounts.    See also receivable.    



payee 

A person or company to whom you owe money.    



Payee Summary 

An information box which allows you to see instantly all the pertinent information about a payee.    To view 
a payee summary, click on a payee button.      



payroll 
An account used for recording payments to employees and for accruals of income tax and social security 
deposits.    



performance 

The yearly percentage profit or loss per share of a security.    



principal 
In a loan, the actual amount you borrowed or the amount you have left to pay off.    



profit 

The percentage increase (or decrease) in the value of a share of stock.    See also performance.    



receivable 

Money that comes to you. A term usually reserved for business accounts.    See also payable.    



reconcile 

To compare your records with those of your bank.    Usually you do this by checking your monthly bank 
statement against your check register.    CA-Simply Money streamlines this process.    With CA-
Simply Money, you may also reconcile your credit cards.    



reinvestment 

Some securities, particularly mutual funds, pay you dividends, interest income, and capital gains with 
additional shares instead of cash.    



Reminder 

A CA-Simply Money feature which lets you schedule your transactions to make sure you don't miss 
important dates like a mortgage payment or a CD coming to term.    



Scheduler 

A CA-Simply Money feature that helps you track your regular payments and other transactions.    



security 

Any investment which has a value that is expressed in shares.    



short sell 
When you sell shares of stock you do not actually own, but plan to buy later in hopes that the buying price
will be lower.    



Special 
Some transactions require transferring funds but do not warrant setting up a payee button.    These 
situations are listed in the Special Browser box, and you can designate a special when you record 
transactions in the Register.    Some examples are balance adjustments, deposits, and service charges.    



split 

Dividing a transaction amount into two or more categories.    



stock 

Shares of stock represent shared ownership of a corporation by investors.    



stock split 

When the market price of a company's stock reaches an inconvenient trading range, the company may 
reduce the price of their shares by a percentage and issue compensatory shares to maintain investors' 
equity.    



tax-free accounts 

Some income from investment accounts such as Keogh, IRA, SEP, 401(k) plan, and other retirement 
accounts may be tax-free.    Consult your tax advisor for more information.    



Tool Rack 

The row of buttons at the bottom of the main window in CA-Simply Money.    



unrealized equity 

The value of your real property minus the amount you owe on the property.    Improvements made on 
property (such as your house) that are not yet paid for will increase your unrealized equity.    



Welcome 
A step-by-step introduction to CA-Simply Money that illustrates the available features and allows you to 
start a finance group.    The Welcome appears the first time you run CA-Simply Money.    



Using Keyboard Shortcuts

Tool Rack
Help F1
Write Alt+W
Reports Alt+P
Graphs Alt+G
Register Alt+S
Balance Alt+B
Find Alt+I
Schedule Alt+L
Advise Alt+A
Setup Alt+U

File Menu
New Alt+F, N
Open Alt+F, O
Delete Alt+F, D
Change Name Alt+F, C
Backup Alt+F, B
Restore Alt+F, R
Archive Alt+F, A
Import Alt+F, I
Export Alt+F, E
Tax Export Alt+F, T
Printer Setup Alt+F, P
Exit Alt+F, X

Edit Menu
Cut Alt+E, T
Copy Alt+E, C
Paste Alt+E, P
Categories Alt+E, A
Classifications Alt+E, L
Budget Alt+E, B
Investments Alt+E, I

Operations Menu
Pay Expenses Alt+O, P
Record Income Alt+O, R
Transfer Funds Alt+O, T
Action Items Alt+O, A
Modem Stock Update Alt+O, M
Make Group Alt+O, M
Modify Group Alt+O, O

Tools Menu
Produce Reports Alt+T, P
Draw Graphs Alt+T, G
View Register Alt+T, S
Balance Accounts Alt+T, B
Find Alt+T, I
Schedule Actions Alt+T, L
Get Advice Alt+T, A
Setup Alt+T, U

System Menu



Background Patterns Alt+Y, B
Calculator Alt+Y, C
Financial Calculators Alt+Y, F
Order Supplies Alt+Y, O
Settings Alt+Y, S
General Alt+Y, S, G
Password Alt+Y, S, P
Reminders Alt+Y, S, N
Check Printing Alt+Y, S, C
Reports & Graphs Alt+Y, S, R
Modem Alt+Y, S, M

Help Menu
Contents Alt+H, C
Keyboard Alt+H, K
Commands Alt+H, O
Procedures Alt+H, P
Using Help Alt+H, U
Windows Tutorial Alt+H, W
About CA-Simply Money Alt+H, A



Commands

Click on the following items for a brief description of the commands on each menu.

File Menu
Edit Menu
Operations Menu
System Menu
Tools Menu



File Menu

This topic briefly describes the options on the File menu, and directs you to more detailed information.

New Create a new finance group. 
(See Creating a New Finance Group.)

Open Access another finance group. 
(See Opening an Existing Finance Group.)

Delete Remove a finance group that is not currently active. 
(See Deleting a Finance Group.)

Change Name Change the name of a finance group or the comment about 
it. (See Modifying a Finance Group.)

Backup Make a backup of a finance group. 
(See Backing up Data.)

Restore Bring a backed up finance group into CA-Simply Money. 
(See Restoring Data.)

Archive Create a copy of your data as of a certain date. 
(See Archiving Data.)

Import Bring in MXF, QIF, or BMF data. 
(See Importing Data.)

Export Save data in MXF or QIF format to use with another product.
(See Exporting Data.)

Tax Export Save data in TXF format to use with tax preparation 
software. (See Exporting to Tax Programs.)

Printer Setup Access the Windows printer setup feature. 
(See the Windows User's Guide.)

Exit End the current CA-Simply Money session. 
(See Quitting CA-Simply Money.)

Edit Menu

This topic briefly describes the options on the Edit menu, and directs you to more detailed information.

Cut Remove a selected word or amount and put it in the 
Windows clipboard. (See Cut Command.)

Copy Put a copy of the selected word or amount into the Windows
clipboard. (See Copy Command.)

Paste Place the contents of the Windows clipboard at the current 
cursor location. (See Paste Command.)

Categories Modify categories. (See Editing Categories.)

Classifications Modify classifications. (See Classifications.)

Budget Make a budget. (See Budgeting.)

Investments 
Securities

Change information about a security (name, symbol, price, 
etc.). (See Modifying A Security.)



Investments 
Types

Add to or change the kinds of investments you have (stock, 
mutual fund, CD, etc.). 
(See Adding or Changing an Investment Type or Goal.)

Investments 
Goals

Add to or change your investment goals (high risk, growth, 
income, etc.). 
(See Adding or Changing an Investment Type or Goal.)

Operations Menu

This topic briefly describes the options on the Operations menu, and directs you to more detailed 
information.

Pay Expenses Make payments on an account (same as single click on an 
account button). (See Paying Bills.)

Record Income Add income through an income source (same as single click
on an income button). (See Recording Income.)

Transfer Funds Move money from one account to another. 
(See Transferring Funds Between Accounts.)

Action Items See a list of pending tasks. (See Completing Action Items.)

Modem Stock 
Update

Update stock prices through CompuServe. 
(See Updating Prices.)

Make Group Group income sources, accounts, or payees to automate 
tasks or see summary reports or graphs. 
(See Grouping Buttons.)

Modify Group Change the members of a group. (See Modifying a Group.)

System Menu

This topic briefly describes the options on the System menu, and directs you to more detailed information.

Background 
Patterns

Select patterns for the background of the main screen, 
check screen, check, and/or registers. 
(See Background Patterns.)

Calculator Display a calculator. 
(See Using the Windows Calculator.)

Financial 
Calculators 
Loan

Determine an affordable loan size or payment amount. 
(See Using the Loan Calculator.)

Financial 
Calculators 
Refinance

See when you will break even after refinancing your 
mortgage. (See Using the Refinance Calculator.)

Financial 
Calculators 
Interest

Convert nominal interest rate to effective (annual) rate. 
(See Using the Interest Calculator.)

Financial 
Calculators 

Translate dividends into annual yield. 
(See Using the Dividend Calculator.)



Dividend
Financial 
Calculators 
Investment

Calculate amounts to invest.
(See Using the Investment Calculator.)

Order Supplies See information about ordering checks. 
(See Ordering Supplies.)

Settings 
General

Control settings for audio, button layout, financial advisor, 
confirmation messages, and more. 
(See Changing System Settings.)

Settings 
Password

Enter or change a password for the current finance group. 
(See Passwords.)

Settings 
Reminders

Control reminder messages. 
(See Using Reminders.)

Settings Check 
Printing

Specify date format and other options for checks. 
( See Setting Check Printing Options.)

Settings 
Reports & 
Graphs

Specify ranges of dates, or turn color on or off for reports 
and graphs. (See Setting Default Report & Graph Options.)

Settings 
Modem

Set up communications information. 
(See Setting up Your Modem.)

Tools Menu

This topic briefly describes the options on the Tools menu, and directs you to more detailed information.

Produce 
Reports

Generates a report. 
(See Reports.)

Draw Graphs Displays a graph. 
(See Graphs.)

View Register Lets you make transactions in an account. 
(See Using an Account Register.)

Balance 
Accounts

Lets you reconcile an account. 
(See Reconciling Accounts.)

Find Searches for a transaction based on one or more of these 
factors:    date, account, payee, memo, amount, method of 
payment. (See The Find Feature.)

Schedule 
Actions

Lets you set up a recurring transaction such as paying rent 
each month.    CA-Simply Money reminds you to make the 
transaction, and automatically uses the amount and other 
information you enter in the Scheduler. 
(See The Scheduler.)

Get Advice Displays a list of financial advice topics tailored to your 
situation.    To see detailed advice, select a topic by clicking 
on it, then click on the Advice button. (See The Kiplinger's 
Financial Advisor.)

Setup Lets you add income sources, accounts, payees, and 



special types of fund transfers. (See Finance Buttons.)



The Welcome 

This Welcome appears if you do not have an existing CA-Simply Money database.    It will not appear 
after you set up your first finance group.

Use the mouse to click on the buttons at the bottom of the screen:

· Free.    CA-Simply Money makes money management easy by printing checks for you.    If you plan 
to use the check-printing feature, you must order checks for your printer that contain your bank 
information.    To find out about getting a free supply of checks from Computer Associates, click Free.

· Features.    If you want an overview of the features that make CA-Simply Money unique, click 
Features.

· Start.  If you want to go straight to the program, click Start.    

· Practice.  If you want to try some features of CA-Simply Money by using several months of sample 
data, click Practice.    You will use the program more easily and efficiently if you take the time to 
practice.    

To return to the Program Manager, choose Practice or Start, then choose Exit from the CA-Simply Money 
File menu.



Using the Welcome

Click one of these buttons:

· Next.    Click to get the next Welcome window.    This button is not displayed if you are at the last 
window in a topic.

· Previous.    Click to go back to the last Welcome window.    This button is not displayed if you are at 
the first window in a topic.

· Exit.    Click to go back to the first Welcome window.    



Using the Welcome:    On to the Practice

You have chosen to try some CA-Simply Money features by using sample data that comes with the 
product.    Feel free to select menu options and drag buttons just to see what happens.    Don't worry 
about destroying the sample data.    Nothing you do is saved after you exit "Practice."

Turn to Chapter 4 of the User Guide for ideas about features to try.    If you have never used CA-Simply 
Money, we highly recommend that you practice before setting up your own finances.    

Click one of these buttons:

· OK.    Click to load the sample data and start the practice.

· Exit.    Click to go back to the first Welcome window.    



Using the Welcome:    On to Setting up Your Finances

You have chosen to begin using CA-Simply Money.    If you have never used CA-Simply Money before, 
we recommend that you go to Chapter 3 of the User Guide because it helps you start to set up your 
finances.    

Instead of going directly to the product, you might want to try some CA-Simply Money features by using 
the sample data.    By practicing first, you will find it easier to set up your own finances.    To use the 
sample data, click Exit, then click Practice.

Click one of these buttons:      

· OK.    Click OK to start CA-Simply Money and begin setting up your finances.    When in CA-Simply 
Money, notice that each window and dialog box contains either a Help button or Help on the menu 
bar.    Choose Help or refer to your User Guide for help along the way.

· Exit.    Click to go back to the first Welcome window.    



Choosing an Income Source, Account, or Payee 

1. Highlight an income source, account, or payee by clicking once on it.

If the dialog box has an All button, you can click on it to highlight all of them.

2. Click on OK.



Generating a Payee Summary

A Payee Summary shows the payee button, the address and contact (if any), total transactions, total 
payment amount, last payment amount, average payment amount, days between payments, and account 
number.

To display a Payee Summary:

1. Either:

· Click once on the button of the payee whose summary you want to see.

· Click once on the Payees button.    The View Summary dialog box appears.    Select the payee 
whose summary you want to see, then click on OK.

The summary for the payee appears. 



The Balance Account Dialog Box

The Balance Account dialog box appears after you choose an account to balance.    The register for the 
account appears behind it.    The Balance Account dialog has spaces for you to enter the following 
information from your account statement:

· ending balance

· any service charge, which CA-Simply Money deducts from the ending balance

· any interest earned, which CA-Simply Money adds to the ending balance

These amounts go into the account Register as individual transactions. 

For information about balancing an account, see Balancing a Bank Account.



Using the Income List

When you click once on the Income button, the Income List appears.    It contains a list of all your income 
sources.    For each one it shows:

· the name

· the type of income source (paycheck, interest, dividend, and so on)

· number of times income was applied from the income source 

· total income added from the income source 

After you choose one of the income sources, you can record income.    To choose one:

1. Click once on the income source for which you want to apply income.

2. Click on the Use button.

A dialog box for recording income appears. 

Note:    Clicking once on an individual income source button accomplishes the same thing as this 
procedure. 

Related Topic:
Recording Income



Using the Account List

When you click once on the Accounts button, the Account List appears.    It contains a list of all your 
accounts.    For each one it shows:

· the name

· the type of account (checking, savings, mortgage, and so on)

· number of times the account was updated 

· current balance of the account

After you choose one of the accounts, you can add to it, withdraw from it, or use its register.    To choose 
an account:

1. Click once on the account you want to use.

2. If you want to add to or withdraw from it, click on the Use button.    

If you want to display its register, click on the Register button.

Note:    Clicking once on an individual account button accomplishes the same thing as using the Account 
List and selecting Use.    Dragging an account button to the Register button is the same as using the 
Account List and selecting Register. 

Related Topics:
Using an Account Register
Paying Bills
Using the Checkbook to Pay Bills
Mortgages
Tracking Credit Cards
Cash and Savings Accounts
Credit Line Accounts
Recording Assets and Liabilities
Investment Accounts
Payroll Accounting



Printer Setup 

When you select Print Setup from the File menu, the Windows Print Setup dialog box appears.    For 
information about setting up printers, see the Windows User's Guide.



File Exit

When you select Exit from the File menu, a dialog box appears that lets you choose to either back up the 
current finance group before exiting, or exit without backing up the current finance group.    For more 
information, see Quitting CA-Simply Money.



Printing or Recording Checks

After you enter payment information for a mortgage or credit line, and click on the Record button, the 
Print/Record Check dialog box appears.    It lets you choose to print a check or just record the transaction.

To print a check:
1. Click the option button next to Prepare Check for Printing.

2. Click OK.

To record the transaction only:
1. Click the option button next to Just Record Transaction.

2. Click OK.



Paying a Scheduled or Recurring Bill

To pay a scheduled or recurring bill, choose a transaction from the Action Items box, and click on Act.    
The Record Transaction box appears.    

The Record Transaction box contains either the information you supplied when you scheduled the action 
in the Scheduler, or the information from the last payment made to a payee on a recurring basis.

1. Make any necessary changes to the transaction information in the Record Transaction box, and 
choose Record.

2. When you have completed the transactions you want to pay or delete, choose Close to return to the 
General Advice box.




